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Version history 

User guide version For iSBEM version 

25th July 2008 3.2.b 

23rd December 2008 3.3.b 

1st March 2010 3.5.a 

3rd December 2010 3.5.b 
 
 
Key changes and additions from previous versions of the User Guide 
 
Changes and additions in 3rd December 2010 version 3.5.b:  
 
1. Further explanation or clarification of existing parameters and functionality of iSBEM. 

This “Further guidance” icon shown in the left margin is used to indicate these items in 
the text. 
• Guidance on HVAC system types (see Table 13, Section 7.6.2: Defining HVAC 

Systems – HVAC Systems tab). 
• Guidance on zoning rules (see Section 3.4: Measurement and other conventions). 
• Guidance on system requirements (see Section 4.1: System Requirements). 

 
2. Changes related to new functionality of the iSBEM version 3.5.b. This “new” icon 

shown in the left margin indicates in the text where iSBEM has changed since the 
previous version.  

 
• A new button to allow importing the assessor details from a previous version of 

iSBEM specifically for MS Office 2007 in the General form > General Information tab 
> Certifier details sub-tab (see Section 7.3.2: General Information tab). 

• Guidance on the key differences in the new version of the software (see Section 
2.1.1: Key differences in the software). 

 
 
Changes and additions in 1st March 2010 version 3.5.a:  
 
1. Further explanation or clarification of existing parameters and functionality of iSBEM. This 

“Further guidance” icon shown in the left margin is used to indicate these items in the text. 
 

• Guidance on definition of notional building (see Section 2.3: Calculation basics for Building 
Energy Rating Certificate purposes). 

• Guidance on zoning rules (see Section 3.3: Zoning guide – How to zone your building). 
• Guidance for users of Office 2007 (see Section 4.2: Installing iSBEM on your computer). 
• Guidance on sources of help information (see section 4.6: Getting assistance with using 

iSBEM). 
• Guidance on using the multiplier parameter (see Section 6.1: Basic interface functionality and 

buttons). 
• Modified options for stage of analysis in the General form > General Information tab > Project 

Details sub-tab (see Section 7.3.2: General Information tab). 
• Owner details, instead of occupier details, are required in the General form > General 

Information tab > Owner Details sub-tab (see Section 7.3.2: General Information tab). 
• Guidance on zone height (see Section 7.5.3: Defining zones – Zones tab). 
• Guidance on zone defined as having no HVAC system (see Section 7.5.3: Defining zones – 

Zones tab and Section 7.6.8: Defining the zone specific building services- Zones tab). 
• Guidance on adjacency of envelopes (see Section 7.5.4: Defining envelopes – Envelope tab). 
• Guidance on envelope areas (see Section 7.5.4: Defining envelopes – Envelope tab, Section 

7.5.5: Defining windows and rooflights – Windows & Rooflights tab, Section 7.5.7: Defining 
doors – Doors tab, and Section 7.5.8: Quick Envelopes tab: Short cut to creating envelopes 
and windows). 

Further 
guidance 

NEW 
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• Guidance on the window and rooflight parameters which cannot be edited using the Quick 
Envelopes sub-tab (see Section 7.5.8: Quick Envelopes tab: Short cut to creating envelopes 
and windows). 

• Guidance on consequences of changing the HVAC system type (see Section 7.6.2: Defining 
HVAC Systems – HVAC Systems tab). 

• Guidance on default efficiency for heat generator for hot water systems (see Section 7.6.3: 
Defining HWS – HWS tab). 

• Guidance on default storage and secondary circulation losses for hot water systems (see 
Section 7.6.3: Defining HWS – HWS tab). 

• Guidance on defining CHP generators (see section 7.6.7: Defining the CHP generator – CHP 
Generator tab). 

• Guidance on default HVAC systems (see Section 7.6.8: Defining the zone specific building 
services- Zones tab). 

• Guidance on lamp types (see Section 7.6.8: Defining the zone specific building services- Zones 
tab). 

• Guidance on sub-dividing zones due to daylight (see Section 7.6.8: Defining the zone specific 
building services- Zones tab). 

• Guidance on accessing the error files from the Ratings form (see Section 8.1.1: Building 
Regulations Check tab and section 8.1.2: Asset Rating tab). 

• Guidance regarding the main heating fuel for a building with no space or water heating (see 
Section 8.2.7: Building Energy Rating Certificate). 

• Guidance on connecting to EPCgen.net in order to generate the XML message (see 
APPENDIX E: Connection to EPCgen.net). 

 
2. Changes related to new functionality of the iSBEM version 3.5.a. This “new” icon shown in the 

left margin indicates in the text where iSBEM has changed since the previous version.  
 

• Version number of iSBEM is now visible in the top blue bar of the window in all forms, tabs, and 
sub-tabs of the interface (see Section 5.1: Introduction to the main forms in iSBEM). 

• System configuration tab in the General form > File Options tab has been split into 2 tabs to 
accommodate new tick boxes (see Section 7.3.1: File Options tab). 

• A new tick box in the General form > File Options tab > System Configuration (cont.) sub-tab to 
control the clearing of the contents of the Quick Envelopes tab (see Section 7.3.1: File Options 
tab and 7.5.8: Quick Envelopes tab: Short cut to creating envelopes and windows). 

• A new tick box in the General form > File Options tab > System Configuration (cont.) sub-tab to 
switch between defining the glazing using areas or percentages in the Quick Envelopes tab 
(see Section 7.3.1: File Options tab and 7.5.8: Quick Envelopes tab: Short cut to creating 
envelopes and windows). 

• A new sub-tab for Helpline Diagnosis (see Section 7.3.1: File Options tab). 
• A new button to allow importing the Assessor Details from a previous version of iSBEM (see 

section 7.3.2: General Information tab). 
• A new parameter to enter MPRN in the General form > General Information tab > Building 

Details sub-tab (see section 7.3.2: General Information tab). 
• A new parameter to enter the year of construction in the General form > General Information 

tab > Building Details sub-tab (see section 7.3.2: General Information tab). 
• New option of “Same space” for the parameter “Connects space to” in the definition of 

envelopes in the Geometry form > Envelope tab > General sub-tab (see Section 7.5.4: Defining 
envelopes – Envelope tab). 

• New parameter for frame factor of windows in the Geometry form > Windows & Rooflights tab 
> General sub-tab (see Section 7.5.5: Defining windows and rooflights – Windows & Rooflights 
tab). 

• New field for primary energy factor for district heating systems (see Section 7.6.1: Global and 
Defaults tab). 

• New sub-tab for “Storage & Secondary Circulation” in the Building Services form > HWS tab 
(see Section 7.6.3: Defining HWS – HWS tab). 

• New parameter for insulation type on the hot water storage in the Building Services form > 
HWS tab > Storage & Secondary Circulation sub-tab (see Section 7.6.3: Defining HWS – HWS 
tab). 

• New parameter for insulation thickness on the hot water storage in the Building Services form > 
HWS tab > Storage & Secondary Circulation sub-tab (see Section 7.6.3: Defining HWS – HWS 
tab). 

• General sub-tab renamed to “Collector Parameters” sub-tab in the Building Services form > 
SES tab (see Section 7.6.4: Defining Solar Energy Systems (SES) – SES tab). 
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• New input parameters for the solar collector performance parameters in the Building Services 
form > SES tab > Collector Parameters sub-tab (see Section 7.6.4: Defining Solar Energy 
Systems (SES) – SES tab). 

• New sub-tab for “Solar Storage & Collector Loop” in the Building Services form > SES tab (see 
Section 7.6.4: Defining Solar Energy Systems (SES) – SES tab). 

• New parameter for solar hot water storage volume in the Building Services form > SES tab > 
Solar Storage & Collector Loop sub-tab (see Section 7.6.4: Defining Solar Energy Systems 
(SES) – SES tab). 

• New parameter for solar preheating type in the Building Services form > SES tab > Solar 
Storage & Collector Loop sub-tab (see Section 7.6.4: Defining Solar Energy Systems (SES) – 
SES tab). 

• New parameter for insulation type on the solar hot water storage in the Building Services form 
> SES tab > Solar Storage & Collector Loop sub-tab (see Section 7.6.4: Defining Solar Energy 
Systems (SES) – SES tab). 

• New parameter for insulation thickness on the solar hot water storage in the Building Services 
form > SES tab > Solar Storage & Collector Loop sub-tab (see Section 7.6.4: Defining Solar 
Energy Systems (SES) – SES tab). 

• New parameter for the heat transfer rate of the heat exchanger in the solar collector loop in the 
Building Services form > SES tab > Solar Storage & Collector Loop sub-tab (see Section 7.6.4: 
Defining Solar Energy Systems (SES) – SES tab). 

• New parameter for the overall heat loss coefficient of pipes in the solar collector loop in the 
Building Services form > SES tab > Solar Storage & Collector Loop sub-tab (see Section 7.6.4: 
Defining Solar Energy Systems (SES) – SES tab). 

• New sub-tab for “Auxiliary Energy & Distribution Losses” in the Building Services form > SES 
tab (see Section 7.6.4: Defining Solar Energy Systems (SES) – SES tab). 

• New parameter on the insulation of the distribution pipes between the solar energy system and 
the back up system in the Building Services form > SES tab > Auxiliary Energy & Distribution 
Losses sub-tab (see Section 7.6.4: Defining Solar Energy Systems (SES) – SES tab). 

• New parameter on the insulation of the distribution pipes between the solar energy system and 
the back up system in the Building Services form > SES tab > Auxiliary Energy & Distribution 
Losses sub-tab (see Section 7.6.4: Defining Solar Energy Systems (SES) – SES tab). 

• New parameter on the circulation system of the solar energy system in the Building Services 
form > SES tab > Auxiliary Energy & Distribution Losses sub-tab (see Section 7.6.4: Defining 
Solar Energy Systems (SES) – SES tab). 

• New parameter on the nominal pump power in the solar energy system in the Building Services 
form > SES tab > Auxiliary Energy & Distribution Losses sub-tab (see Section 7.6.4: Defining 
Solar Energy Systems (SES) – SES tab). 

• New sub-tab for viewing Calculation Logs in the Ratings form (see Section 8.1.1: Building 
Regulations Check tab and 8.1.2: Asset Rating tab).  

• New sub-tab for viewing Calculation Errors in the Ratings form (see Section 8.1.1: Building 
Regulations Check tab and 8.1.2: Asset Rating tab).  

• New sub-tab for accessing supporting documents in the Ratings form (see Section 8.1.1: 
Building Regulations Check tab and 8.1.2: Asset Rating tab). 

• Data reflection report of the actual building also produced in pdf format (see Section 8.2.3: 
Data Reflection Report – Actual Building). 

 
Changes and additions in 23rd December 2008 version 3.3.b:  
 
1. Further explanation or clarification of existing parameters and functionality of iSBEM. This 

“Further guidance” icon shown in the left margin is used to indicate these items in the text. 
 

• Guidance on basics of energy calculations (see Section 2.2: Calculation basics for Building 
Regulations compliance purposes and Section 2.3: Calculation basics for Building Energy 
Rating Certificate purposes). 

• Guidance on primary energy and emission factors (see Section 2.4: Primary Energy and CO2 
Emissions in Energy Calculations). 

• Guidance deciding whether iSBEM is appropriate to model a building (see Section 2.5: 
Deciding whether SBEM is appropriate). 

• Guidance on internal walls between merged zones (see Section 3.3: Zoning guide – How to 
zone your building). 

• Guidance on zoning rules (see Section 3.3: Zoning guide – How to zone your building). 
• Guidance on system requirements (see Section 4.1: System Requirements). 
• Cm value renamed to κm (see section 7.4.1: Defining construction types). 
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• Guidance on the number of object to create in a project (see section 7.5.3: Defining zones – 
Zones tab). 

• Guidance on zone height (see Section 7.5.3: Defining zones – Zones tab). 
• Guidance on adjacency for envelopes (see Section 7.5.4: Defining envelopes – Envelope tab). 
• Guidance on defining fully glazed envelopes (see Section 7.5.5: Defining windows and 

rooflights – Windows & Rooflights tab). 
• Guidance on the default electric HVAC system (see Section 7.6.1: Global and Defaults tab). 
• Guidance on heat recovery options (see 7.6.2: Defining HVAC Systems – HVAC Systems tab). 
• Guidance on auxiliary energy (see 7.6.2: Defining HVAC Systems – HVAC Systems tab). 
• Guidance on bivalent systems (see 7.6.2: Defining HVAC Systems – HVAC Systems tab). 
• Modified options for cooling generator types (see 7.6.2: Defining HVAC Systems – HVAC 

Systems tab). 
• Guidance on metering provision for lighting and for individual HVAC systems (see 7.6.2: 

Defining HVAC Systems – HVAC Systems tab). 
• Guidance on system controls (see 7.6.2: Defining HVAC Systems – HVAC Systems tab). 
• Guidance on indirectly conditioned spaces (see Section 7.6.8: Defining the zone specific 

building services- Zones tab). 
• Guidance on how to define a zone that has more than one HVAC system (see Section 7.6.2: 

Defining HVAC Systems – HVAC Systems tab and Section 7.6.8: Defining the zone specific 
building services- Zones tab). 

• Guidance on SFP for mechanical ventilation systems (see Section 7.6.2: Defining HVAC 
Systems – HVAC Systems tab and Section 7.6.8: Defining the zone specific building services- 
Zones tab). 

• Guidance on mechanical exhaust system in the zones (see Section 7.6.8: Defining the zone 
specific building services- Zones tab). 

• Guidance on defining lighting in the zones (see Section 7.6.8: Defining the zone specific 
building services- Zones tab). 

• Guidance on defining lighting controls in the zones (see Section 7.6.8: Defining the zone 
specific building services- Zones tab). 

• Guidance on recommendations (see Section 8.1.2: Asset Rating tab and Section 8.2.8: 
Advisory Report). 

• Guidance regarding an undefined building environment (see Section 8.2.7: Building Energy 
Rating Certificate). 

• Guidance on error files (see Section 8.2.11: Accessing the reports from the project folder). 
• Guidance on converting files created by previous iSBEM versions to the current version (see 

APPENDIX B: iSBEM file conversion).  
 
2. Changes related to new functionality of the iSBEM version 3.3.b. This “new” icon shown in the 

left margin indicates in the text where iSBEM has changed since the previous version.  
 

• Version of iSBEM specifically for users of Office 2007 (see Section 4.1: System Requirements). 
• New section on sources of help information (see section 4.6: Getting assistance with using 

iSBEM). 
• New tab for Local Area Network Settings in the General form > File Options tab (see section 

7.3.1: File Options tab). 
• New layout and functionality in the General form > General Information tab > Energy Assessor 

Details sub-tab > Energy Assessor Details sub-form (see section 7.3.2: General Information 
tab). 

• New field for the EPCgen.net Activation Code for the Energy Assessor in the General form > 
General Information tab > Energy Assessor Details sub-tab > Energy Assessor Details sub-
form (see section 7.3.2: General Information tab). 

• Difference default values for air permeability depending on the purpose of analysis (see section 
7.5.2: Defining zones – Zones tab). 

• New domestic-type activities added to the building type Dwelling (see section 7.5.3: Defining 
zones – Zones tab). 

• New tick box to define variable speed pumping for central heating systems using water (see 
Section 7.6.2: Defining HVAC Systems – HVAC Systems tab). 

• New parameter to define cooling fuel type (see Section 7.6.2: Defining HVAC Systems – HVAC 
Systems tab). 

• New fields and functionality in the CHP tab to allow for tri-generation (see section 7.6.7: 
Defining the CHP generator – CHP Generator tab). 

• New parameter to define the parasitic power for occupancy sensing lighting controls in a zone 
(see Section 7.6.8: Defining the zone specific building services- Zones tab). 
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• New sub-tab to separate the parameters on display lighting from the rest of the general lighting 
and controls parameters (see Section 7.6.8: Defining the zone specific building services- Zones 
tab). 

• Generation of the XML file required for lodgement of official BER documents (see Section 
8.2.11: Accessing the reports from the project folder). 
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This manual and the adaptation of the software tools described in it, for the Republic of Ireland Building Regulations, 
were developed by the BRE for Sustainable Energy Authority Ireland (SEAI). This manual is a version specifically 
adapted for the Republic of Ireland from the original User Guide which, together with the software tools described in 
it, was developed by the BRE for the Department for Communities and Local Government (DCLG), under a contract 
managed for DCLG by AECOM (formerly Faber Maunsell). 

 

Disclaimer 

The iSBEM User Guide cannot provide legal advice or a definitive interpretation of the law. 
The guidance provided in this document is limited to the technical operation of the software 
tool. It is offered in good faith but is not binding on any person(s) or organization. The same 
applies to the default values in the interface, which should be viewed as conservative 
suggestions intended to be replaced by actual values.  
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1. HOW TO USE THIS GUIDE 

1.1. Scope of the guide 

The purpose of this guide is to give an introduction to the use of iSBEM, an interface for 
SBEM (Simplified Building Energy Model) - an approach for the “Non-domestic Energy 
Assessment Procedure” (NEAP) for assessing the energy performance of buildings. 

 

This guide includes: 
• An explanation of the role of iSBEM in the NEAP with a brief overview of the 

methodology. 
• How to set up iSBEM to operate on your computer. 
• How to work through the steps of the input. 
• How to obtain the Building Regulations Compliance document and how to obtain 

a Building Energy Rating (BER) Certificate and Advisory Report.  
• Guidance on how to assemble the required information for your own building. 
• A tutorial. 
• How to convert files created with previous versions of iSBEM to be compatible 

with the new version (3.5.b). 
 
This guide does not include: 

• A detailed description of the structure of the NEAP. 
• A full definition of the “reference” building which is used to assess compliance 

with Building Regulations, or the “notional” building which is used to calculate the 
BER. 

• A description of the contents of the NCM Construction, Glazing, or Activity area 
databases. 

• A detailed description of SBEM, the calculation engine to which iSBEM is an 
interface. This is described in the SBEM Technical Manual, available for 
download from the SEAI website at 
http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM
_Software/Download_SBEM_Software.html.    

• Guidance related to energy calculations for the UK Building Regulations (This is 
described in a separate volume). 

 

1.2. Structure of the guide 

This guide is split into eight chapters and five appendices, and it contains a tutorial. 

 

TUTORIAL: The tutorial runs alongside Chapters 4 through to 8 with a task set at each 
stage, starting from opening iSBEM through to printing off the Compliance document and 
Building Energy Rating Certificate. It is recommended that you complete this tutorial 
before trying to enter real building data. Details on the Example building used in the 
tutorial are included in APPENDIX A:.  

 
 

http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM
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Chapter 1: HOW TO USE THIS GUIDE 

 

Chapter 2: INTRODUCTION TO iSBEM, SBEM, AND THE  

 

Chapter 3: ASSEMBLING REAL BUILDING DATA 

This chapter provides guidance on preparing building data for inputting into iSBEM, 
including how to zone a building. 

 
Chapter 4: iSBEM BASICS – GETTING STARTED 

This chapter includes instructions on how to install iSBEM, start a new or open an 
existing project, and correctly save and close projects. 

 

Chapter 5: TOUR OF iSBEM 

This chapter introduces the structure of iSBEM in terms of its forms, tabs, and sub-tabs. 

 

Chapter 6: BASIC iSBEM FUNCTIONALITY AND THE HELP MENU 

This chapter details some of iSBEM’s key commands, buttons, and functionality. 

 

Chapter 7: ENTERING A BUILDING INTO iSBEM 

This chapter takes the user through each of the forms in turn and explains the steps of 
inputting a building into iSBEM. 

 
Chapter 8: CALCULATING AND VIEWING THE ENERGY PERFORMANCE OF THE 
BUILDING- THE RATINGS FORM AND OUTPUT REPORTS 

This chapter explains how to produce the Compliance document for Building Regulations, 
obtain the Building Energy Rating, and view the other output documents produced by 
SBEM. 

 

APPENDIX A: TUTORIAL BUILDING DETAILS AND iSBEM OUTPUT 
DOCUMENTATION 

APPENDIX B: iSBEM file conversion 

APPENDIX C: User-defined construction database 

APPENDIX D: List of parameters required by iSBEM 

APPENDIX E: Connection to EPCgen.net. 
APPENDIX F: Matrix of activity areas and building types 
 

T 
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2. INTRODUCTION TO iSBEM, SBEM, AND THE NEAP 

2.1. What is iSBEM, SBEM, and the NEAP? 

The Energy Performance of Buildings Directive (EPBD) 2002/91/EC of the European 
Parliament and Council (dated 16th December 2002) requires that the energy 
performance of new buildings be evaluated with a calculation methodology that complies 
with the Directive. Separately, the Directive calls for the production of energy 
performance certificates for many existing buildings. This uses the same calculation 
methodology, although this is not mandatory. In response, the UK Department for 
Communities and Local Government (CLG) commissioned the National Calculation 
Methodology (NCM) for the energy performance of buildings. The Republic of Ireland has 
adopted a similar methodology in the form of the Non-domestic Energy Assessment 
Procedure (NEAP). 

The initial use of the NCM was for compliance with the 2006 amendments to Part L of the 
Building Regulations in England and Wales (ADL1A and ADL2A). Similar amendments 
have been made in Scotland and Northern Ireland.  

For dwellings, Dwelling Energy Assessment Procedure (DEAP) should be used. This is 
not dealt with in this Guide. 

SBEM, iSBEM, and the associated databases and files are an implementation of the non-
domestic building part of the NCM that is freely available to users (subject to certain 
licence conditions). Other accredited software may be used if preferred, but it is intended 
that SBEM and iSBEM should be applicable to the majority of buildings.  

The initial versions of SBEM and iSBEM have principally been aimed at meeting Building 
Regulations requirements for compliance with the 2006 amendments to Part L of the 
Building Regulations in England and Wales. In later versions, further features were 
incorporated in order to allow the software to be used for Building Regulations 
requirements in Scotland and Northern Ireland (Scottish Building Regulations Section 6 
and Northern Ireland Building Regulations Part F) and for generating Energy 
Performance Ratings for existing non-domestic buildings throughout the UK. Further 
features were then added to accommodate the Building Regulations requirements in the 
Republic of Ireland. 

This manual describes how to use iSBEM to check for compliance with the Building 
Regulations in the Republic of Ireland and to generate a Building Energy Rating 
Certificate and the accompanying Advisory Report. 

The approach to the NCM/NEAP embodied in this tool comprises a calculation engine 
called the Simplified Building Energy Model (SBEMi) operating with a user interface 
called iSBEMii. The purpose of SBEM and its interface is to produce consistent and 
reliable evaluations of energy use in non-domestic buildings for Building Regulations 
Compliance (and for building performance certification purposes.) Although it may assist 
the design process, it is not primarily a design tool and should not be used for making 
strategic design decisions. It does not calculate internal temperatures, for example.  

It is anticipated that vendors of design and other software will offer design and asset 
rating calculations as part of their packages, either by embedding SBEM within them or 
by offering accredited alternative calculation methods.  

SBEM consists of a calculation methodology (described below), which runs together with 
a compliance checking module (BRIRL) and a Building Energy Rating Certificate 
generator (BERgen), which utilise some of the same data during the calculation. The user 

                                                
i Pronounced s-bem.  
ii Pronounced i-s-bem. 
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sees iSBEM, the interface software, which interweaves these components together and 
interacts with a series of databases to provide consistent data to the calculation while 
simplifying the user's need to obtain raw building construction data. 

SBEM is a compliance procedure and not a design tool. If the performance of a 
particular feature is critical to the design, even if it can be represented in SBEM, it 
is prudent to use the most appropriate modelling tool for design purposes. In any 
case, SBEM should not be used for system sizing. 
 

2.1.1. Key differences in the software 

The main differences between iSBEM v3.5.b and the previous version are as follows:  

• Modification of iSBEM so that if using Access 2007, the “Import Details” 
facility for energy assessors allows accessing file types with the extension 
"accdb" rather than "mdb" for Access 2003.  

• Modifications related to Landmark’s environment for validating status of 
energy assessors when producing EPCs.  

• Inclusion of updated NCM Constructions Database which contains the 
revised Irish constructions.  

• Correction of problem with creating the “pdf” data reflection report which, in 
certain cases, causes a crash.  

• Adding precautions to prevent problems, in certain cases, during the 
generation of the reference building if trying to create a window with a very 
small area.  

• Adjustment of text display in BRIRL output documents to prevent overlapping 
of text in certain cases.  

• Modification in order to prevent a roof with metal-cladding from affecting the 
thermal bridging junctions for wall-floor.  

• Correction of reported actual building's heat transfer coefficients and alpha 
value in “sim” files. 

 

2.2. Calculation basics for Building Regulations compliance 
purposes 

The calculation procedure in SBEM complies with the NEAP. It is suitable for use for the 
majority of buildings, but some designs will contain features which mean that more 
accurate energy calculations may be obtained using more sophisticated calculation 
methods.  

In brief, the methodology calculates the energy consumption (for space heating and 
cooling, water heating, ventilation, and lighting) and CO2 emissions associated with a 
standardised use of a building. The energy consumption is expressed in terms of kWh 
per m2 of floor area per year, and the CO2 emissions are expressed in terms of kg of CO2 
per m2 floor area per year. Full details of the methodology will be made available on the 
Sustainable Energy Authority Ireland (SEAI) website at http://www.seai.ie. 

The performance criteria are based on the relative values of the calculated primary 
energy consumption and CO2 emissions of a building being assessed, and similar 
calculated values for a “reference building”. The criteria are determined as follows: 

NEW 

http://www.seai.ie
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• Primary energy consumption and CO2 emissions for both the proposed building 
and the reference building are calculated using SBEM. 

• The calculated primary energy consumption of the proposed building is divided by 
that of the reference building, the result being the Energy Performance 
Coefficient (EPC) of the proposed building. To demonstrate that an acceptable 
primary energy consumption rate has been achieved, the calculated EPC of the 
building being assessed should be no greater than the Maximum Permitted 
Energy Performance Coefficient (MPEPC). The MPEPC is 1.0.  

[ ] ( )EPCtCoefficienePerformancEnergyannummkWh
UseEnergyPrimary
UseEnergyPrimary

reference

actual =./ 2

 

• The calculated CO2 emission rate of the proposed building is divided by that of 
the reference building, the result being the Carbon Performance Coefficient 
(CPC) of the proposed building. To demonstrate that an acceptable CO2 emission 
rate has been achieved, the calculated CPC of the building being assessed 
should be no greater than the Maximum Permitted Carbon Performance 
Coefficient (MPCPC). The MPCPC is 1.0.  

[ ] ( )CPCtCoefficienePerformancCarbonannummkgCO
EmissionsCO
EmissionsCO

reference

actual =./ 2
2

2

2

 

Potentially, the MPEPC the MPCPC could be decreased as future changes to the 
Building Regulations demand higher standards. 

SBEM will calculate the EPC and the CPC of the building being assessed and clearly 
indicate whether the maximum permitted values have been exceeded. 

The requirements that the calculated EPC and CPC do not exceed the calculated 
MPEPC and MPCPC, respectively, apply to the constructed building. However, designers 
may wish to calculate the EPC and CPC at an early design stage in order to ensure that 
the requirements can be achieved by the constructed building. 
 
While a full description of the reference building will be made available on the SEAI 
website, as above, in general, it has the following main characteristics: 

• The same geometry, orientation, usage, and service strategy as the evaluated 
building.  

• The amount of glazing in the reference building is not the same as that in the 
evaluated building. The area of glazing is a fixed percentage of every external 
wall and roof and is dependent on the building type. 

• It is exposed to the same weather conditions as the evaluated building. 
• Standard operating patterns (to allow consistent comparison between buildings in 

the same sector). 
• Standardised assumptions for building fabric, glazing, and HVAC plant 

efficiencies. 
 
NB: For space and water heating, the system in the reference building will use the same 
fuel used in the corresponding system in the actual building, except if the actual building 
uses a low or zero carbon (LZC) heating technology, in which case, the reference 
building will use natural gas as fuel for the corresponding system. For the purposes of the 
NEAP, low or zero carbon (LZC) heating technologies are to include: biomass, biogas, 
heat pumps, waste heat, and renewable energy sources (i.e., photovoltaic systems, solar 
thermal systems, wind generators, combined heat and power generators, etc.). The 
reference building will always use grid-supplied electricity as fuel for cooling and auxiliary 
energy. 
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Any service not covered by the Building Regulations (e.g., emergency escape lighting, 
specialist process lighting, etc.) is ignored in both the actual and reference buildings. 

SBEM calculates the energy demands of each space in the building according to the 
activity within it. Different activities may have different temperatures, operating periods, 
lighting standards, etc. SBEM calculates heating and cooling energy demands by 
carrying out an energy balance based on monthly average weather conditions. This is 
combined with information about system efficiencies in order to determine the energy 
consumption. The energy used for lighting and hot water is also calculated.  This requires 
information from the following sources: 

 

Information Source 

Building geometry such as 
areas, orientation, etc.  

Assessor reads from drawings or direct 
measurement. 

Weather data Internal database. 

Selection of occupancy 
profiles for activity areas 

For consistency, these come from an internal 
Activity database – assessor selects by 
choosing building type and activity from 
database for each zone. 

Activity assigned to each 
space  

Assessor defines within iSBEM by selecting 
from internal database (the user should identify 
suitable zones for the analysis by examining 
the building or drawings). 

Building envelope 
constructions 

Assessor selects from internal Construction 
and Glazing databases or inputs parameters 
directly (“Inference” procedures may be used 
for energy certification of existing buildings). 
Assessor can also define their own 
constructions in the user-defined construction 
database.  

HVAC systems Assessor selects from internal databases or 
inputs parameters directly  

Lighting Assessor selects from internal databases or 
inputs parameters directly  

Table 1: Calculation parameters for SBEM 

 

The “inference” facility in iSBEM guides the assessor through the data input procedures 
and directs him/her towards appropriate internal databases. This option is intended for 
use when certifying existing buildings if the drawings or construction information are not 
available.  

Further information on compliance with building regulations can be found on the 
Sustainable Energy Authority Ireland (SEAI) website at http://www.seai.ie and the 
website of the Department of the Environment, Heritage, and Local Government at 
http://www.environ.ie.  

 

http://www.seai.ie
http://www.environ.ie
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2.3. Calculation basics for Building Energy Rating Certificate 
purposes 

A Building Energy Rating (BER) Certificate and an Advisory Report are to be supplied by 
the occupier of a building to a prospective buyer or tenant when constructed, sold, or 
rented. The objective of the rating is: 

a. To give the prospective buyers or tenants information about the energy performance 
of the building. 

b. To give builders/developers and vendors/landlords an incentive to upgrade the 
energy performance of the building by giving visible credits to superior standards. 

The BER certificate must be accompanied by an Advisory Report setting out 
recommendations for cost-effective improvements to the energy performance of the 
building. However, there will be no legal obligation on vendors or prospective purchasers 
to carry out the recommended improvements. 

The calculation of the Building Energy Rating (BER) follows the NCM (NEAP). The BER 
is an indication of the energy performance of the building. It covers energy use for space 
heating and cooling, water heating, ventilation, and lighting calculated on the basis of 
standard occupancy. The rating is expressed as a ratio of calculated primary energy use 
per floor area per year (kWh/m2.annum) for the actual building compared to that 
calculated for a “notional” building.  

BER certificates are intended to send market signals about the relative performance of 
comparable buildings, and so it is necessary that the notional building should be the 
same for all buildings of a given type. In order to provide this consistency, the notional 
building must be the same irrespective of: (a) whether the building is naturally ventilated 
or air conditioned and (b) the fuel choice. 

The insulation levels and HVAC efficiencies in the notional building are identical to the 
reference building used for building regulations compliance checking except that certain 
parameters in the notional building are fixed irrespective of features in the actual building. 
These aspects are: 

a. The space heating and hot water service is always met by a gas-fired system 
irrespective of whether a fuel other than gas is used in the actual building, or is even 
available in the locality of the actual building. 

b. The notional building has a fixed servicing strategy regardless of the strategy adopted 
in the actual building. Therefore: 

• Each space is heated to the heating setpoints defined in the NCM Activity 
Database, irrespective of whether the corresponding space in the actual 
building has heating provision or not.  

• Each space is cooled, to a fixed cooling setpoint, irrespective of whether the 
particular space in the actual building has cooling provision or not.  

• Each space is naturally ventilated, irrespective of whether the corresponding 
space in the actual building has natural or mechanical ventilation. 

The performance criteria are based on the relative values of the calculated primary 
energy consumption and CO2 emission rate of a building being assessed, and similar 
calculated values for the notional building. The criteria are determined as follows: 

• Primary energy consumption and CO2 emissions for both the actual building and 
the notional building are calculated using SBEM. 

• The calculated primary energy consumption of the actual building is divided by 
that of the notional building, the result being the Building Energy Rating (BER) of 
the actual building. The rating is also converted into an energy band/grade on an 
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“A-G” scale. 

[ ] ( )BERRatingEnergyBuildingannummkWh
UseEnergyPrimary
UseEnergyPrimary

notional

actual =./ 2  

• The calculated CO2 emission rate of the actual building is divided by that of the 
notional building, the result being the CO2 Emissions Indicator of the actual 
building. 

 [ ] IndicatorEmissionsCOannummkgCO
EmissionsCO
EmissionsCO

notional

actual
2

2
2
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2 ./ =  

 

The BER certificate will also display the energy label corresponding to the BER (Figure 1) 
and the main heating fuel in the proposed building which is taken as the fuel which 
delivers the greatest total thermal output (space or water heating) over the year. 

Further information on the BER can be found on the Sustainable Energy Authority Ireland 
(SEAI) website at http://www.seai.ie and the website of the Department of the 
Environment, Heritage, and Local Government at http://www.environ.ie. 

 

 
 

Figure 1: Energy labels for the BER 
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http://www.seai.ie
http://www.environ.ie
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2.4. Primary Energy and CO2 Emissions in Energy 
Calculations  

In SBEM, the energy calculations for the Republic of Ireland incorporate the primary 
energy factors and the CO2 emission factors shown in Table 2 for the different fuel types. 

 

Fuel type 
Primary energy factors 
kWh/kWh 

Emission factors 
kgCO2/kWh 

Natural Gas 1.1 0.203 
LPG 1.1 0.232 
Biogas 1.1 0.025 
Oil 1.1 0.272 
Coal 1.1 0.361 
Anthracite 1.1 0.361 
Smokeless Fuel (inc Coke) 1.2 0.392 
Dual Fuel Appliances (Mineral + Wood) 1.1 0.289 
Biomass 1.1 0.025 
Grid Supplied Electricity 2.7 0.643 
Grid Displaced Electricity 2.7 0.643 
Waste Heat 1.05 0.018 

Table 2: Primary energy and carbon dioxide emission factors 

 

The primary energy is considered to include the delivered energy, plus an allowance for 
the energy “overhead” incurred in extracting, processing, and transporting a fuel or other 
energy carrier to the building. Hence, the primary energy factors in Table 2 denote kWh 
of primary energy per kWh of the building’s delivered energy. 

The carbon dioxide emissions are calculated on the basis of the primary energy, i.e., due 
to the delivered energy at the building and the energy incurred in extracting, processing, 
and transporting a fuel or other energy carrier to the building. The emission factors in 
Table 2 denote the CO2 emissions released in kgCO2 per kWh of the building’s delivered 
energy. 

Hence, after the delivered energy is calculated by SBEM for the building, it is converted 
using the appropriate factors (from Table 2) for the fuel used in order to produce the 
estimated primary energy, in kWh/m2 per annum, and the CO2 emission rate, in kg 
CO2/m2 per annum. 

 

2.5. Deciding whether SBEM is appropriate 

All calculation processes involve some approximations and compromises, and SBEM is 
no exception. The most obvious limitations relate to the use of the CEN monthly heat 
balance method. This means that processes which vary non-linearly at shorter time-steps 
have to be approximated or represented by monthly parameters. The HVAC system 
efficiencies are an example of this. On the other hand, SBEM does have provision to 
account for processes that may not be present in software packages that contain more 
sophisticated fabric heat flow algorithms, such as, duct leakage, thermal bridge 
calculations, and infiltration allowances. 

The user interface, iSBEM, provides the user with routes by which some non-standard 
systems and other features can be represented. For example, the ability to input specific 
fan powers provides a route by which demand-controlled ventilation might be handled, 
using pre-calculated effective SPF. There are also possibilities to go beyond these within 
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the existing SBEM model via more general interfaces. For example, other countries have 
implemented night ventilation procedures with monthly heat balance calculation engines. 

It is, therefore, difficult to give absolute rules about when SBEM can and cannot be used. 
As broad guidance, it is more likely to be difficult to use SBEM satisfactorily if the building 
and its systems have features that are (a) not already included in iSBEM and (b) have 
properties that vary non-linearly over periods of the order of an hour. However, as the 
example above shows, this is not a universal rule. There is a balance between the time 
and effort required to carry out parametric studies to establish input values for SBEM and 
detailed explicit modelling of a particular building. 

Features which cannot currently be represented in iSBEM: 

• Night ventilation strategy 

• Ventilation with enhanced thermal coupling to structure  

• Demand-controlled ventilation 

• Automatic blind control 

• Light transfer between highly glazed internal spaces such as atria or lightwells. 

 

If in doubt about whether iSBEM would be appropriate for modelling your building, please 
contact your Accreditation Scheme Provider. 

 

2.6. Overview of how a building is defined in iSBEM 

There is a number of stages to inputting a building in iSBEM: 

a Enter general information about the building, the owner, and the certifier/assessor, 
and select the appropriate weather data. 

b Build up a database of the different forms of constructions and glazing types. 

c After “zoning” the building (on the drawings), create the zones in the interface, and 
enter their basic dimensions, along with the air permeability of the space. 

d Define the envelopes of each zone, i.e., walls, floor, ceiling, etc. The envelopes’ 
areas, orientations, the conditions of the adjacent spaces, and the constructions used 
all need to be defined. 

e Within each envelope element, there may be windows/rooflights or doors. The areas 
and types of glazing or door within each envelope element need to be entered.  

f Similarly, within the envelope elements or within the window/door, there may be 
additional thermal bridges which need to be defined. 

g Define the HVAC (heating, ventilation, and air conditioning) systems, the HWS (hot 
water systems), and any SES (solar energy systems), PVS (photovoltaic systems), 
wind generators, or CHP (combined heat and power) generators used in the building. 

h Define the lighting system and ventilation characteristics of each zone, and assign 
the zones to the appropriate HVAC system and HWS. 

i Run the calculation and assess compliance and/or calculate energy rating. 

The building services systems, zones, envelope elements, windows, and doors are all 
referred to as “building objects” in SBEM. Figure 2 shows each of these building objects 
and demonstrates how they are linked together so that SBEM can calculate the energy 
consumption of the building. This diagram gives you an overview of what information is 
required and where you have to enter it in iSBEM. It may be useful to return to this figure 
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at the end of the tutorial, by which point you will have been introduced to all the building 
objects. 

Figure 2 serves to provide an overview of the structure of the building objects that you will 
be introduced to in this User Guide. More details on each item and how they are defined 
and linked together will be provided in detail in Chapters 5 to 8 and through the Help 
menu accessible from within iSBEM. 
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Building 
object 

Key parameters needed to 
define this building object 

Object(s) to 
which it 
needs to be 
linked 

Where it is defined in 
iSBEM 

Hierarchy of SBEM building objects 
 
 

Zone  Dimensions, activity type, 
details on lighting, heating, and 
ventilation strategy. 

HVAC and 
HWS  

Geometry form > Zones 
tab and in the Building 
Services form > Zones 
tab 

Envelope 
Elements 

Type of envelope 
(wall/floor/roof), area, 
orientation, construction type, 
thermal bridges, condition of 
adjoining space.  

Zone Geometry form > 
Envelopes tab or the 
Geometry form > Zones 
tab > Quick-Envelopes 
sub-tab 

Windows Dimensions, glazing type, 
thermal bridges, shading 
system, transmission factor, 
and whether it is a display 
window or not. 

Envelope 
Element 

Geometry form > 
Windows & Rooflights tab 
or the Geometry Form > 
Zones tab > Quick 
Envelopes sub-tab 

Doors Area, construction type, thermal 
bridges, and type of door. 

Envelope 
Element 

Geometry form > Doors 
tab 

HVAC  
 

System type, heat source, fuel 
type, further details on 
efficiencies, duct leakage, 
specific fan power, and 
controls. 

Zone Building Services form > 
HVAC systems tab 

HWS   Generator type, fuel type, 
details on efficiency and 
whether it is a storage system. 
 

Zone Building Services form > 
HWS  tab 

SES 
 

Area, orientation, inclination. HWS  Building Services form > 
SES tab 

PVS 
 

Area, orientation, inclination 
and type. 
 

- Building Services form >  
PVS tab 

Wind 
generator 

Terrain type, dimensions, and 
power. 

- Building Services form >  
Wind generator 

CHP 
generator 

Fuel type, details on efficiency, 
% building heat and hot water 
supplied, and thermal and 
electrical efficiencies. 

(HVAC) Building Services form >  
CHP tab 

 
 
 
 
 
 

Figure 2: Structure of SBEM objects 

HVAC1 

HWS 

Zone 1 Zone 2 Zone 3 …and so on 
for all the 
zones that 
are served 

by this 
HVAC 
system 

Wall Ceiling Floor Wall Wall Wall 
…and so on 

for all the 
envelope 
elements 

that 
surround 
this zone 

SES 
…and so on for  all the windows, roof-lights, and 
doors that are present in the envelope elements Window 

…and 
similarly for 

all the 
zones 

served by 
this HWS 

PVS 

If 
 appropriate 

HVAC2 

Similarly for zones 
served by this 
HVAC system 

If there are other 
HVAC systems… 

Wind 
gene

CHP 

Door 
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3. ASSEMBLING REAL BUILDING DATA 

3.1. Introduction 

There are four steps to calculating the ratings for a building. First, a decision needs to be made 
on whether SBEM is the appropriate analysis tool. Then, information on the building needs to be 
gathered, analysed, and finally, entered into the interface. The tutorial in this Guide focuses on 
the functionality of the tool. To ease that process, all the information on the Example building is 
provided, and the zoning is done for you. However, when analysing a real building you will need 
to collect and analyse the building data yourself. This chapter will guide you on what information 
you need to gather, and how you need to process this information before you can enter it into the 
interface, iSBEM. 
 

 
Figure 3: Steps for calculating the rating for a building 

 

 

 

Step 2 
Gather the raw data on 

your building (see 
Section 3.2) 

Step 4 

Enter the information into 
the interface, double-
check it, and run the 

calculation (see Chapters 
5 to 8) 

Step 3 
Analyse the information 
and identify the different 
zones (see Section 3.3) 

Step 1 
Decide whether SBEM is 
the appropriate analysis 

tool (see Section 2.5) 
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3.2. Tips for gathering information for iSBEM 

Item Requirements Potential issues and experiences  

  New build and 
refurbishment 

Existing building 

Architectural: 
building 
spatial layout 
of functions, 
geometry, and 
orientations 

 

 

Building plans, 
sections, site 
plan 

 

 

Plans and 
schedules should 
be available at this 
stage. What degree 
of detail do they 
show? For 
instance, have 
decisions been 
made on usage of 
each space in the 
building? 

Are plans available? How old are 
they? Can they be used? What 
degree of detail do the plans show? 

Have there been changes to the 
internal layout (with consequent 
effects on activity type, area, and 
geometry)? 

Don’t assume that adequate 
information on an existing building 
can be obtained easily. Any planning 
should include time to physically 
survey at least some parts of the 
building. Note that there may be 
practical obstacles to overcome, such 
as, measuring zone dimensions 
without specialist tools to hand. 

Envelope 
construction 
materials 

Detailed 
drawings, 
schedules of 
construction 
details 

Detailed drawings 
and schedules 
should be 
available. What 
degree of detail do 
they show? For 
instance, do details 
show junctions and 
hence thermal 
bridges? Do they 
rely on the 
constructors to use 
initiative to select 
suitable materials? 

Are drawings and schedules 
available? How up-to-date are they? 
What degree of detail do they show? 
Have there been changes, for 
instance replacement windows, re-
roofing, or additional insulation? 

It may be necessary to investigate 
construction details such as wall or 
roof constructions and thermal 
bridges by opening them up. If this is 
impossible, then any assumptions 
made must err on the pessimistic 
side. The standard databases allow 
this, based on construction date 
(assuming compliance with the then 
current Building Regulations). 

Building 
Services 

 

 

Description of 
plant and its 
control, 
schedules of 
plant sizing 
including fans 

Detailed drawings 
and schedules 
should be 
available. What 
degree of detail do 
they show? For 
instance, is it 
possible to work 
out specific fan 
power from fan 
power and air 
quantity? Has the 
fine detail of 
installation been 
left to equipment 

Are drawings and schedules 
available? Are they held on site or by 
a maintenance or other remote 
contractor? Is there a building log 
book? How up-to-date are they? 
What degree of detail do they show? 
Have there been changes, such as 
plant replacement or to the control 
philosophy? 

If written information is not available, 
the plant will need to be surveyed. 
Who has access to plant rooms and 
when? There are safety issues. Is the 
surveyor familiar with plant type and 
specifications? It can be difficult to 
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suppliers and 
installers – If so, 
could they 
inadvertently 
compromise the 
design intent? 

identify systems from simple visual 
inspection. Any assumptions made 
must err towards a less efficient plant 
and/or less precise control. 

If an external contractor has 
responsibility for operation or 
maintenance, it may be necessary to 
probe carefully how the plant is 
actually configured. This is to avoid 
misunderstandings on how it should 
work.  

Table 3: Tips for gathering information for iSBEM 

 

3.3. Zoning guide – How to zone your building 

The way a building is subdivided into zones will influence the predictions of energy performance. 
Therefore, the NCM Modelling Guide defines zoning rules that must be applied when assessing 
a building for Building Regulations purposes (compliance or energy certification). The end result 
of the zoning process should be a set of zones which are distinguished from all others in contact 
with it by differences in one or more of the following: 

• The Activity attached to it 

• The HVAC system which serves it 

• The lighting system within it 

• The access to daylight (through windows or rooflights). 

 

To this end, the suggested zoning process within a given floor plate is as follows: 

1. Divide the floor into separate physical areas, bounded by physical boundaries, such as 
structural walls or other permanent elements. 

2. If any part of an area is served by a significantly different HVAC or lighting system, 
create a separate area bounded by the extent of those services.  

3. If any part of an area has a different activity taking place in it, create a separate area for 
each activity. 

4. Attribute just one Activity (selected from the drop-down list available for each building 
type) to each resulting area. If the building is speculative, and the activity is not fully 
defined, select the appropriate ‘Speculative Activity’ for the relevant building type. 

5. Divide each resulting area into Zones receiving significantly different amounts of daylight, 
defined by boundaries which are: 

• At a distance of 6m from an external wall containing at least 20% glazing.  

• At a distance of 1.5 room heights beyond the edge of an array of rooflights if the area 
of the rooflights is at least 10% of the floor area. 

• If any resulting Zone is less than 3m wide, absorb it within surrounding zones. 

• If any resulting Zones overlap, use your discretion to allocate the overlap to one or 
more of the Zones. 

NB: Currently iSBEM is not able to realistically model sunspaces, light-wells, lightpipes, or atria, 
as it cannot represent light transfer between highly glazed/reflective internal spaces such as 
these. For buildings where these elements are a significant part of the design, we suggest that 
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the building be modelled using approved dynamic simulation models 
(http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/).   

6. Merge any contiguous areas which are served by the same HVAC and lighting systems, 
have the same Activity within them (e.g., adjacent hotel rooms, cellular offices, etc.), and 
which have similar access to daylight, unless there is a good reason not to. 

NB: Small unconditioned spaces like store cupboards, riser ducts, etc., can be absorbed into the 
adjacent conditioned spaces. In iSBEM, this would involve adding their floor area to that of the 
adjacent conditioned space. Larger areas should be treated as indirectly conditioned spaces. 
See note in Section 7.6.8: Defining the zone specific building services, regarding indirectly 
conditioned spaces. 

7. Each Zone should then have its envelopes described by the area and properties of each 
physical boundary. Where a Zone boundary is virtual, e.g., between a daylit perimeter 
and a core Zone, no envelope element should be defined. SBEM will then assume no 
transfer of heat, coolth, or light across the boundary, in either direction. In the context of 
iSBEM, the building needs to be divided into separate Zones for each Activity area, 
subdivided where more than one HVAC system serves an Activity area.  

 
NB: If the internal envelopes between merged zones have been designed of heavy construction 
to have thermal mass, then their κm value (renamed from Cm value) will determine how the 
building retains and emits heat, and hence they should be defined in iSBEM. You can sum the 
areas of two or more internal walls (between merged zones) with the same construction and 
orientation and enter them as one envelope (assigned to the zone resulting from the merging) 
whose adjacency is “Same space”. If, on the other hand, the internal walls are partitions of light 
construction and very small thermal mass, then they should not cause any significant effects on 
the calculation if they were omitted from the iSBEM model. If in doubt about the thermal mass of 
the internal partitions, it is better to err on the side of caution and include them in your model as 
described above. 

NB: The term “zone” is used as a short hand for “activity area” throughout this manual. It 
should not be assumed to be the same as a building services control zone, for instance, 
on the basis of building façade, although in some cases they may align.  
 
NB: For building regulations calculations purposes, we recommend that users generally avoid 
creating more than 100-150 zones in iSBEM. However, the processing time will depend on the 
total number of objects (not just zones), i.e., zones, envelopes, windows, etc. Note that for 
building regulations compliance checking, the calculation has to generate 2 buildings: the actual 
and reference, so the number of objects (all the zones, envelopes, windows, etc.) that the 
calculation has to process is multiplied by 2, while for the BER to be calculated, 3 buildings need 
to be generated: actual, reference, and notional, i.e., all the objects in the input are multiplied by 
3 to give the total number of objects being processed by SBEM. Hence, creating a project with a 
very large number of objects will slow down the calculation and may cause it to crash. 

 

3.4. Measurement and other conventions 

In order to provide consistency of application, standard measurement conventions have been 
adopted to be used as part of the NCM (NEAP). These apply to both accredited dynamic 
simulation tools and third party software interfaces to SBEM, although some parameters may 
only relate to the latter. These conventions are specified in Table 4 below: 

 

 

http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/
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Parameter Definition 

Zone Height Floor to floor height (floor to soffit for top floor), i.e., including 
floor void, ceiling void, and floor slab. Used for calculating 
length of wall-to-wall junctions, radiant and temperature 
gradient corrections, and air flow through the external 
envelopes due to the stack effect. 

NB: For a zone with a flat roof, the zone height would be from 
top of floor to top of roof. For a zone with a pitched roof and a 
flat ceiling underneath it, the zone height would be from top of 
floor to underside of soffit. For a zone with a sloping roof (i.e., 
an exposed pitched roof with no flat ceiling underneath it), the 
zone height would be from top of floor to soffit height. If there 
is a suspended floor, the zone height would be measured 
from the floor surface (rather than the slab underneath it). 

Zone Area Floor area of zone calculated using the internal horizontal 
dimensions between the internal surfaces of the external 
zone walls and half-way through the thickness of the internal 
zone walls (see Figure 4). Used to multiply area-related 
parameters in databases. Area basis needs to be consistent 
with that for operational ratings. 

NB: If the zone has any virtual boundaries, the area of the 
zone is that delimited by the ‘line’ created by that virtual 
boundary. 

(Building) Total Floor Area Sum of zone areas. Used to check that all zones have been 
entered. 

Envelope Area Area of vertical envelopes (walls) =  h * w, where: 

h=floor to floor height (floor to soffit on top floor), i.e., 
including floor void, ceiling void, and floor slab  

w=horizontal dimension of wall. Limits for that horizontal 
dimension are defined by type of adjacent walls. If the 
adjacent wall is external or a perimeter wall, the limit will be 
the internal side of the adjacent wall. If the adjacent wall is 
internal, the limit will be half-way through its thickness.  

NB: Areas of floor, ceilings, and flat roofs are calculated in 
the same manner as the zone area. Area for an exposed 
pitched roof (i.e., without an internal horizontal ceiling) will be 
the inner surface area of the roof.  

Used to calculate fabric heat loss, so this is the area to which 
the U-value is applied. 

Window Area Area of the structural opening in the wall/roof, i.e., it includes 
the glass and the frame. 

Deadleg Length Length of the draw-off pipe to the outlet in the space (only 
used for zones where the water is drawn off). Used to 
determine the additional volume of water to be heated 
because the cold water in the deadleg has to be drawn off 
before hot water is obtained. Assumes that HWS circulation 
maintains hot water up to the boundary of the zone, or that 
the pipe runs from circulation or storage vessel within the 
zone. 

Flat Roof Roof with a pitch of 10 degrees or less. 

Further 
guidance 
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Pitched Roof Roof with a pitch greater than 10 degrees and less than or 
equal to 70 degrees. If the pitch is greater than 70 degrees, 
the envelope should be considered a wall. 

Display Window As defined in the Building Regulations. 

Personnel Door As defined in the Building Regulations. 

High Usage Entrance Door As defined in the Building Regulations. 

Vehicle Access Door As defined in the Building Regulations. 

Glazed door When doors have more than 50% glazing, then the light/solar 
gain characteristics must be included in the calculation. This 
is achieved by defining these doors as windows. (Otherwise, 
they are defined as opaque doors.) 

Table 4: Measurement and other conventions 

 

 
Figure 4: Internal horizontal dimension of a zone 

 

3.5. Number of corners (thermal bridge parameter) 

To calculate heat transfer (losses/gains) due to thermal bridges, iSBEM requires the number of 
corners, in contact with the exterior, associated with each zone. NB: This section is provided for 
information only as inputting the number of corners is no longer required by the user. It is now 
calculated by SBEM. 

 

Number of corners = number of convex corners - number of concave corners 

 

Where a concave corner is adjacent to two Zones, it is halved – see Figure 5 below for an 
example. 

 

Internal horizontal dimension 

t/2 

Zone B 
t 

Zone A 
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Figure 5: Number of corners 

 

Example (Figure 5): 

Number of corners for Zone A = 2 (convex corners) - 2 x ½ (half concave corners) = 1 corner 

 
NB: Entering the number of corners for the zone in iSBEM is no longer required as SBEM is now 
able to calculate the value for this parameter from the other information input for the zone. 

 

3.6. iSBEM Nomenclature 

3.6.1. Naming zones, envelope elements, windows, and doors 

There is no set nomenclature for the different items in the Geometry form. The only requirement 
is that they are all unique. You may prefer to assign familiar/representative names. However, 
with a large building, a methodical nomenclature makes it easier to identify elements and keep 
track of what has been input.  

Below is a suggested nomenclature. If you use Quick Envelopes or the “Copy Record” function, 
the elements you create will be named in this way. 

 

Element Suggested 
name 

Explanation 

Zone z#/## The z stands for zone, and the first number is the storey number (0 
for ground floor and 1 for first floor etc.). After the slash, the 
number(s) stands for the number of the zone on that floor. These 
can run consecutively throughout the building or start again at 1 for 
each floor. 

Walls z#/##/ot The first two groups of figures are to identify, as described above, 
which zone the wall is part of. Then the o is the orientation 
(n/nw/e/se etc.) and t is the type (i means internal, u means 
underground, and no letter means external). 

Floors z#/##/ft Similar to walls, the first two groups of figures identify the zone. This 
is followed by an f for floor and then the type t (i for internal floor, e 

Concave corners – Both of these 
concave corners are part of Zone A 
and another adjacent zone. Therefore, 
only half of each concave corner is 
associated with Zone A (the other half 
with the adjacent zone). 

Convex corners 

Zone A 
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for over external space, and no letter for ground floor). 

Ceilings/ 
roofs 

z#/##/ct The first two groups of figures identify the zone. This is followed by c 
for ceiling and t is the type (i is for internal ceiling and no letter 
means the ceiling has no occupied space above it, i.e., it is a roof). 

Window z#/##/ot/g The first three groups of figures identify which envelope the window 
is attached to, as described above. The g stands for glazing. 

Door z#/##/ot/d The first three groups of figures identify which envelope the door is 
attached to, as described above. The d stands for door. 

   
And for 
all the 
above 
elements 

(name).# If there is more than one element which would have the same name 
following the above nomenclature, “.1” is added for the second 
element and “.2” is added to the third, etc. For example, if there were 
two north walls in a zone (z0/01), with the same orientation and type, 
then the first wall would be named “z0/01/n” and the second would 
have a “.1” added to the end and therefore be named “z0/01/n.1”. 

Table 5: Suggested iSBEM nomenclature 

 

See Table 6 for examples. 

 
Name Description of element 
z0/01 Zone 01 on the ground floor (0) 
z0/01/n First North facing external wall of zone 0/01 
z0/01/n.1 Second North facing external wall of zone 0/01  
z0/01/n.2 Third North facing external wall of zone 0/01 
z0/01/ni A North facing wall of zone 0/01, which is internal  
z0/01/nu A North facing underground wall of zone 0/01  
z0/01/n/g Glazing in the North external wall of zone 0/01 
z0/01/n/d Door in the North external wall of zone 0/01 
z0/01/f Ground floor of zone 0/01 
z0/01/fi Internal floor of zone 0/01, i.e., there is an interior space below 
z0/01/fe External floor of zone 0/01, i.e., there is an exterior space below 
z0/01/c Roof of zone 0/01, i.e., there is an exterior space above 
z0/01/ci Ceiling of zone 0/01, i.e., there is an interior space above 

Table 6: Examples of building element names 

 

Recommendations if you set up your own nomenclature: 
• Use names which link subordinate parts of the construction (e.g., windows) to the 

element of which they are part. 
• Incorporate reminders about major distinctions like whether the wall is internal or 

external, or unusual features like suspended floors over an exterior space. 
• Choose characters which avoid using shift keys, e.g., avoid capital letters. 

Other points on naming: 
• If you use the Quick Envelopes (see Section 7.5.8) to create the walls, roofs, floors, 

ceilings, and windows, the names are created automatically for you. If you follow the 
suggested nomenclature for the zones, the names for the walls/floors/windows, etc., will 
be exactly as described above. If you choose another way of naming your zones, the 
above endings will be added to your zone’s name. For example, if you named your first 
zone, “room1”, then the first north wall created for that zone would be automatically 
called “room1/n”. 
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• It is not possible to have two elements with the same name. If you try to use the same 
name twice, iSBEM automatically renames the second element for you. For example, if 
you attempt to create a second zone named “z0/01” or a second wall named “z0/01/n”, 
iSBEM will rename them “z0/01.1” and “z0/01/n.1”, respectively. 

• If you use the “Copy Record” function, a name is generated automatically for you. For 
example, if you copy zone “z0/01”, the new zone will be automatically named “z0/01.1”. 
However, any building objects (i.e., envelopes, windows, doors) assigned to the zone, 
which are also copied as a result, retain the same names as those which they are copied 
from. It is recommended that you appropriately rename any copied elements. 

 

3.6.2. Naming constructions and building services systems 

As there are generally far fewer constructions and building services systems in a building, such a 
methodical nomenclature system, as that recommended for the geometrical definition of the 
building, is not generally required. However, names which clearly identify the type and/or use of 
the construction or building services system are recommended. 
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4. iSBEM BASICS – GETTING STARTED 

This chapter will show you how to install and open iSBEM, start a new project or open an 
existing project, and, finally, close the application correctly.  

NB: To open and edit files created with previous versions of iSBEM (iSBEM_v3.2.b or 
earlier), you will first need to convert each file in order to make it compatible with this 
version of iSBEM. See APPENDIX B: iSBEM file conversion for instructions on how to do 
this. 

The tutorial begins in this chapter. It uses a simple, two storey, rectangular building to 
demonstrate the different aspects of the application. Details of this building can be found in 
Appendix A (these details will only be needed for tasks set out in Chapters 7 and 8). 

 

4.1. System Requirements 

The current version of iSBEM (iSBEM_v3.5.b.mdb) runs on Microsoft Access 2002 onwards. A 
run-time version of Access 2002, which would be sufficient, can be requested on CD from the 
BER office via email at info@ber.seai.ie or phone at 1890 734 237 (local number in RoI). 
Alternatively, you can download the runtime version of Access 2007 for free from Microsoft's 
website at http://www.microsoft.com/downloads/details.aspx?familyid=d9ae78d9-9dc6-4b38-
9fa6-2c745a175aed&displaylang=en.  

We recommend at least 512 MB RAM on your computer to run the application. To view all of the 
output documents produced by iSBEM, you will also need Microsoft Internet Explorer, Microsoft 
Excel, and Adobe Acrobat Reader installed on your machine. 

NB: If you have been using MS Access 2000 to run iSBEM, please note that it cannot cope with 
the changes introduced from iSBEM_v3.2.b onwards. 

NB: There is now (from iSBEM_v3.2.b onwards) a version of iSBEM specifically for Office 2007 
users. Please ensure that you download and install the iSBEM version suitable for your version 
of MS Access.  

The approved version of iSBEM has been developed to work on a Windows platform only 
(Windows 2000, Windows XP, Windows Vista, and Windows 7). Unfortunately iSBEM is not 
compatible with Mac or Linux. SBEM itself will run on most platforms as it is standard C++ and 
can be compiled in Mac or Linux, but the iSBEM interface is a Microsoft Access application 
which will not run on Linux or Mac operating systems. 

NB: Ensure that you have full read and write access permissions on the NCM folder, where 
iSBEM is installed by default on your computer. If you are unable to do this, you need to contact 
the IT department of your company and ask them to adjust your settings to give you full read and 
write access rights on the NCM folder on your computer. 

NB: For assessors accredited by an Accreditation Scheme Provider that generates the final BER 
certificate and the Advisory Report for lodgement in a central system for the Accreditation 
Scheme, please note that in order to generate the XML file required by your Accreditation 
Scheme Provider, your computer must be connected to the internet (see Section 7.3.2: General 
Information tab). If there is no internet connection, then the XML file will not be generated. 
Please also note that the output files produced on your computer will always contain the 
watermark. 

 

Further 
guidance 

mailto:info@ber.seai.ie
http://www.microsoft.com/downloads/details.aspx?familyid=d9ae78d9-9dc6-4b38
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4.2. Installing iSBEM on your computer 

The current version is: iSBEM_v3.5.b. The tool can be accessed via the following web address: 
http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM_Software/Do
wnload_SBEM_Software.html.   

NB: FILES CREATED WITH PREVIOUS VERSIONS OF iSBEM ARE NOT AUTOMATICALLY 
COMPATIBLE WITH THIS VERSION AND WOULD REQUIRE CONVERSION BEFORE THEY 
CAN BE OPENED AND EDITED USING THE NEW VERSION (see APPENDIX B: iSBEM file 
conversion). 
How to install iSBEM: 

1. Go to the ‘Download’ page and complete the form. 

2. Click on the hyperlink to download the tool. 
3. Save the iSBEM_v3.5.b.exe file to a folder of your choice on your hard drive (do not try to 

open the file at this point), such as the Desktop. 

4. Once the download is complete, double-click on the iSBEM_v3.5.b.exe icon, and then click 
on “Unzip’ to initiate the self-extracting process. This will automatically install the application 
in a new folder on your hard drive (default folder: C:\NCM). You may change the 
installation path if you wish. 

5. Once the file has been unzipped to your hard drive, the message "49 file(s) unzipped 
successfully" will appear (this number may change with future versions of the tool). Click on 
‘OK’, and then close the WinZip Self-Extractor window (click on ‘Close’ or on the cross in 
the top right hand corner of the window). 
iSBEM is now installed on your computer. 

6. To locate iSBEM on your computer, open Windows Explorer, and navigate through the 
following (assuming the default installation path was not changed): 

My Computer 
C:\ (drive) 

NCM\ 

iSBEM_v3.5.b 

iSBEM_v3.5.b.mdb (the tool itself) along with all of its associated databases and files are 
located within this folder (iSBEM_v3.5.b). NB: For users of Office 2007, the Microsoft Access file 
called iSBEM_v3.5.b.accdb. 

 
NB: If you changed the installation path (step 4), the tool will be located in:  

your selected path\iSBEM_v3.5.b. 
 

TIP: You may wish to create a shortcut to the “iSBEM_v3.5.b folder” on your Desktop or 
elsewhere in your system so that you can access it more easily. To create a shortcut, right click 
on the iSBEM_v3.5.b folder, select “Create Shortcut”, and then drag and drop the newly created 
folder to the location of your choice, e.g., your Desktop. 

 

4.3. Opening iSBEM 

After installing iSBEM and double-clicking on the “iSBEM_v3.5.b” folder, you will be presented 
with the window in Figure 6. In order to start the application, you will need to double-click on the 

http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM_Software/Do
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Microsoft Access file called iSBEM_v3.5.b.mdb. NB: For users of Office 2007, the Microsoft 
Access file called iSBEM_v3.5.bccdb. 

 

 
Figure 6: Location of the iSBEM Microsoft Access file and Projects folder 

 

The first time that the application is opened, a dialogue box will appear containing iSBEM’s 
licensing terms and conditions (Figure 8). You will need to accept the terms and conditions 
before you can proceed. If you tick the “Don’t show this message again” box, this window will not 
appear again on starting the application.  

 

Double-click to 
start iSBEM 

Projects sub-folder 
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Figure 7: Name of the iSBEM Microsoft Access file for Office 2007 users 

 

Double-click to 
start iSBEM 
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Figure 8: Terms and Conditions dialogue box 

 

4.4. Creating new and opening existing projects 

When the terms and conditions have been accepted, a new window will appear which gives 
three “iSBEM Start-up Options” (Figure 9): 

 

 
Figure 9: iSBEM Start-up dialogue box 

 

NB: FILES CREATED WITH PREVIOUS VERSIONS OF iSBEM ARE NOT AUTOMATICALLY 
COMPATIBLE WITH THIS VERSION AND WOULD REQUIRE CONVERSION BEFORE THEY 
CAN BE OPENED AND EDITED USING THE NEW VERSION (see APPENDIX B: iSBEM file 
conversion). 

 
1. Open Recent Projects – This option has a drop-down menu which contains the 5 most 

recently-opened projects.  
2. Select an Existing Project – Selecting this option and clicking on “OK” opens the “Open 

File” dialogue box, allowing you to browse through your network/computer to locate a project. 
It is set to automatically open in the “Projects” sub-folder within the iSBEM_v3.5.b folder.  

3. Create a New Project – If this option is chosen, the “Save New Project” dialogue box 
appears, and you need to do the following: 

 (v3.5.b) 
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a. Click on the “Create new folder” button on the top right hand side of the “Save New 
Project” dialogue box, enter the project’s name as the name for the folder, and then 
click on “Open”. 

b. Click into the “File Name” field and enter the project name again and click on “Save”. 
(This folder and project file will be saved to the iSBEM “Projects” folder by default – 
see Figure 6). 

c. A form then opens which allows you to enter some basic information about the 
project - see Figure 10. This includes: 
• Purpose of the analysis which will be carried out on the building, e.g., Republic of 

Ireland: Building Energy Rating. 
 
NB: If ‘Republic of Ireland: Building Regulations Part L’ is selected as the “Purpose of 
Analysis”, then the Building Regulation Check tab becomes visible in the Ratings form to 
enable running SBEM for compliance checking with Building Regulations. If ‘Republic of 
Ireland: Building Energy Rating’ is selected as the “Purpose of Analysis”, then the Asset 
Rating tab becomes visible instead in the Ratings form to enable running SBEM for the 
generation of Building Energy Rating Certificates. 

• Weather location (pick the closest to your site from the available locations) – 
there is currently only 1 weather location available for the Republic of Ireland, 
i.e., Dublin.  

• Stage of analysis – whether ‘Final Building Energy Rating’ or ‘Provisional 
Building Energy Rating’. This parameter is enabled only if ‘Republic of Ireland: 
Building Energy Rating’ is selected as the “Purpose of Analysis”. 

NB: Final BER certificates are generated in colour while provisional ones are generated in 
greyscale. 

• Name of the project. 
• Building type - The choice of building type here sets the default building type for 

the activity areas that you will define later. You will, however, be able to change 
the building type for each of the activity areas when you come to define them. At 
this point, you should choose the building type that most closely defines the 
majority of the building. 

 
You will be able to edit this information at a later stage in the General form (Section 7.3: General 
form).  
 
NB: Only the communal areas of apartment buildings containing self-contained flats should be 
assessed for compliance using SBEM, for example, circulation areas (using the “Common 
circulation areas” activity under the building type “DWELLING”). The self-contained flats 
themselves should be assessed using the Dwelling Energy Assessment Procedure (DEAP).  
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Figure 10: iSBEM Basic Information form when new project is created 

 

Task 1: Start the application, accept the terms and conditions, select “Open an Existing Project” 
and click on ‘OK’. You will now be within the “Projects” sub-folder within the “iSBEM_v3.5.b” 
folder. When you installed iSBEM, you also automatically installed 2 files for the Example 
building: the ‘Example building - Complete Ireland’ and the ‘Example building - Tutorial Ireland’ 
files. Double-click on the ‘Example building - Complete Ireland’ File. You should now be within 
the interface which opens in the General form. 

 

4.5. Closing iSBEM 

There are two ways to close iSBEM (circled in Figure 11): 

1. Go to the General form and click on “Exit iSBEM”. 

2. Go to the General form and click on the cross in the corner of the iSBEM screen (the 
smaller window inside the main Microsoft Access window).* 

*It is not advisable to exit by clicking the cross in the corner of the main Microsoft Access 
screen.  
 

What to do if you close the application incorrectly, or if there is a power cut 

If you click on the cross in the corner of the main Microsoft Access screen, your work will not be 
saved to your project file, but stored within a temporary file until the next time you open the 
interface. When you do open the interface next, you will be presented with the “iSBEM Project 
Recovery” dialogue box. It asks you whether you want to continue working with the last project 
which was not closed properly. Click on “Yes”, and then, when you are in the General form, click 
on “Save”. If you click “No” here, all your changes will be lost. If there is a power cut, your work 
will be saved into the temporary file as described above, and you should follow the same 
instructions for recovering your data. 
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Figure 11: General form showing the correct ways of closing iSBEM 

 

After clicking on either of the 2 options (circled in Figure 11), the iSBEM “END” dialogue box 
(Figure 12) will open to ask you whether you want to save your changes to the project. The 
project will be saved to the location determined when you clicked on “Create a New Project” as 
the project was first entered (the default location was the “Projects” sub-folder within the 
“iSBEM_v3.5.b” folder). 

 

 
Figure 12: The iSBEM END dialogue box 

 

When you have chosen to save or exit without saving, the iSBEM “END” (Figure 13) dialogue 
box will open. To exit, click on the button in the centre of the dialogue box. 
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Figure 13: iSBEM END dialogue box 

 

FINAL TASK: You only need to do this task when you have finished your session. 

Go to the General form and click on “Exit iSBEM”. When you are asked whether you would like 
to save your project, click on “OK”. 

 

4.6. Getting assistance with using iSBEM 

The following sources are available if you need assistance on the use of iSBEM and have been 
unable to locate the information you need in this Guide: 

• You can click “F1” while in any field within the iSBEM interface to get Help information on 
any specific input item (see Section 6.2: iSBEM Help).  

• The helpline can be contacted as follows: 

o For all registered assessors and trainers, via phone 1890 252 738 or email 
registered@ber.seai.ie. 

o For all other queries, via phone 1890 734 237 or email info@ber.seai.ie. 

The above phone numbers are treated as local numbers if you call from within the Republic 
of Ireland. 

• You can also refer to the FAQs on SEAI’s website at 
http://www.seai.ie/Your_Building/BER/BER_FAQ_Search/.    

 

 

 

 

 

 

 

 

 

 

mailto:registered@ber.seai.ie
mailto:info@ber.seai.ie
http://www.seai.ie/Your_Building/BER/BER_FAQ_Search/
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5. TOUR OF iSBEM 

The interface consists of a number of screens into which the data on a building needs to be 
entered. This chapter gives an overview of these screens. 

5.1. Introduction to the main forms in iSBEM 

If you have completed Task 1, you should now be within the interface in the General form. 

 

The iSBEM opening screen (Figure 14) gives access to seven main forms: 
• General 
• Project Database 
• Geometry 
• Building Services 
• Ratings 
• Building Navigation 
• About iSBEM 

 

Within each of these forms, there are various tabs and sub-tabs as shown in Figure 14.  

 

 
 

 
Figure 14: The seven forms in iSBEM 

 

Tab 

Form 

Sub-
tab 

Name and location of 
currently open nct file 

Version of iSBEM 
currently running  

Name of form 
currently open  

Name of project 
currently open  
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As can be seen in Figure 14, the top blue bar of the window displays the version number of 
iSBEM, the name of the form currently open, and the name of the project. This bar is always 
visible in all the form, tabs, and sub-tabs of the interface.  
 

Below is a summary of the data which needs to be entered into each form: 

 

General: The General form is where projects can be saved and opened. General information 
relating to the project can also be recorded here, such as the name and address of the project 
and details about the building’s owner and certifier/energy assessor. This information may have 
already been entered when the project was first created (see Section 4.4: Creating new and 
opening existing projects, under ‘Create a new project’), but they can be edited here.  

Project Database: The Project Database form is where the glazing and construction details of 
your building fabric are entered. 

Geometry: The Geometry form is where the shape, size, and orientation of the “zones” are 
entered. Each zone requires a description of the walls, floor, roof/ceiling, doors, and windows 
which comprise its envelopes.  

Building Services: The Building Services form is where all the building’s systems are 
described, including: HVAC, HWS, PVS, SES, Wind, and CHP systems. Further information on 
the lighting and ventilation characteristics specific for each zone is also input through this form. 

Ratings: The Ratings form is used to carry out the energy performance calculation and 
compliance checking, access the results, and obtain the Building Regulations compliance 
document as well as the Building Energy Rating Certificate. The only data entry in this form is 
related to modifying the energy efficiency recommendations for the Advisory report that 
accompanies the BER certificate. 

Building Navigation: The Building Navigation form provides a hierarchical summary of all the 
building objects that have been defined, assigned and unassigned, along with key details on 
some of the objects. There is no data entry in this form.  

About iSBEM: The About iSBEM form displays the licensing conditions for the software. There 
is no data entry in this form.  

 

5.2. Hierarchy of forms, tabs, and sub-tabs in iSBEM 

Detailed information on each of the forms, tabs, sub-tabs, and sub-forms within them is provided 
in the sections indicated below: 

 
Form Tab Sub-tab            Sub-form Section 
General 
 File Options 
  File Operations  
  System Configuration 
  Local Area Network (LAN) Settings 
 General Information 
  Project Details 
  Building Details 
  Certifier/Energy Assessor 

Certifier/Energy Assessor details 
Insurance details 

  Owner Details 

7.3 

Project Database 
 Constructions for Walls 

7.4 
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  General  
  Assigned 
 Constructions for Roofs 
  General  
  Assigned 
 Constructions for Floors 
  General  
  Assigned 
 Constructions for Doors 
  General  
  Assigned 
 Glazing 
  General  
  Assigned 
Geometry 
 Project 
  General and geometry 
  Thermal bridges 
 Zones 
  General 
  Envelope Summary 
  Quick Envelopes 
 Envelopes 
  General 
  Windows Summary 
 Doors 
  General 
 Windows and rooflights 
  General 

7.5 

Building Services 
 Global & Defaults 
  HVAC System Defaults (if the “Purpose of the  analysis”        
selection in the General form > General Information tab > Project details sub-tab 
is BER generation) 
  Project Building Services 
 HVAC Systems 
  General 
  Heating 
  Cooling 
  Systems Adjustments 
  Metering Provision 
  System Controls 
  Zone Summary 
 HWS 
  General 
  Assigned 
 SES 
  General 
 PVS 
  General 
 Wind Generators 
  General 
 CHP Generator 
  General 
 Zones 
  HVAC, HWS, and Lighting Systems 
                         Ventilation  
                          Exhaust 
  Lighting (General) 
  Lighting (Controls) 

7.6 
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  Display Lighting 
Ratings 
 Building Regulations Check 
  Building Rating 
OR (if the “Purpose of the  analysis” selection in the General form > General 
Information tab > Project details sub-tab is to generate the BER) 
 Asset Rating 
  Building Rating 
  Recommendations 
  EPC Audit 

Construction 
Geometry 
HVAC & HWS 
Lighting 

  Calculation Logs 
SBEM.log 
BERgen.log 
BRIRL.log 

  Calculation Errors 
SBEM.err 
BERgen.err 
BRIRL.err 

8.1 

Building Navigation 
 Selections 
 Object Properties 

7.7 

About iSBEM 
  

7.8 

Table 7: Structure of the forms, tabs, and sub-tabs in iSBEM 

 

Task 2: In the ‘Example building - Complete Ireland’ file, click on each of the 6 forms and each 
of their tabs and sub-tabs to familiarise yourself with how to get from one location in iSBEM to 
another. (At present, there is a small, but unavoidable, time delay when switching between 
forms.) 
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6. BASIC iSBEM FUNCTIONALITY AND THE HELP MENU 

6.1. Basic interface functionality and buttons 

Within the Project Database, Geometry, and Building Services forms, you are required to enter 
information about various aspects of the building. The Project Database form requires you to 
enter the information about the properties of each of the construction and glazing types. The 
Geometry and Building Services forms require you to enter details about the zones, their 
envelope elements, windows, and doors and all of the building services systems found in the 
building (all these items are shown in Figure 2: Structure of SBEM objects). 

All of these items are ‘records’ within the interface, and there is a General sub-tab, like the one 
shown below (Figure 15), for each, where you can view, add, delete, and edit them. 

Within iSBEM, there is an alternative way of entering some types of records, in particular, the 
envelope elements and windows. These can be entered using the Quick Envelope sub-tab. The 
functionality of this and any other screens in iSBEM will be explained in the relevant sub-section 
of Chapter 7. 

The majority of the buttons and functionality of iSBEM can, however, be demonstrated by the 
General sub-tab (Figure 15). 
 
 

 
 
 

 

 

 

Figure 15: A General sub-tab: basic commands and buttons 

9- Record navigation buttons 
10-Additional Functionality-the ESCAPE key: 
Pressing the escape key to navigate away from 

an uncompleted form. 

Tab 
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1. Data entry fields 
The data entry fields in iSBEM require the user to either enter text/numbers or select an option 
from a drop-down list. Some of the fields are green. These fields are mandatory and must be 
filled in before proceeding to the next record or navigating away from that screen. 

 

2. Record selector button  

Clicking on the record selector drop-down button produces a drop-down list of all of the records 
in that sub-tab. For example, in the Project Database form > Constructions for Walls tab, clicking 
on the record selector drop-down button displays all of the constructions for walls that have 
already been defined in that project. 
To the right of the name of the record, there is further information about the parent building 
objects for that record. For example, in the Zones tab, clicking the record selector button 
displays all of the zones in the building along with the HVAC system with which each zone is 
associated. 

Extra features: 
“Copy single object” function (this function will be available in future versions of the tool): The 
first entry in the drop-down list begins with “Choose action or X from the list” where X can be a 
construction, zone, wall, HVAC system, etc. The only action currently planned to become 
available is to “Copy a single object”. This will allow (when it becomes functional in future 
versions) the user to copy only the selected object with none of its associated/child objects (To 
copy the object and all of the associated objects, you will need to use the “Advanced Copy” 
button, which is discussed below). 

 

3. Add new record button  

If you hover over this button with the mouse cursor, the text “Click here to insert a new X” will 
appear, where X could be a construction object, zone, HVAC system, etc. You can also click on 
the “Add new record” button  at the bottom of the screen. You will then be prompted to enter 
a name for the record. Once you have done this, press on the Tab or Enter button on your 
keyword. You will then be able to start entering the rest of the information necessary for that 
record.  

NB: The name should be entered in the “Name” field. Do not try to add a name in the “Record 
selector” field. 

 

4. Delete record button  
If you hover over this button with the mouse cursor, the text “Click here to delete current X” will 
appear. To delete a record, select the record you want to delete from the drop-down “Record 
selector” menu, and click on the “Delete” record button. Not only will the record be deleted but 
any associated sub-objects as well. For example, if you delete an envelope element, any 
associated windows and doors will also be deleted (If a Microsoft Access message box appears 
showing “Reserved error” or “No current record”, click on “OK” to proceed). A dialogue box will 
then appear to confirm that you intend to delete the record. Any deletion cannot be undone. It is 
very important that you determine which associated sub-objects are going to be deleted at the 
same time. If you are sure you want to delete the record and all its associated records, click on 
“Yes”. 

 

5. Advanced copy button  

The “Advanced Copy” button is available in the Geometry and Building Services forms. By 
clicking on this button, the selected building object, along with all of its associated sub-objects, 



51                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

are copied. The new record is given an automatic name. For example, if you copied envelope X, 
a new envelope would be created and named “X.1”. At the same time, all of its associated 
objects would also be copied. For example, if an envelope element were copied, any associated 
windows and doors would also be copied. The copied windows and doors, however, keep the 
same name as those they were copied from. For a zone, this would mean all of its associated 
envelope elements, windows, and doors would be copied, and if any HVAC systems were 
copied, so would every associated zone, along with all of its envelope elements, windows, and 
doors. 

If you need to only copy the selected record and not any of its sub-objects, use the copy single 
object function found in the record selector menu (this function will be available in future versions 
of the tool). 

 

6. Reports button  

Clicking on the “Reports” button produces two reports: the Data Summary report and the 
Unassigned Objects report. These reports are for double-checking the data entered. For more 
details on these two reports, see Section 7.9: Double-checking the data. 

 

7. Help button  

The “Help” button can be found in the top right hand corner of every sub-tab of iSBEM. Clicking 
on this button opens the Help menu (see Section 6.2: iSBEM Help, for further information). 

 

8. Multiplier field 
If there is more than one identical zone, for example, this field allows the user to only define it 
once and then enter the number of these identical zones that exist in the building. Remember 
that this would also “multiply” all of its associated envelope elements, windows, doors, and 
additional thermal bridges during the calculation. 

 

9. Record navigation buttons  

These buttons allow you to scroll through the records in that sub-tab. 

 

10. The Escape key – navigating away from incomplete records 

Once a new record has been created, iSBEM will not allow you to navigate away from that 
screen until you have completed all the mandatory fields (all the green fields). SBEM does not 
have default values for these fields, and they are needed for SBEM to can carry out its 
calculations. You will also not be able to delete the record until it has been completed. 

If you need to navigate away from the screen before it is completed, press the Escape key on 
your keyboard. 

 

11. The Global buttons  or tick boxes 

Global buttons and tick boxes allow you to use previously defined ‘global’ values for a variety of 
parameters. For example, in Figure 15 , the global ‘air permeability at 50pa’ button is pressed in. 
This means that the current record (in this case, zone z0/01east) takes the previously defined 
‘global’ air permeability value (this global value is defined in the Geometry form > Project tab > 
General and Geometry sub-tab – see Table 8: Global parameters). 
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When the Global button or tick box is not pressed in or ticked, you are able to enter a value 
specifically for that record. This is shown in Figure 15 where the floor-to-floor height ‘global’ 
button is not pressed in, and a value of 3 has been introduced for that zone. 

Table 8: Global parameters - shows the global parameters available in iSBEM, where they are 
defined, and where they are later used. 

 

Parameter Global value defined: Location of Global button or 
tick box 

Air permeability 

 

Geometry form > Project tab > 
General and Geometry sub-tab 

Geometry form > Zones tab > 
General sub-tab 

Zone height 

 

Geometry form > Project tab > 
General and Geometry sub-tab 

Geometry form > Zones tab > 
General sub-tab 

Thermal bridges 

 

Geometry form > Project tab > 
Thermal bridges sub-tab 

Geometry form > Zones tab > 
General sub-tab 

Condition of adjoining space 
for envelope elements 

 

Project Database form >  
Construction for Walls tab > 
General sub-tab 

Project Database form >  
Construction for Floors tab > 
General sub-tab 

Project Database form > 
Construction for Roofs tab > 
General sub-tab 

Geometry form > Envelope 
tab > General sub-tab  

Geometry form > Zones tab > 
Quick Envelopes sub-tab 

Table 8: Global parameters 

 

6.2. iSBEM Help 

iSBEM Help can be accessed in two ways: 

1. By pressing the “Help” button which appears on every sub-tab in the interface as described 
in Section 6.1. This opens the “Help Topics” window from which you can navigate to the item 
of interest (see Figure 16).  

2. By clicking into the field of interest and pressing the F1 key on your keyboard. This opens 
the specific Help entry relating to that particular field in the “Help Entries” window (see Figure 
17). From there, you can click either “Contents”, “Index”, or “Find” to open the “Help Topics” 
dialogue box. 

 

There are Help entries on each of the fields in the interface, and there is a selection of “How to” 
entries, such as, how to close iSBEM, how to name the building objects, or how to go about 
describing a roof. Most of this information can also be found in this User Guide.  

 
Help Topics window (Figure 16) 
All of the Help topics are listed in the “Help Topics” window. It contains three screens from which 
you can navigate to your chosen topic: the “Contents” screen, the “Index” screen, and the “Find” 
screen. 
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• The “Contents” screen lists all the entries under the iSBEM form, tab, or sub-tab to which 
they relate or under the “How to..” menu. 

• The “Index” screen lists all the entries in alphabetical order. 
• The “Find” screen contains a search engine which brings back all the Help entries which 

contain in their contents, a given word or phrase. 

 
 
 
 
 
 
 

 
Figure 16: Help Topics window 

 

Help Entries window (Figure 17) 
Double-clicking on the item of interest in the “Help Topics” window, or clicking on F1 on your 
keyboard, while the cursor is in the relevant field in the interface, opens the “Help Entries” 
window on the page of interest and closes the “Help Topics” window. Within the “Help Entries” 
window, it is possible to scroll through the “Help Entries” using the scrolling buttons. Clicking on 
either the “Contents”, “Index”, or “Find” buttons opens the “Help Topics” window. 

 

 

 

 

Find facility – allows the user 
to search for a given word or 
phrase in their content or the 
Help entries. 

Entries listed 
in 
alphabetical 
order 

Entries listed under the 
form/tab to which they 
relate or under the “How 
to…” menu. 
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Figure 17: Help Entries window 

Click on Contents, Index, 
or Find to open the Help 
Topics window. 

Scroll through Help entries in 
the order they appear in the 
Contents. 
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7. ENTERING A BUILDING INTO iSBEM 

This chapter takes you through each of the iSBEM data entry forms consecutively (the General, 
Project Database, Geometry, and Building Services forms), giving guidance on what information 
is required at each stage. 

For this section of the tutorial, you will be using the ‘Example building - Tutorial Ireland’ file. 
Some of the information for the Example building has already been entered into this file, but in 
each step, there will be a few fields that need to be filled in. 

 

The Example building 
The Example building is a two storey rectangular building. A coffee shop and a supermarket are 
located on the ground floor while the first floor is office space. The original drawings for each 
floor, as well as the characteristics of the building fabric are shown in APPENDIX A:. A 3D-view 
of the Example building is shown in Figure 18. 

 

 
Figure 18: 3D view of the Example building 

 

Before continuing with the tutorial, it is recommended that you have a brief read through 
APPENDIX A: to familiarise yourself with the building and, in particular, how the building 
has been zoned. 
 

Task 3: Close the completed version of the example (‘Example building - Complete Ireland’ 
File), that you have been using to take a tour of the interface in Task 2, and open the tutorial 
version of the example, ‘Example building - Tutorial Ireland’ file.  

To do this, go to the File Options tab in the General form and click “Open an existing project”. 
You will then be asked if you want to save the complete version. Click on “Exit without saving”. 
You will then be presented with the start-up options dialogue box. Click on “Select an existing 
project to open”, and then select ‘Example building - Tutorial Ireland’ File. 

 

7.1. Order of data entry 

Some items need to be defined before others in iSBEM. For example, the building fabric needs 
to be defined before the walls, doors, and windows can be fully described. This hierarchy 
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between the different elements defined in iSBEM can be seen in Figure 2: Structure of SBEM 
objects. However, there is a degree of flexibility too. 

Figure 19 shows which elements need to be entered before others and also gives a suggested 
order of data entry. It is this order that is followed in the tutorial.  

 

 
Figure 19: Order of data entry 

(The stages, indicated by the letters in Figure 19 (a – i) correspond to the stages described in Section 2.6: 
Overview of how a building is defined in iSBEM). 

 

7.2. Important note on the default values in iSBEM 

In iSBEM, there are default values included for various parameters. For example, there are 
default seasonal efficiencies for HVAC systems and default constructions for envelope elements 
so that you can select them when defining the envelopes of a zone. These default values are not 
generous, should be checked by the user, and, if appropriate, changed or added to.   

NB: If none of the default values in iSBEM are changed, it is likely that the building will 
not comply with Building Regulations and achieve a poor rating. 

 

Necessary order of data entry 

(i) Calculate rating / 
Assess compliance 

(a) General certification details – such as building’s address and certifier’s name, 
as well as the weather location and the relevant Building Regulations  

(b) Build up database 
of construction and 
glazing types 

(d-f) Define the zone’s envelopes, windows, and doors, 
and any additional thermal bridges associated with these 
elements (Some information can be entered at the same 
time as the zone, but to complete the definition, the 
envelope elements need to be assigned to a zone) 

(g) Enter information on 
building services such as 
HVAC, HWS, and PV 
systems, if available Su
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d 
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(h) Enter zone-specific 
building services such as 
lighting and ventilation 
strategy and which HVAC 
system and HWS it is 
served by 

(c) Create the zones 
and define their basic 
dimensions 

B
uilding Services Form
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etry Form

 
Project 
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Form
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eneral 
Form

 

Where in 
iSBEM? 
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7.3. General form 

The General form contains two tabs: 

• File Options tab 

• General Information tab 

7.3.1. File Options tab  

The File Options tab has five sub-tabs: 
• File Operations sub-tab. 
• System Configuration sub-tab. 
• System Configuration (cont.) sub-tab. 
• Local Area Network (LAN) Settings sub-tab. 
• Helpline Diagnosis sub-tab. 

 

File Operations sub-tab: 
This sub-tab contains the options to “Save current project”, “Save As”, “Open an Existing 
Project”, “Create a New Project”, and “Exit iSBEM” (shown in Figure 20).  

 

 
Figure 20: The File Options tab in the General form  

 
System Configuration sub-tab: 

iSBEM creates different output reports (more details can be found in Chapter 8). Two of these 
reports have the file extension ‘.htm’. In order to open the htm reports (by accessing your web 
browser, Microsoft Internet Explorer), iSBEM needs to know the Program Files folder path on 

Name and location of 
currently open nct file 
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your computer. The default path (C:\Program Files\), shown in Figure 21, should be fine for most 
systems. If, however, you have a different configuration on your computer, and the reports are 
not created, you will need to manually edit the configuration in this tab to reflect the settings on 
your computer.  

iSBEM also needs to know the folder where the projects and the iSBEM output reports will be 
saved. This is specified by the Project Files folder. The default path, shown in Figure 21, should 
be fine for most systems. If however, the reports are not created, you will need to manually edit 
the configuration in this tab. 

There is a tick box which is unticked by default. You need to tick it if you would like SBEM to 
generate the Data Reflection reports (for the actual and notional buildings) in html format (as well 
as csv format) during the calculation, and the relevant access button will appear in the Ratings 
form. If the box remains unticked, then these reports will be generated in csv format only (see 
Section 8.2.3: Data Reflection Report – Actual Building and 8.2.3: Data Reflection Report – 
Actual Building).  

There is also a tick box that should remain ticked if you wish for the contents of the Building 
Navigation form to be refreshed automatically with any changes in the objects properties that 
might have been performed since the form was last accessed. If you do not wish for the Building 
Navigation form to be refreshed automatically, you should untick this box. There is a button in 
the Building Navigation form which you can click in order to initiate the “refresh” function 
manually (see Section 7.7: Building Navigation form). 

 

 
Figure 21: The System Configuration sub-tab 

 
System Configuration (cont.) sub-tab: 

This sub-tab (Figure 22) contains tick boxes which users can modify to reflect their preferences 
while using iSBEM: 

1. Tick box which is unticked by default. You need to tick it if you would like SBEM to generate 
the Data Reflection reports (for the actual and notional buildings) in html format (as well as 
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csv format which is always done) during the calculation, and the relevant access button will 
appear in the Ratings form. If the box remains unticked, then these reports will be generated 
in csv format only (see Section 8.2.3: Data Reflection Report – Actual Building and 8.2.3: 
Data Reflection Report – Actual Building).  

2. Tick box, which is ticked by default and should remain ticked, if you wish for the contents of 
the Building Navigation form to be refreshed automatically with any changes in the objects 
properties that might have been performed since the form was last accessed. If you do not 
wish for the Building Navigation form to be refreshed automatically, you should untick this 
box. There is a button in the Building Navigation form which you can click in order to initiate 
the “refresh” function manually (see Section 7.7: Building Navigation form). 

3. Tick box, which is ticked by default, to automatically clear the contents of the Quick 
Envelopes tab once the envelopes have been created (i.e., the create envelopes button has 
been pressed). You can untick this box if you do not wish for the contents of the tab to be 
cleared (see Section 7.5.8: Quick Envelopes tab: Short cut to creating envelopes and 
windows). 

4. Tick box, which is ticked by default, to allow the definition of the areas of glazing in 
envelopes to be input as areas, in m2, rather than percentages in the Quick Envelopes tab. If 
you wish to define glazing areas using percentages, then you can untick the box (see 
Section 7.5.8: Quick Envelopes tab: Short cut to creating envelopes and windows). 

 

 
Figure 22: The System Configuration (cont.) sub-tab 

 
Local Area Network (LAN) Settings sub-tab: 
In this sub-tab, the following information can be entered (Figure 23): 

Proxy Server 

1. Tick box to indicate whether a proxy server is used (by a Local Area Network) for connecting 
your computer to the Internet. If the box is ticked, i.e., a proxy server is used, then the 
following fields become active: 
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a. Address - the URL address of the proxy server used. 

b. Port - the port of the proxy server used. 

c. Tick box to indicate whether the proxy server requires a password. If the box is 
ticked, then the following field becomes active: 

i. Password – the password for the proxy server. 

NB: All information on the proxy server, if one is used, should be available from your IT 
Department. 

NB: For assessors accredited by an Accreditation Scheme Provider that generates the final BER 
certificate and the Advisory Report for lodgement in a central system for the Accreditation 
Scheme, please note that in order to generate the XML file required by your Accreditation 
Scheme Provider, your computer must be connected to the internet (see Section 7.3.2: General 
Information tab). If there is no internet connection, then the XML file will not be generated. 
Please also note that the output files produced on your computer will always contain the 
watermark.  

2. Tick box to follow a different connection route to be ticked only if requested by the SBEM 
Helpline after you have experienced problems connecting to the EPCgen.Net site. This box 
is unticked by default and should not be ticked unless requested.  

 

 
Figure 23: The Local Area Network (LAN) Settings sub-tab 

 
Helpline Diagnosis sub-tab: 
In this sub-tab (Figure 24), there is a button that initiates the generation of diagnosis data for the 
SBEM Helpline to assist in identifying a problem. This button should not be pressed unless you 
are requested to do so by the SBEM Helpline. 
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Figure 24: Helpline Diagnosis sub-tab 

 

7.3.2. General Information tab 

The General Information tab contains four sub-tabs, as described below, where you can enter as 
much or as little background information about the project. However, there are also essential 
parameters to be selected, such as the weather location for the project and the purpose of the 
analysis. These details can be entered and edited in their respective tabs (see Figure 25). Some 
of this information may have already been entered when the project was first created (see 
Section 4.4, under ‘Create a new project’). 
 

The General Information tab contains four sub-tabs: 
• Project Details sub-tab. 
• Building Details sub-tab. 
• Certifier Details OR Energy Assessor Details. 
• Owner Details sub-tab. 
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Figure 25: The General Information tab in the General form 

 

Project Details sub-tab: 
In this sub-tab, the following information can be entered (Figure 25): 

Building Regulations & EPBD Parameters 

3. Purpose of the analysis – purpose for carrying out a calculation using SBEM, whether it is to 
check compliance with Building Regulations (e.g., Republic of Ireland: Building Regulations 
Part L) or to generate a BER Certificate. 

NB: If ‘Republic of Ireland: Building Regulations Part L’ is selected as the “Purpose of Analysis”, 
then the Building Regulation Check tab becomes visible in the Ratings form to enable running 
SBEM for compliance checking with Building Regulations. If ‘Republic of Ireland: Building Energy 
Rating’ is selected as the “Purpose of Analysis”, then the Asset Rating tab becomes visible 
instead in the Ratings form to enable running SBEM for the generation of Building Energy Rating 
Certificates. 

4. Tick box to indicate whether, in addition to producing a BER, you wish to check compliance 
with Building Regulations and produce a compliance document – This parameter is active 
only if the “Purpose of Analysis” parameter is set to ‘Republic of Ireland: Building Energy 
Rating’. 

5. Weather location (pick the closest to your site from the available locations) – there is 
currently only 1 weather location available for the Republic of Ireland, i.e., Dublin. 

6. Stage of analysis – whether ‘Existing Building - Final’, ‘New Building – Final’, or ‘New 
Building - Provisional’. This parameter is enabled only if ‘Republic of Ireland: Building Energy 
Rating’ is selected as the “Purpose of Analysis”. 

NB: Final BER certificates are generated in colour while provisional ones are generated in 
greyscale. 
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7. Project complexity – complexity of the building for the purposes of energy assessments for 
BER certificates. This parameter is active only if the “Purpose of Analysis” parameter is set 
to ‘Republic of Ireland: Building Energy Rating’. The options available are: 

• ‘Level 3’ – simple, existing buildings that can be modelled using SBEM, e.g., 
small buildings such as converted houses or doctors’ surgeries. 

• ‘Level 4’ – new and existing buildings that can be modelled using SBEM, e.g., 
small purpose built office buildings. 

• ‘Level 5’ – new and existing complex buildings that need to be modelled using 
Dynamic Simulation Models, e.g., large office buildings or factories. 

NB: If in doubt about whether iSBEM would be appropriate for modelling your building, 
please contact your Accreditation Scheme Provider. 

 

 
Figure 26: The Building Details sub-tab of the General Information tab in the General form 

 
Building Details sub-tab: 
In this sub-tab (Figure 26), the following information can be entered: 

Building Details 

1. Building type - The choice of building type here sets the default building type for the activity 
areas that you will define later. You will, however, be able to change the building type for 
each of the activity areas when you come to define them. At this point, you should choose 
the building type that most closely defines the majority of the building. 

2. Name of the project. NB: The text input in this field should not include any double quotes. 

3. MPRN - the Meter Point Reference Number (MPRN) of the building. This parameter is active 
only if the “Purpose of Analysis” parameter is set to ‘Republic of Ireland: Building Energy 
Rating’. This parameter must consist of 12 digits, with the first digit being 0, and should not 
be left blank. 
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4. Building address. NB: The text input in this field should not include any double quotes. 

5. County – select from the list the county for the building address. 

6. Location description - a description of the building location. NB: The text input in this field 
should not include any double quotes. 

7. Year of construction – the year the building was constructed. This parameter is active only if 
the “Purpose of Analysis” parameter is set to ‘Republic of Ireland: Building Energy Rating’ in 
the Project Details sub-tab.  

 
Certifier Details / Energy Assessor Details sub-tab: 
The name of this sub-tab changes depending on the option selected in the parameter “Purpose 
of Analysis” in the Projects Details sub-tab, as follows:  

• Certifier Details sub-tab – if the option selected is ‘Republic of Ireland: Building 
Regulations Part L’. 

• Energy Assessor Details sub-tab – if the option selected is ‘Republic of Ireland: 
Building Energy Rating’. 

This sub-tab (Figure 27) contains three sub-forms: Energy Assessor Details sub-form, Insurance 
Details sub-form, and Keys sub-form.  

 

 
Figure 27: The Energy Assessor Details in the General form 

 

Energy Assessor Details sub-form: in this sub-form, the following information can be entered: 

1. Name – of the certifier or energy assessor. NB: The text input in this field should not include 
any double quotes. 

2. Telephone number – of the certifier or energy assessor. 
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3. Address – of the certifier or energy assessor. NB: The text input in this field should not 
include any double quotes. 

4. County – of the certifier or energy assessor. NB: The text input in this field should not include 
any double quotes. 

5. Accreditation Scheme – the accreditation scheme of the energy assessor. This parameter is 
active only if the “Purpose of Analysis” parameter is set to ‘Republic of Ireland: Building 
Energy Rating’. If the option selected is not ‘Not accredited’, the following fields become 
active: 

a. Assessor number – the registration number of the energy assessor. This 
parameter is active only if the “Purpose of Analysis” parameter is set to ‘Republic 
of Ireland: Building Energy Rating’. This parameter must consist of 6 digits, and it 
should not be left blank. 

b. Qualifications – the qualifications of the energy assessor as they will need to be 
qualified for the type of building being assessed (check with your Accreditation 
Scheme Provider). This parameter is active only if the “Purpose of Analysis” 
parameter is set to ‘Republic of Ireland: Building Energy Rating’. See the “Project 
complexity” parameter in the General Information tab. 

c. Emp/Trading Name – the employer or the trading name of the energy assessor. 
This parameter is active only if the “Purpose of Analysis” parameter is set to 
‘Republic of Ireland: Building Energy Rating’. NB: The text input in this field 
should not include any double quotes. 

d. Emp/Trading Address – the employer or the trading address of the energy 
assessor. This parameter is active only if the “Purpose of Analysis” parameter is 
set to ‘Republic of Ireland: Building Energy Rating’. NB: The text input in this field 
should not include any double quotes. 

e. Assessor Comp. No. – the company number of the energy assessor’s employer. 
This parameter is active only if the “Purpose of Analysis” parameter is set to 
‘Republic of Ireland: Building Energy Rating’. NB: The text input in this field 
should not include any double quotes. 

Import Details – clicking on either of the two buttons available will enable you to import the 
assessor details which you might have entered in a previous version of iSBEM, instead of re-
typing them. After you click on the button, you will have the option to browse the folders on your 
computer and select a previous version of iSBEM, for e.g., iSBEM_v3.5.a.mdb, from which to 
import the previously input details into the version of iSBEM you are working with. 

If you are importing details from a version of iSBEM specifically for MS Office 2003, use the 
“Import details from mdb” button to import your details from an “.mdb” file. If you are importing 
details from a version of iSBEM specifically for MS Office 2007, use the “Import details from 
accdb” button to import your details from an “.accdb” file. 

NB: If you are running the Office 2007 version of iSBEM, you can import assessor details from 
an Office 2003 or an Office 2007 version of iSBEM, i.e., 2 buttons will be visible in the interface 
for “mdb” and “accdb” files. On the other hand, if you are running the Office 2003 version of 
iSBEM, you can import details from a previous Office 2003 version of iSBEM only, i.e., only 1 
button for “mdb” files will be visible in the interface.  

NB: For assessors accredited by an Accreditation Scheme Provider that generates the final BER 
certificate and the Advisory Report for lodgement in a central system for the Accreditation 
Scheme, please note that in order to generate the XML file required by your Accreditation 
Scheme Provider, your computer must be connected to the internet (see Section 7.3.2: General 
Information tab). If there is no internet connection, then the XML file will not be generated (see 
APPENDIX E: Connection to EPCgen.net). Please also note that the output files produced on 
your computer will always contain the watermark. 

NEW 

NEW 

NEW 
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NB: All the information in the Certifier Details / Energy Assessor Details sub-tab will remain 
visible in any new project created unless it is cleared by pressing the “Clear all” button. 

 

 
Figure 28: Insurance Details in the General form 

 

Insurance Details sub-form: This sub-form is available only if the “Purpose of Analysis” 
parameter is set to ‘Republic of Ireland: Building Energy Rating’. This is where the following 
information can be entered: 

1. Insurer Company – Name of the energy assessor’s insurance company. NB: The text input 
in this field should not include any double quotes. 

2. Policy Number – The energy assessor’s insurance policy number. 

3. Effective Date – The energy assessor’s insurance policy effective start date. 

4. Expiry Date – The energy assessor’s insurance policy expiry date. 

5. PI Limit – The energy assessor’s insurance policy cover limit. 
 

Owner Details sub-tab (Previously Occupier Details sub-tab): 

In this sub-tab (Figure 29), the following information can be entered: 

Owner of the Building Details 

1. Name – of the owner of the building. NB: The text input in this field should not include any 
double quotes. 

2. Telephone number – of the owner of the building. 

3. Address – of the owner of the building. NB: The text input in this field should not include any 
double quotes. 

4. County – of the owner of the building. NB: The text input in this field should not include any 
double quotes. 



67                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

 
Figure 29: The Owner Details sub-tab of the General Information tab in the General form 

 

NB: The background information has already been entered for the Example building so there is 
no tutorial task relating to the General form. 
 

7.4. Project Database form 

Each type of construction used in the building fabric is defined within the Project Database form. 
Within this form, there are five main tabs (circled in Figure 30): 

• Constructions for Walls tab  

• Constructions for Roofs tab 

• Constructions for Floors tab 

• Constructions for Doors tab 

• Glazing tab 
In each tab, you need to enter information on each of the different types of construction found in 
the building. For example, in your building, there may be two glazing types. This is where you 
enter the details of these types. Later on, during the building’s geometry definition, each of these 
construction/glazing types can be assigned to particular parts of the building 
envelope/door/window. In other words, you are not defining the walls, doors, or windows of 
your building at this stage; just the characteristics of the materials used in their 
construction. 
Clicking on the ”Check Objects assignment” button produces two reports: the Unassigned 
Objects Report and the Data Summary Report. These reports can be used to check the data 
entered at any stage of inputting a building into the interface. There is a “Reports” button on 
each tab within the interface so it is not necessary to return to this form to access the reports. 
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How to double-check the data you have entered is explained at the end of this chapter (see 
Section 7.9: Double-checking the data). 

Notes:  
• Constructions for intermediate floors/ceilings are dealt with under the Constructions for 

Floors tab.  
• If the space in the roof is unconditioned, the top floor ceiling should be dealt with as a 

"roof".  It should be given the combined thermal performance of the whole 
construction including the ceiling construction, the void, and the roof construction. 

• Only constructions for external doors and windows need to be defined in iSBEM (i.e., 
ignore internal doors and windows). 

 

 
Figure 30: The Constructions and Glazing tabs in the Project Database form 

 

Each of the main tabs in the Project Database form has two sub-tabs: General and Assigned. 
The General tab is where the information is entered to define your construction types - see the 
following section on how this is done. The Assigned tab contains a list of all the envelope 
elements (doors or windows) of the building to which this construction (or glazing) has been 
“assigned”. You cannot edit the list on this screen as it is provided for viewing only (see Figure 
31).  

 

NB: At this stage in the tutorial, most of the Assigned tabs will be blank as you will not have yet 
created the building elements to which these constructions need to be assigned. You will do this 
in Section 7.5: Geometry form. 
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Figure 31: The Assigned sub-tab in the Constructions for Walls tab 

 

7.4.1. Defining construction types 

To insert a new type of construction, you must firstly create a new record by clicking on the 
“Create a new record” button shown in Figure 32. For each new construction, you need to enter 
the following information: 

1. Name - You will be prompted to enter a unique name for your construction (this must be 
done before you can continue with the construction’s definition). 

2. Generally used in walls/floors/roofs which connect zones to (for walls, roofs, and floors 
only) – Here you need to select from the options in the drop-down menu (see Figure 32), 
which include the options of: Exterior, Strongly ventilated space, Unheated adjoining 
space, Conditioned adjoining space, and Underground. This sets the default or ‘global’ 
condition of the adjacent space which will appear when you assign this construction for a 
specific envelope element (see Section 7.5.4: Defining envelope, for details on how this 
global value is used). This parameter is only required for walls, roofs, and floors. 

3. Tick if the construction involves metal cladding (for walls and roofs only) – tick box. 

NB: Constructions involving metal cladding are roof or wall systems where metal forms an 
integral part of the construction, such as metal twin skin systems where the insulation is 
located between the metal skins and where the metal skins are typically 0.4 mm to 1.2 mm 
thick. Metal cladding systems are divided into two broad categories: (a) built-up metal 
cladding systems involving rail and bracket or z-spacer systems with insulation within the 
panels, and (b) composite-panel metal cladding systems with insulation inside the panels. If 
the metal is simply used as an external shield against the weather, such as a rainscreen, this 
is not, for the purposes of SBEM calculations, considered as “metal cladding”.  

4. Description of the construction - SBEM requires a number of parameters to describe the 
thermal characteristics of the construction types. These can be introduced into iSBEM in 
one of three ways: 
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i. Import directly from the library - This is the default option. If it is not already selected, 
you need to click on the “Import one from the library” radio button. Then, in the library 
drop-down menu(s), choose the construction that most closely matches the one you 
are trying to define, from your knowledge of what has been found in the building or is 
specified on drawings or schedules. 

ii. Choose from the library following inference procedures - This option is intended for 
use when certifying existing buildings, when you may not have the drawings or 
schedules which specify the construction types used in the building. The inference 
procedures will help you to select construction types on the basis of non-technical 
information you may have on the building. To use this option, you need to click on 
the “Help with Inference procedures” radio button and then in the inference drop-
down menus, choose the options that most closely describe your construction. For 
example, for a wall, you may be able to choose a construction based on the sector, 
the building regulations year with which you think it would be compliant, and a 
general description. 

iii. Manually introduce the values - Click on the “Introduce my own values” radio button if 
you wish to enter your own values to define the construction.  

For walls, roofs, floors, and doors, there are two parameters which need to be 
entered: the U-value (W/m2K) and the κm value (renamed from Cm value) (kJ/m2K). 
(See below for the description of these parameters). If the user selects a construction 
type from the construction library or through the inference procedures, these values 
are imported automatically from the iSBEM databases.  

For glazing types, the parameters that need to be entered manually are: the U-
value, the solar transmittance (T-Solar), and the light transmittance (L-Solar). (See 
below for the description of these parameters). If the user selects a glazing type from 
the glazing library or through the inference procedures, these values are imported 
automatically from the iSBEM databases.  

NB: Remember that the values chosen may have to be justified to the Building Control officers to 
gain Building Regulations approval. 

NB: Glazed Doors - Doors which are more than 50% glazed should be entered into iSBEM as 
windows, and their light and solar characteristics should be entered into the Project Database 
form > Glazing tab. Doors which are 50% or less glazed can be treated as opaque doors. 
 
U-Value 
The U-value is the thermal transmittance of the construction, given in W/m2K. It can be 
calculated using the “combined method” given in BS EN ISO 6946 for simple constructions. 
Constructions such as cladding and steel frame constructions require more complicated 
calculation procedures, and an appropriate methodology should be followed. For example, the 
“BRE U-value Calculator” would be appropriate for these construction types. (Guidance on the 
calculation of U-values for curtain walls can be found in ‘The Thermal Assessment of Window 
Assemblies, Curtain Walling and Non-traditional Building Envelopes’, Ledbetter, S., et al., Centre 
for Window and Cladding Technology, University of Bath, Bath, March 2006). 
 
NB: In the case of a user-defined U-value for ground floors, the user needs to specify (using a 
tick-box) whether the U-value entered into iSBEM has been obtained following the guidance in 
BR 443:2006 - Conventions for U-value Calculations, i.e., the U-value has been 
modified/corrected to account for the heat loss through floors in contact with the ground. If the U-
value input by the user has already been modified, then SBEM will use the U-value as it is. 
Otherwise, SBEM will make the modification (as a function of the ratio of exposed perimeter to 
floor area and the thermal resistance of the floor construction), which is always the case when 
the floor construction is selected from the Library or using Inference procedures. 
 
NB: The calculation of the U-values of rooflight/window systems must include the effect of the 
bars that form part of the glazing system. 
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NB: The glazing U-value entered should be for glazing in a vertical inclination. This value 
is adjusted in SBEM to produce the correct U-value for the window/rooflight inclination (the 
correction for a horizontal flat roofs is +0.3 to the U-value and for pitched roofs, it is +0.2 to the 
U-value). However, the value checked for compliance with building regulations is the one input 
and not the adjusted U-value used within the calculation.  
 
κm (Kappa m) value 
The κm value (renamed from Cm value) is the effective thermal capacity of an element (wall, 
floor, ceiling, etc), given in kJ/m2K. As it takes some time for heat to flow into or out of the 
building fabric, not all the thermal capacity is useful. The κm value represents that part which 
affects the heating and cooling energy demands. The rules for calculating it can be found in the 
CEN standard: prEN 13790:2006. In brief, for each construction element: Calculate the 
contribution of each layer of construction by calculating: density (kg/m3) x thickness (m) x 
specific heat capacity (kJ/(kgK)). Starting from the layer of the construction closest to the space 
(i.e., from the interior), add these values together until any one of the following conditions is 
satisfied:  

• the sum of the layers thicknesses has reached 0.1 m, 
• you have reached the mid-point of the construction, or 
• you have reached an insulating layer (defined, for SBEM purposes, as having a 

conductivity of 0.08 W/mK or less). 
 
NB: If the construction contains an air cavity whose conductivity is above 0.08 W/mK, the 
contribution of the air cavity needs to be taken into account in the calculation of the κm value 
(although the contribution to the thermal mass of the construction would be very small), i.e., it is 
not considered as an insulating layer. 
 
T Solar 
T Solar is the total solar energy transmittance (g perp) defined as the time-averaged ratio of 
energy passing through the un-shaded element to that incident upon it. T Solar values entered 
by the user should refer to values for normal incidence of solar radiation. NB: External movable 
devices for solar protection are accounted for later when defining the window in the Geometry 
form, through the shading system options. 
  
L Solar 
L Solar (light transmittance) is the amount of visible solar energy that passes through a glazing 
system, expressed as a fraction of the visible solar energy incident on it. This value will be used 
for the daylighting calculations. 
 
NB: Total solar energy transmittance values given by windows manufacturers are usually given 
for solar radiation perpendicular (normal) to the glazing (g perp). However, SBEM uses monthly 
calculations and therefore, a value (g) averaged over all angles of incidence. Accepting some 
simplifications, SBEM calculates this value by multiplying (g perp) by a factor of 0.9. This also 
applies to the light transmittance values. 
 
NB: In the Glazing Database, "Uncoated, clear" refers to ordinary clear glass which has no low-
emissivity coating and no tint, "Reflectance, low-emissivity" refers to glazing in which at least one 
glass pane has a low-emissivity coating (such as "Pilkington K" glass or "Optitherm" glass), and 
"Tinted" refers to glazing where at least one pane is colour-tinted. 
 
NB: For windows or other glazed envelope elements with non-scattering glazing, ISO 9050 and 
EN410 provide a method to obtain the solar energy transmittance for radiation perpendicular to 
the glazing. EN 13363-2 and ISO 15099 provide methods of determination of the total solar 
energy transmittance of glazing equipped with solar protection devices. For more information, 
see also section 11.4 of the CEN Standard prEN wi 14. 
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Figure 32: An external wall being defined in the Constructions for Walls tab 

 

Task 4: Define each of the construction types  
Fabric details for the Example building are listed in APPENDIX A:, Section A.1: Constructions. 
Look through the records in each of the sub-tabs using the record selector, and you will see that 
five out of the seven constructions have been defined for you. You need to define the roof and 
the internal wall constructions. This will involve clicking on the appropriate sub-tab, adding a new 
record, clicking on the appropriate radio button, and choosing the appropriate options from the 
drop-down menus. 

As you will see, the glazing, door, and external wall parameters have been entered manually, the 
ground floor has been entered using the inference procedures, and the internal floor has been 
selected from the library. The roof and internal walls can both be selected from the library. 
Simple names such as “Ground floor for Example building” have been used.  

 
Viewing and deleting construction types 
To view the construction types that you have in your Project Database form, you need to click on 
the record selectoriii in each of the four tabs. A drop-down list will then appear showing all of the 
constructions that have been defined in that project so far. To delete a construction or glazing 
type, you need to select it using the record selector, and then click on the “Delete record” button. 

 

7.5. Geometry form 

Depending on what information you have first, you can start by entering information into either 
the Geometry form or the Building Services form. 

                                                
iii For further descriptions of the various commands in iSBEM, see Chapter 6: BASIC iSBEM 
FUNCTIONALITY AND THE HELP MENU.  

Click here to insert a new 
wall type 

Click here to delete the 
construction type in view. 
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To define the geometry of your own building, you will need to have followed the instructions on 
“zoning” given in Chapter 3. (The Example building has been “zoned” for you. Details can be 
found in Table 17, Figure 92: Ground floor plan, and Figure 93: First floor plan in APPENDIX A:.) 

The Geometry form contains five main tabs (see Figure 33): 
• Project tab – This tab requires geometrical information on the whole building rather than 

on a zone level and is where you can enter global default values for a number of 
parameters to be used.  

The geometry of each zone is then described in the following four tabs: 
• Zones tab 
• Envelopes tab 
• Doors tab 
• Windows and rooflights tab 

 

 
Figure 33: The Project, Zones, Envelopes, Doors, and Windows & Rooflights tabs in the 

Geometry form 

 

7.5.1. Summary of how to define the geometry of a building 

There are 5 steps to defining the geometry of a building: 

1. Enter building scale information (total floor area) and global values which apply to 
most zones (such as zone height and Psi values for thermal bridges). This is done in the 
Project tab (Section 7.5.1: Project tab). 

Then for each zone: 

2. Create the zone - This is done in the General sub-tab of the Zones tab (Section 7.5.3: 
Defining zones). 
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3. Create its envelope elements – There are two ways to create envelope elements 
(walls, floor, and roof/ceiling): 

a. In the Envelopes main tab (Section 7.5.4). 

b. In the Quick Envelopes sub-tab of the Zones tab (Section 7.5.8). 

4. Create any windows – There are two ways to do this: 

a. In the Windows main tab (Section 7.5.5). 

b. In the Quick Envelope sub-tab of the Zones tab at the same time as creating the 
envelope element it is part of (Section 7.5.8). 

5. Create any external doors – In the Doors tab (Section 7.5.7). 

 
NB: Internal windows and doors should not be entered into iSBEM. 

 

The tabs in italics above are the main tabs of the Geometry form (see Figure 33). It is important 
to understand how to introduce information into these tabs (as well as being able to use the 
Quick Envelope function) as there are some parameters which can only be entered using these 
tabs. However, once familiar with the basis of the geometry objects, it is likely that you will enter 
most of your data using the Quick Envelope function. 

 
Order of data entry 

You need to create the zone before defining its envelope. It is not mandatory to enter all the 
information about the zone (envelopes, doors, windows, thermal bridges) before moving onto the 
next zone as you can always add or edit this information at a later time. Where possible, 
however, you should introduce each zone one at a time into the interface. 

 

Description of what is happening in iSBEM 

When you create a zone, envelope element, or window, you are creating what is referred to in 
iSBEM as a ‘building object’. These building objects need to be linked together correctly in order 
to define the geometry of a zone. When you define an envelope element in the Envelopes main 
tab, you will be prompted to link (or assign) it to a zone. Equally, when you define a window in 
the Windows & Rooflights main tab, you are prompted to link it to an envelope element. If you 
create the envelope element or window in the Quick Envelope sub-tab, these links are 
established automatically. This will be further explained as you work through the Example 
building. The final stage of defining a zone is to assign it to the appropriate building services 
systems. This can be done in either the Geometry or Building Services form. 

Figure 34 below is an example of a simple zone. To define the geometry of this zone, you would 
need to create the zone, 6 envelope elements, one window, and one door. The south wall door 
and window would need to be linked to the south wall, which in turn (along with the other 5 
envelope elements) would need to be linked to the zone, as shown by the arrows in the diagram 
below. 
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Figure 34: Diagram of building objects needed to define a simple zone 

 

NB: The tutorial will take you through how to define and link the building objects needed to 
complete the geometrical definition of a zone. 
 

7.5.2. Project tab 

Before defining the geometry of each zone, there are several parameters at the building scale 
which you need to enter. These include total floor area and globaliv values which apply to all or 
most zones (zone height and air permeability). These parameters are entered into two sub-tabs: 

• General & Geometry sub-tab 

• Thermal Bridges sub-tab 

 

General & Geometry sub-tab: 
This sub-tab requires five pieces of information as shown in Figure 36: 

Building Infiltration (Global) 

1. Air permeability at 50 pa (m3/h.m2) - The value you enter here will be the global or default 
value assigned to each zone. You can choose later to either use this global value or 
enter a different value for each zone that you define (see Section 7.5.3: Defining zones). 

NB: If the purpose of analysis option that has been selected in the General form > 
General Information tab > Project Details sub-tab is BER generation, then iSBEM’s 
default value for air permeability will be 25 m3/h.m2, while if compliance with building 
regulations has been selected as the purpose of analysis, the default value will be 10 
m3/h.m2. In either case, the user can over-write the default value by manually entering an 
alternative value. 

Building Orientation 

2. Building (clockwise) rotation – In degrees from north.  

NB: For example, Figure 35, a rotation of 45 degrees would change north-facing walls to 
north-east. However, note that the nomenclature in the names of already created 
envelopes (denoting orientation) would not be changed automatically by the rotation. 
Also, note that any envelope created after the rotation is performed will still retain the 

                                                
iv For further details on global values, see Section 6.1: Basic interface functionality and buttons. 

Diagram of a simple zone showing 
the building objects needed to 
define the zone and how they need 
to be linked to each other 

Define 
east wall 

N 

Define 
west wall 

Define 
south wall 

Define ceiling 

Define floor 

Define 
north wall 

Define 
Zone 

Define window 
in south wall 

Define door 
in south wall  
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original coordinate system. Hence, this parameter should be changed with caution from 
the default of zero.  

NB: The "Building rotation" parameter can be used when you want to model a building 
identical to one you have already modelled in iSBEM before (and therefore have its nct 
file), but which has a different orientation to the original one. As such, this parameter can 
be used to rotate the whole building as described in the guidance, provided you do not 
need to make any further modifications to the geometry of the building. 

 

 
Figure 35: Example of a 45 degree building rotation 

 

NB: The user is no longer required to enter the building height (height to eaves, in m). 

Building Details 

3. Zone height (Global) – Floor to floor height (floor to soffit for top floor), in m, i.e., including 
floor void, ceiling void, and floor slab. As with the global building infiltration parameter, 
the value you enter here will be given as the global or default zone height in each of the 
zones. You can choose to use this global value or enter a new value for each respective 
zone (see Section 7.5.3: Defining zones).  

NB: For a zone with a flat roof, the zone height would be from top of floor to top of roof. 
For a zone with a pitched roof and a flat ceiling underneath it, the zone height would be 
from top of floor to underside of soffit. For a zone with a sloping roof (i.e., an exposed 
pitched roof with no flat ceiling underneath it), the zone height would be from top of floor 
to soffit height. If there is a suspended floor, the zone height would be measured from 
the floor surface (rather than the slab underneath it). 

4. Building area – The total building (sum of zone areas) floor area (m2) – This field is for 
data entry checking purposes only (i.e., the value entered into this field is not used in any 
part of the calculation). The user can compare this figure to the figure calculated by 
iSBEM and reported directly below: “Currently the total zone area is…” which is a sum of 
all the areas of the entered zones. A red warning will appear if these values are not 
identical. 

Building Volume 

Wall 1: North  

Wall 1: North-East  

BEFORE ROTATION  AFTER ROTATION  
 

Wall Created to the North  Wall Created to the North  

N 
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5. Building volume – The total building (sum of zone volumes) volume (m3) – The user can 
either enter their own figure for the volume or choose to let iSBEM calculate it from the 
user-input dimensions of the zones.  

 

 
Figure 36: General & Geometry sub-tab of Project tab in the Geometry form 

 

Thermal bridges sub-tab: 

The Thermal bridges sub-tab allows you to define ‘global’ Psi values for thermal bridges. These 
global values can be selected when defining a zone so that you do not need to define the 
thermal bridges separately for each zone. If, however, the global values you define here do not 
apply to a specific zone, you can always choose not to use the global values (when defining the 
zone) and enter new values for that specific zone (see Section 7.5.3: Defining zones). 

SBEM requires information about non-repeating thermal bridgesv associated with junctions 
between envelope elements, windows, and doors which are in contact with the exterior as shown 
in Figure 37: Defining the global thermal bridges (see footnote below on types of thermal 
bridges). 

These types of junctions fall into two categories: 

1. Junctions involving metal cladding 

2. Junctions NOT involving metal cladding. 

For each type of junction, you can enter an Psi value (W/mK) or leave the default values. For 
junctions not involving metal cladding, you can also tick a box indicating whether or not that type 
of junction complies with the relevant standards. The standards for junctions not involving metal 
                                                
v Note on types of thermal bridges: There are two types of thermal bridge; repeating and non-repeating. 
Repeating thermal bridges should be taken into account when calculating the U-value of a construction. Non-
repeating thermal bridges can arise from a number of situations, but SBEM is only concerned with those arising 
from junctions between envelope elements, windows, and doors which are in contact with the exterior as shown 
in Figure 37. 
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cladding are Accredited Robust Details. The default Psi values for junctions involving metal 
cladding are compliant with the Metal Cladding and Roofing Manufacturers Association 
(MCRMA) standards. 

In Figure 37, the defaults for all the junctions in the building have been set to comply with the 
relevant Accredited Robust Details standards and use the tool’s defaults, except for the roof-to-
wall junctions involving metal cladding, where an Psi value has been manually added as an 
example. 

 

 
Figure 37: Defining the global thermal bridges 

 

NB: Thermal bridging at junctions and around openings, which is not covered in Accredited 
Construction Details [1] or MCRMA guidance [2], needs to be accounted for, and this may be done 
using the method in BRE Information Paper IP 1/06, making use, where appropriate, of the new 
publication on conventions for temperature factors and linear thermal transmittance [3]. 
[1] Accredited Construction Details for limiting thermal bridging and air leakage. Details on 
http://www.communities.gov.uk 

[2] Design of metal roofing and cladding systems: Guidance to complement Approved Documents L2A and L2B. 
MCRMA Technical paper no. 17, joint publication by MCRMA and EPIC, 2006  

[3] Conventions for calculating temperature factors and linear thermal transmittance (in preparation). 

 

7.5.3. Defining zones – Zones tab 

The first step in defining the geometry of a zone is to create the zone in the Zones tab of the 
Geometry form.  

NB: For building regulations calculations purposes, we recommend that users generally avoid 
creating more than 100-150 zones in iSBEM. However, the processing time will depend on the 
total number of objects (not just zones), i.e., zones, envelopes, windows, etc. Note that for 

http://www.communities.gov.uk
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building regulations compliance checking, the calculation has to generate 2 buildings: the actual 
and reference, so the number of objects (all the zones, envelopes, windows, etc.) that the 
calculation has to process is multiplied by 2, while for the BER to be calculated, 3 buildings need 
to be generated: actual, reference, and notional, typical, i.e., all the objects in the input are 
multiplied by 3 to give the total number of objects being processed by SBEM. Hence, creating a 
project with a very large number of objects will slow down calculation and may cause it to crash. 

The Zones tab contains four sub-tabs: 
• General sub-tab: This is where the zones are created and defined. You need to give 

each zone a unique name, select its building and activity types, and enter its area, 
height, and infiltration characteristics. You can also specify which HVAC system the zone 
is served by in this tab (but only if you have already defined the HVAC system in the 
Building Services form or you are using one of the default HVAC systems in iSBEM). 
(see below). 

• Quick Envelopes sub-tab: This is one way to define the envelope elements and assign 
them to the zone as described in Section 7.5.8: Quick Envelopes tab: Short cut to 
creating envelopes and windows. 

• Thermal bridges sub-tab: This is where the global thermal bridges for the zone are 
defined (see below). 

• Envelope Summary sub-tab: This tab displays a summary of all the envelope elements 
of the zone. 

 

General sub-tab: 

To create a zone, you will need to click into the General sub-tab of the Zones tab, add a new 
record, and enter the following information: 

1. Name – Any name can be given to a zone. The only requirement is that it is unique. 
There are certain recommendations to avoid it becoming complicated since there are so 
many elements in iSBEM which require naming. See Section 3.6: iSBEM nomenclature, 
for guidance on how to name your zones, envelope elements, doors, and windows. 

2. Multiplier – Indicate how many zones exactly identical to this one exist in the building (if 
more than the default of 1). Remember that this would also “multiply” all of its associated 
envelope elements, windows, doors, and additional thermal bridges during the 
calculation. 

3. HVAC System – If you have defined your HVAC systems before defining your zones 
(i.e., if you have started with the Building Services form instead of the Geometry form), 
you can select the HVAC system that serves this zone from the drop-down list. If no 
HVAC system serves the space (i.e., an unconditioned zone), select ‘Zones without 
HVAC system’ (spaces which have no heating or cooling, e.g., plant rooms, storage 
spaces, exposed circulation spaces.). If you have not yet defined your HVAC system, 
this can be left as ‘Unassigned’ at this stage. You will be able to assign the zones to an 
HVAC system later within the Building Services form so there is no need to define the 
HVAC system before continuing. If you leave the zone as unassigned, a red warning will 
appear in the top right hand corner to let you know how many zones remain unassigned. 

NB: If a zone is defined as having no heating or cooling, i.e., assigned to ‘Zones without 
HVAC system’, but the activity type selected for the zone is one which typically requires 
conditioning (according to the Activity Database), a red exclamation mark “!” will appear 
next to this parameter as a warning to the user, in case this was done in error. Ultimately, 
however, the calculation will be carried out using the data input by the user.     

If you do not know the type of the HVAC system in your building or its detailed 
parameters, you should select one of the following default options from the drop-down 
menu (see Section 7.6: Building Services form): 
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• ‘Heating only - Electric resistance’ - Heat generated by passing current through 
resistance wire. Assumed to be electric central heating system with warm air 
distribution. Fan storage heaters and electric fan converters should be input by 
defining an HVAC system in the Building Services form > HVAC Systems tab > 
General sub-tab and selecting the system type "Other local room heater - fanned". If 
you do not know the heating method (i.e., whether a heated-only building uses 
electricity or a fuel-based heating system), you should select electric resistance 
heating as your default. 

• ‘Heating only - Other systems’ - Assumed to be wet radiator system, heat generated 
by fuel combustion. Pumps assumed to be powered by grid-supplied electricity. If 
you know the fuel type used by the heating system, you can define it in the Building 
Services form > Global and Defaults tab > HVAC System Defaults sub-tab (see 
Section 7.6.1: Global and Defaults tab).  

•  ‘Heating and mechanical cooling’ - Assumed to be constant volume air system with 
terminal reheat and fixed fresh air. Refrigeration (chillers), fans, and pumps assumed 
to be powered by grid-supplied electricity. If you know the fuel type used by the 
heating system, you can define it in the Building Services form > Global and Defaults 
tab > HVAC System Defaults sub-tab (see Section 7.6.1: Global and Defaults tab). 

NB: The default HVAC systems are representative of existing rather than new buildings and 
should only be used if you do not know the type of the HVAC system in your building or its 
detailed parameters as the default efficiencies assumed by iSBEM for them are quite pessimistic 
and cannot be edited by the user. 

NB: See note in Section 7.6.8: Defining the zone specific building services, regarding indirectly 
conditioned spaces.  

4. Building type – The default for this field is the building type that was selected when 
creating the project (this information is recorded in the General Information tab in the 
General form). It can, however, be changed for any particular zone, if appropriate (see 
note below). 

5. Activity type – A building can be divided into a number of activity areas. For example, in 
an office building, there may be a reception, open plan office, some cellular offices, a tea 
room, and some toilets. When you choose your building type and activity area, you are 
setting a number of default parameters which the tool uses to calculate the energy 
consumption. These parameters include temperature set points, heat gains from people 
and equipment, required illuminance, and fresh air requirements amongst others. Each 
building type has a number of different activity areas to choose from. The description of 
the activity area, as it appears in the NCM Activity Database, is displayed in a box at the 
right-hand side of the sub-tab. For more information on building types and activity areas, 
please refer to the NCM Modelling Guide or the NCM Activity Database (available for 
download from the SEAI websitevi.  

NB: It is not a problem in SBEM to introduce activities from building types other than the default 
building type introduced at the beginning of an SBEM project. For example, an office may have 
activities from the “Office” building type (e.g., open plan office, meeting room, tea making, etc...) 
but may also have atypical activities which are not included in the office building type, e.g., a 
shop, in which case the user would need to use a “Retail” building activity such as 'General 
Sales Area' or similar. The building type does not need to be the same for all activities in a 
project. It is intended to be a default for the project in iSBEM (could apply to other interfaces) 
and provides a 'filter' on the many activities available, making it easier for users to make a choice 
of activity for each zone. Generally, activities from the default building type should be used, but if 
there is nothing suitable available, another building type could be used. 

                                                
vihttp://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM_Software/Downlo
ad_SBEM_Software.html     

http://www.seai.ie/Your_Building/BER/Non_Domestic_buildings/Download_SBEM_Software/Downlo
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NB: Domestic-type activities were added to the options available under the building type 
“Dwelling” in iSBEM in order to allow the energy calculations for the generation of one BER 
certificate for a building which contains residential accommodation above a non-domestic space 
(e.g., a shop or a pub) provided that the residential space can only be accessed from within the 
non-domestic space, i.e., the residential part is not designed or altered for use as a separate 
independent dwelling. In addition to common circulation areas of apartment buildings containing 
self-contained flats (as described in the next note), these are the only cases where SBEM can 
be used to model domestic activities. For more information on the appropriate software tools to 
use for modelling your building, please refer to the SEAI website at www.seai.ie.     

NB: Only the communal areas of apartment buildings containing self-contained flats should be 
assessed for compliance using SBEM, for example, circulation areas (using the “Common 
circulation areas” activity under the building type “DWELLING”). The self-contained flats 
themselves should be assessed using the Dwelling Energy Assessment Procedure (DEAP).  

6. Area - Floor area of the zone, in m2, calculated using the internal horizontal 
dimensions between the internal surfaces of the external zone walls and half-way 
through the thickness of the internal zone walls (see Section 3.4: Measurement and 
other conventions, and Figure 4). This parameter is used to multiply area-related 
parameters in the databases. The area basis needs to be consistent with that for 
Operational Ratings. 

NB: If the zone has any virtual boundaries created due to the zoning rules on daylight 
access, you need to consider the area of the zone as that delimited by the ‘line’ created by 
that virtual boundary (the virtual boundary itself is not entered into iSBEM). 

NB: Where there is an unheated, unoccupied roof space (i.e., between a pitched roof and a 
flat ceiling) above an activity area, it should not be treated as a separate unheated zone. 
Instead, the void should be considered as part of the construction when calculating the U-
value between the occupied activity area and the outside (i.e., the top floor ceiling should be 
dealt with as a ‘roof’ and be given the combined thermal performance of the whole 
construction including the ceiling construction, the void, and the roof construction). If the roof 
space is occupied (heated), then it becomes a normal activity area. If surfaces of the room 
are not rectilinear, for example, if a pitched roof is exposed to the inside of the conditioned 
zone (i.e., there is no flat  ceiling underneath it), then the roof area will be that of the inner 
surface area of the roof as "seen" by the heat flux. 

7. Zone height – Floor to floor height (floor to soffit for the top floor), in m, i.e., including 
floor void, ceiling void, and floor slab, is used for calculating the length of the wall-to-wall 
junctions and radiant and temperature gradient corrections. Either enter you own figure 
into the box, or click on the Global button ( ). Pressing the Global button brings the 
global default value, which you previously defined in the Projects tab, into the field. 

NB: For a zone with a flat roof, the zone height would be from top of floor to top of roof. 
For a zone with a pitched roof and a flat ceiling underneath it, the zone height would be 
from top of floor to underside of soffit. For a zone with a sloping roof (i.e., an exposed 
pitched roof with no flat ceiling underneath it), the zone height would be from top of floor 
to soffit height. If there is a suspended floor, the zone height would be measured from 
the floor surface (rather than the slab underneath it). 

Infiltration 

8. Air permeability at 50pa, in m3/h.m2 - Similar to the zone height, you have the option to 
either enter you own value or use the default global value which you previously defined 
in the Projects tab by clicking on the Global button. Otherwise, a default value (visible in 
the interface) will be used by the software. 

NB: If the purpose of analysis option that has been selected in the General form > 
General Information tab > Project Details sub-tab is EPC generation, then iSBEM’s 
default value for air permeability will be 25 m3/h.m2, while if only compliance with building 
regulations has been selected as the purpose of analysis, the default value will be 10 

http://www.seai.ie
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m3/h.m2. In either case, the user can over-write the default value by manually entering an 
alternative value. 

9. Thermal bridges: 

a. Tick here to use global psi values – If the box is ticked, the Thermal Bridges sub-
tab disappears and the global psi values defined in the Project tab of the 
Geometry form are applied to the selected zone.  

NB: Entering the number of corners for the zone is no longer required as SBEM is now 
able to calculate the value for this parameter from the other information input for the 
zone. See Section 3.5: Number of corners (thermal bridge parameter) for details on how 
the number of corners is calculated. 

10. User’s notes – This box is provided for the user to fill in, at their discretion, any details 
(description) about the zone that are not covered by the other fields. iSBEM does not 
process the entry in this field.  

Figure 38 shows a zone being defined. 

 

 
Figure 38: A zone being defined in the General sub-tab of the Zones tab in the Geometry form 

 

At the top right hand side of the Zones tab, a message (in red text) will appear indicating how 
many zones have not yet been assigned to HVAC systems. To see a list of all the zones which 
have not been assigned, click on the Reports button to access the Unassigned Objects report 
(for more details about the Objects reports, see Section 7.9: Double-checking the data). 

 
Notes on viewing/deleting/copying zones 
To view the zones that you have created, you need to click on the record selector in the Zones 
tab. A drop-down list will then appear showing all of the zones that you have defined in that 
project. To the right of the zone’s name will be the HVAC system which that zone has been 
assigned to. If a zone has not been assigned to an HVAC system it will say “Unassigned”. 

Notes entered at the user’s 
discretion about the zone. 

A description of the selected 
activity area as it appears in 
the NCM database. 

Selected activity  
type for this 
zone. 

Selected building 
type  for this 
zone. 
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NB: At this stage in the tutorial, you will not have created the HVAC system yet so it will say 
“Unassigned” to the right of your zones. 

 

To delete a zone (along with all its associated envelope elements, doors, and windows), you 
need to select it using the record selector, and then click on the “Delete record” button.  

If you press the copy button, you will copy the selected zone along with all of the envelope 
elements, doors, and windows that have been created and linked to it. The new zone will be 
automatically named for you - it will be the “name of copied zone.1”. Once it has been created, 
you can change its name. However, the names of the copied envelope elements, doors, and 
windows will still have the same names as those they were copied from. The following sections 
will explain how to rename and edit the envelope elements, doors, and windows. (There will be 
an option to just copy the zone by itself, without its child objects, in future versions of the tool.)  

 

 

Task 5: Create Zone z0/02 in the General tab (the circulation area on the ground floor) 

The building has already been zoned for you. See Figure 92: Ground floor plan and Figure 93: 
First floor plan in APPENDIX A:. A summary of the zoning, along with recommended names for 
the zones, is given in Table 17.  

The six zones which make up the coffee shop have been entered for you so you can start by 
entering the information for Zone z0/02. Firstly, click on the Geometry form and the Zones tab. 
You should then be in the General sub-tab. Add a new record and, by referring to APPENDIX A:, 
enter the zone’s name, select the appropriate building and activity types, and finally, enter the 
zone’s area and height. 

Using the record selector, you should now be able to view seven zones in total. 

 
Thermal Bridge sub-tab: 
If the tick box ‘tick here to use global psi values’ in the General sub-tab of the Zones tab (see 
above) is not ticked, the Thermal Bridges sub-tab will be visible, as shown in Figure 39. Here, 
you can define any thermal bridges that might occur in the selected zone relating to junctions 
between envelope elements, windows, and doors which are in contact with the exterior. This is 
done in the same way as setting the global defaults for thermal bridges in the Projects tab (see 
Section 7.5.2: Project tab). 
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Figure 39: The Thermal Bridge sub-tab of the Zones tab 

 

Envelope Summary sub-tab: 
The envelope elements of a zone can be viewed in the Envelope Summary sub-tab of the Zones 
tab, shown in Figure 40, (see Section 7.5.4: Defining envelopes – Envelope tab for details on 
how the envelopes for each zone are created). Depending on which radio button is selected in 
the ‘Show Objects’ section, you can choose to either view only the envelopes attached to the 
zone or view the zone’s envelopes as well as any windows or doors assigned to the envelopes. 
The zone’s envelopes are listed in the left hand side window in terms of their names and types of 
envelope (wall/floor/roof). If any of the envelopes, windows, or doors, are highlighted in the left 
hand side window, more details about that object appear in the ‘Selected objects properties’ 
window, such as its area, construction, and the condition of the space it connects the zone to. 
Also included in the details is the ID number given by iSBEM to this envelope. This ID number 
can be used to locate this particular envelope quickly in the Envelope tab should any editing of 
its parameters be required (see Section 7.5.4: Defining envelopes – Envelope tab). 
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Figure 40: Envelope Summary sub-tab 

 

NB: the Quick Envelope function will be explained in Section 7.5.8: Quick Envelopes tab: Short 
cut to creating envelopes and windows. 

 

7.5.4. Defining envelopes – Envelope tab 

The second stage of defining the geometry of a zone is to define its envelopes (walls, floor, and 
ceiling/roof). There are two ways of doing this: 

1. In the Envelopes tab – Where you can create the envelope elements and define all of 
their parameters. This method is explained below. 

2. In the Quick Envelopes sub-tab of the Zones tab - Where you can create and define the 
basic parameters for the envelope elements and windows. This is explained in Section 
7.5.8. There are some parameters, however, for both envelope elements and windows 
which can only be defined in their main tabs. These tabs will, therefore, be explained 
first. 

 

The main Envelope tab, shown in Figure 41, contains two sub-tabs:  
General sub-tab: This is where you can create and define the envelope elements in terms of 
name, area, orientation, construction type, what type of space it is connected to, and its 
(additional) thermal bridges. 
Window & Door Summary sub-tab: This tab displays a summary of the windows and doors 
present in each envelope element. 
 
 
 

This is the ID number of 
this envelope given to it by  
iSBEM. 
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General sub-tab: 
For each envelope element, you will need to click into the General sub-tab of the Envelope tab, 
create a new record, and add the following information: 

1. Name – Similar to the naming of the zones (see Section 3.6 for more information). 

2. Multiplier – Indicates how many envelope elements identical to this one exist in the 
selected zone. Remember that this would also “multiply” all of its associated windows, 
doors, and additional thermal bridges during the calculation.  

3. Zone – Here you need to select the zone from the drop-down list (of zones defined so 
far) which this envelope element is part of. 

4. Type of envelope – Choose between wall, floor/ceiling, and roof. 

5. If you select roof, a tick box appears: 

i. Is the roof flatvii? – Tick the box to indicate if the roof is flat. Otherwise, the tool 
will assume it is pitched. 

NB: Smoke vents are no longer used in the SBEM calculation, and so their input into iSBEM is 
no longer required. Compliance checking with respect to their U-values will, therefore, need to 
be carried out outside of SBEM. 

6. Connects space to – Here you need to select what conditions apply on the other side of 
the wall/floor/ceiling/roof. If you click the Global button, the condition associated with the 
type of construction selected below (as has been defined in the Project Database form) 
will be inserted as the default. If this is not appropriate, you can un-click the Global 
button and select between: Conditioned adjoining space, External, Strongly ventilated, 
Underground, Unheated space, or Same space (see Table 9). 

 

Option Brief Description 
Exterior For an envelope separating the considered zone from the 

outside air or water. 
Strongly ventilated spaces For an envelope separating the considered zone from a 

space provided with one or more permanent openings (i.e., 
that cannot be closed), with a capacity for the supply of fresh 
air and extract of inside air, determined according to section 
5.3 of NEN 1087, of at least 3x10-3 m3/s per m2 useable 
area. 

Unheated adjoining space For an envelope separating the considered zone from an 
unheated adjoining space, other than meant under ‘Strongly 
ventilated spaces’. 

Conditioned adjoining space For an envelope separating the considered zone from 
another conditioned zone. 

Underground For an envelope separating the considered zone from the 
ground. 

Same space For constructions representing the internal envelopes that 
separate contiguous zones which have been merged into 
one zone, i.e., the envelope is “contained” within the merged 
zone. 

Table 9: Options for ‘Connects space to’ field for envelopes 

 
NB: Note that the Building Regulations compliance check regarding U-values will be applied by 
the tool to all envelopes which are not adjacent to a ‘Conditioned adjoining space’. Also note that 
the tool will not check the U-values of envelopes of unconditioned zones for compliance.  
                                                
vii A pitched roof has a pitch greater than 10 deg (If the roof’s pitch is 10 deg or less, it can be 
considered flat). If the pitch is greater than 70 deg, it can be considered a wall. 
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7. Construction – Here you need to select the type of construction. When you click the 
drop-down menu to the right of the construction field, you will be presented with all the 
constructions of that type (type of envelope defined above) that you have defined in the 
Project Database form, as well as a default construction. Select one of these. If you need 
another construction type, you will need to go back to the Project Database form and 
create it first. 

8. Area – This is the area of envelope element inclusive of any windows and doors, in m2. 
This value is used to calculate the fabric heat loss so this is the area to which the U-
value is applied. For floors and flat roofs/ceilings, the envelope area is calculated in the 
same manner as the zone area (see Section 7.5.3: Defining zones and Section 3.4: 
Measurement and other conventions). The area for an exposed pitched roof (i.e., without 
an internal flat ceiling) will be that of the inner surface area of the roof. For vertical 
envelopes (i.e., walls), the area is calculated as follows: 

Area of vertical envelope element = h * w, where: 

h = floor to floor height (floor to soffit on top floor), in m, i.e., including floor void, ceiling 
void, and floor slab, and 

w = horizontal dimension of the wall. Limits for this horizontal dimension are defined by 
the type of the adjacent walls (usually at right angles to the vertical envelope element in 
question). If the adjacent wall is external, the limit will be the internal side of the adjacent 
wall. If the adjacent wall is internal, the limit will be half-way through its thickness.  

NB: If surfaces of the room are not rectilinear, for example, if a pitched roof is exposed to the 
inside of the conditioned zone (i.e., there is no flat  ceiling underneath it), then the roof area 
will be that of the inner surface area of the roof as "seen" by the heat flux. 

NB: During the calculation, if the area of the wall input is less than the total area of windows 
and doors defined within in, SBEM will increase the area of the wall to fit the areas of all the 
defined openings in it. The corresponding wall in the notional building will similarly have the 
increased area. Therefore, you should always ensure that you double-check the figures you 
input for your model geometry in iSBEM before running the calculation.  

9. Orientation – Here you need to select from the drop-down menu whether the element 
faces north, north-east, east, etc., or is horizontal. 

10. Additional Thermal Bridges – If there are any thermal bridges in addition to those already 
described in the Thermal Bridges sub-tab of Project tab (if the global values are being 
applied) or the Thermal Bridges sub-tab of the Zones tab (if they are not), then they need 
to be entered here in terms of the length of the thermal bridge (m) and its linear thermal 
transmittance [the ψ (psi) value] (W/mK). (See notes in Section 7.5.2: Project tab 
regarding thermal bridges.). 

11. Go to ID – this parameter can be used to quickly “jump to” a particular envelope. The ID 
number of an envelope is visible among the envelope details displayed in the Envelope 
Summary sub-tab of the zone to which this envelope belongs. For example, if while 
reviewing the details in the Envelope Summary sub-tab, an error was detected in the 
description of a particular envelope, you can make a note of its ID number (Figure 40), 
go to the Envelope tab, type the ID number in the box, and press the arrow key . This 
will take you to the General sub-tab of that particular envelope where you can correct the 
error (see Envelope Summary sub-tab in section 7.5.3: Defining zones – Zones tab).  

Figure 41 shows a wall being defined. 
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Figure 41: A wall being defined in the General sub-tab of the Envelope tab in the Geometry 

form 

 

At the top right hand side of the Envelope tab, a message appears if any of the envelope 
elements have not yet been assigned to a zone. To see a list of all the envelope elements which 
have not been assigned to zones, click on the Reports button (for more details about the Objects 
reports, see Section 7.9: Double-checking the data).  

 

Task 6: Create all the envelope elements for Zone z0/02 

The details on the walls, floors, and ceilings/roofs can be found in Table 17 in APPENDIX A:. 
First, click on the Geometry form and the Envelope tab. You should then be in the General sub-
tab. For each new envelope element, you will need to add a new record and by referring to Table 
17, enter its required parameters. Do this for all the envelope elements for Zone z0/02 (This 
includes the four walls, the floor, and the ceiling. (The envelope elements for Zones z0/01north, 
z0/01east, z0/01south, z0/01west, z0/01northwest, and z0/01southwest have been entered for 
you, and you will be able to view them using the record selector.) 

 
Viewing, deleting, and copying envelope elements in the Envelope main tab 
To view the envelope element that you have created, you need to click on the record selector in 
the main Envelope tab. A drop-down list will then appear showing all of the envelope elements 
that you have defined in that project. To the right of the envelope’s name will be the zone which 
that envelope element is part of, followed by the HVAC system which the zone has been 
assigned to. If the zone has not been assigned to an HVAC system, it will say “Unassigned”. 

 

NB: At this stage in the tutorial, you will not have created any HVAC systems yet so it will say 
“Unassigned” to the right of your zones 
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Note that the first line in the drop-down box reads “Select action or wall from the list”. This refers 
to actions that will be available in future versions of the tool, for example, sorting by zone or 
copying only part of the envelope (for example, copying a wall without its windows). 

To delete an envelope element (and any associated windows or doors), you need to select it 
using the record selector and then click on the “Delete Record” button. 

If you press the “Copy Record” button, you will copy the selected envelope element along with 
any windows and doors that have been created and linked to it. The new envelope will be 
automatically named for you - it will be the “name of copied envelope.1”. Once it has been 
created, you can change its name. (The names of the copied windows and doors associated 
with the envelope, however, will have the same name as those they were copied from - the 
following section will explain how to rename and edit the windows). 

 

Task 7: View the envelope elements you have created for zone z0/02 in the Envelope main 
tab AND in the Envelope Summary tab 

First, using the record selector in the main Envelope tab, view the envelope elements that have 
been created in this project.  

Then, go back to the Zones main tab, select zone z0/02, and click on the Envelope Summary 
sub-tab. Here, you should be able to see all the envelope elements that you have created in 
Task 6. If you have made any errors, you will need to go back to the main Envelope tab, and edit 
the envelope elements there. 

 

Task 8: Create a new envelope element and then delete it 

So that you become familiar with the functionality of the tool, try introducing a made-up envelope 
element for zone z0/02 using the Envelope tab. Once it has been sufficiently defined (i.e., the 
green fields have been filled in), you will be able to delete it. 

 
Windows & Doors Summary sub-tab: 
The windows and doors assigned to an envelope element can be viewed in the Window & Door 
Summary sub-tab of the Envelope tab, shown in Figure 42, (see Section 7.5.5: Defining 
windows, for details on creating windows and rooflights and Section 7.5.7: Defining doors, for 
details on creating doors). Depending on which radio button is selected in the ‘Objects’ section, 
you can choose to either view only the windows and rooflights attached to the envelope, view 
only the doors, or view the envelope’s windows and rooflights as well as any doors. The 
envelope’s windows and/or doors are then listed in the left hand side window in terms of their 
names and types (window/door). If any of the windows or doors are highlighted in the left hand 
side window, more details about that object appear in the ‘Selected objects properties’ window, 
such as its area and construction.  
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Figure 42: Windows & Doors Summary sub-tab 

 

NB: the Quick Envelope function is explained in Section 7.5.8: Quick Envelopes tab: Short cut to 
creating envelopes and windows.) 

 

7.5.5. Defining windows and rooflights – Windows & Rooflights tab 

For each envelope element in the building, you need to define the type and amount of glazing it 
contains, if any. If there is more than one window of the same type in one wall/roof, you can add 
together the areas and enter them as one single window (or you can use the multiplier field). The 
principal way to define the windows is in the main Windows & Rooflights tab. 

Rooflights are considered in the same way as windows in SBEM. 

There is only one sub-tab in the Windows & Rooflights tab: 

• General sub-tab. 

 
General sub-tab:  
This is where you need to enter the window name, assign it to an envelope element, enter the 
glazing type, area, shading system, transmission factor, and details of any additional thermal 
bridges. 

NB: Internal windows and doors should not be entered into iSBEM. 

For each window, you will need to create a new record and add the following information: 

1. Name – As before, the name must be unique and should indicate which wall it is to be 
attached to (see Section 3.6: iSBEM Nomenclature, for more information). 



91                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

2. Multiplier – Indicate how many windows identical to this one exist in the selected 
envelope element. Remember that this would also “multiply” all of its associated 
additional thermal bridges during the calculation. 

3. In Envelope – Here, you need to select from the drop-down box, which envelope element 
this window is in (be it a wall or a roof). 

4. Glazing type – Here, you need to select the type of glazing. When you click on the drop-
down menu to the right of the glazing field, you will be presented with all the glazing 
types that you already defined in the Project Database form, as well as a default glazing. 

5. Area – Area of the structural opening in the wall/roof including the frame, in m2. 

NB: If the wall/roof is fully glazed, then the area of the window will be equal to the area of 
the wall/roof. 

NB: During the calculation, if the area of the wall input is less than the total area of 
windows and doors defined within in, SBEM will increase the area of the wall to fit the 
areas of all the defined openings in it. The corresponding wall in the reference building 
will similarly have the increased area. Therefore, you should always ensure that you 
double-check the figures you input for your model geometry in iSBEM before running the 
calculation.  

6. Surface area ratio – This is the “developed area to projected area” ratio for the window. 
The developed area is the total area of the glass plus the frame, and the projected area 
is the area of the opening in the wall/roof. Therefore, for domed or conical rooflights, for 
example, this ratio would be larger than 1. It cannot have a value which is less than 1. 

7. Area ratio covered – This is the ratio of the roof area covered by an array of rooflights to 
the total area of the rooflight glazing (see Figure 43 for example). This parameter is 
active only if the envelope to which this window belongs has been defined as a roof, i.e., 
the window is in fact a rooflight. NB: This parameter is used by SBEM to determine the 
area of the zone which is daylit by the array of rooflights for automatic daylight zoning 
sub-division (see Lighting (Controls) sub-tab in Section 7.6.8: Defining the zone specific 
building services- Zones tab). If the user is doing the daylight zoning manually, the "Area 
ratio covered" parameter is not relevant. If the calculated value for this parameter is 
larger than the maximum of 4, then the user can either enter the value as 4 or do the 
daylight subdivision manually for the zone containing this array of rooflights.  

8. Display Window tick box – Tick this box if the window being defined is for display 
purposes (e.g., a shop front window), as defined in the Building Regulations. 

NB: The compliance tool does not check ‘display windows’ for compliance with the Building 
Regulations with regards to the glazing’s limiting standards for U-values. 

9. Frame factor – This is the ratio of the window or rooflight area which is occupied by the 
frame. The default value is 0.1 for a window (i.e., 10% of the total area is occupied by the 
frame and 90% by the glazing) and 0.3 for a rooflight. It cannot have a value which is 
less than 0 or which is larger than 1. 

10. Shading system – Here, you need to select from the drop-down box whether the window 
has: User-moveable external protection, Automatically-controlled external protection, or 
All other cases. This is used to calculate the reduction factor due to shading devices, 
which reduces the amount of solar heat gains through glazing. 

11. Transmission factor – This is the fraction of light transmitted through that specific window 
after accounting for shading from overhangs and fins. (For details on how to calculate the 
transmission factor, see Section 7.5.6: Transmission correction factors.) 

12. Thermal Bridges – Here, you need to define any thermal bridges in addition to those 
already described in the Thermal Bridges sub-tab of the Project tab (if the global values 
are being applied) or the Thermal Bridges sub-tab of the Zones tab (it they are not), in 
terms of the length of the thermal bridge (m) and its linear thermal transmittance [the 
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ψ (psi) value] (W/mK). (See notes in Section 7.5.2: Project tab, regarding thermal 
bridges.) 

NB: Doors which are more than 50% glazed should be entered into iSBEM as windows, and 
their light and solar characteristics should be entered into the Project Database form > Glazing 
tab. Doors which are 50% or less glazed can be treated as opaque doors. 
 

 
Figure 43: Area ratio covered for the definition of rooflights 

 

Example (Figure 43): 
Roof area covered by array of rooflights = 9 m x 3 m = 27 m2. 
Total area of rooflight glazing = 10 x 1 m2 = 10 m2 
Area ratio covered for the example in the diagram = 27 m2 / 10 m2 = 2.7 
 

Figure 44 shows a window being defined. 

 

Rooflights 
Roof area 

Roof area covered by array of rooflights 
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Figure 44: A window being defined in the General sub-tab of the Windows & Rooflights tab in 

the Geometry form 

 

At the top right hand side of the Windows tab, a message will appear indicating how many 
windows have not yet been assigned to an envelope element. To see a list of all the windows 
which have not been assigned to envelope elements, click on the Reports button (for more 
details about the Objects reports, see Section 7.9: Double-checking the data). 

 

Task 9: Create the windows for zone z0/01west  

The details of all the glazing present in each zone are given in Table 17 in APPENDIX A:. First, 
click on the Geometry form, the Windows & Rooflights tab, and then the General sub-tab. For 
each new window, you will need to add a new record and by referring to Table 17, enter all the 
required parameters. Do this for the window in zone z0/01west (z0/01west/w/g). 

 
Viewing, deleting, and copying windows in the Windows & Rooflights tab 
To view the windows that you have created, you need to click on the record selector in the main 
windows tab. A drop-down list will then appear showing all of the windows that you have defined 
in that project. To the right of the window’s name will be the names of the envelope element 
which that window is part of, followed by the name of the zone to which the envelope belongs. 

Note that the first line in the drop-down box reads “Select action or window from the list”. This 
refers to actions that will be available in future versions of the tool, for example, sorting by 
envelope element. 

To delete a window, you need to select it using the record selector, and then click on the “Delete 
Record” button. 

If you press the “Copy Record” button, you will copy the selected window. The new window will 
be automatically named for you – it will be the “name of copied window.1”. Once it has been 
created, you can change its name. 
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Task 10: View the window that you have created for zone z0/01west in the Windows main 
tab AND in the Windows Summary tab 

First, using the record selector in the main Windows tab, view the windows that have been 
created in this project. You should be able to see 7 (6 already created for you plus the one you 
have created). 

Then, go back to the Envelope main tab, select envelope z0/01west/w, and click on the Windows 
& Doors Summary sub-tab. Here, you should be able to see the window that you have created in 
Task 9. If you have made any errors, you will need to go back to the main Windows & Rooflights 
tab and edit them. 

 

Task 11: Create a window and then delete it 
So that you become familiar with the functionality of the tool, try introducing a made-up window 
for zone z0/01west using the Window & Rooflights tab. Once it has been sufficiently defined (i.e., 
the green fields have been filled in), you will be able to delete it. 
 

7.5.6. Transmission correction factors 

The transmission factor for windows can be calculated fromviii: 
 
TS =  Fo Ff  
where 
 
Fo  is the partial shading correction factor for overhangs, and  
Ff  is the partial shading correction factor for fins. 

A transmission factor of 1 refers to 100% of light transmitted, i.e., no shading from fins or 
overhangs. 
 

NB: The effect of shading from the horizon (e.g., the ground, trees, and other buildings) has not 
been considered for the calculations carried out by SBEM. 
 

Shading from overhangs and fins 

The shading from overhangs and fins depends on the overhang or fin angle, latitude, orientation, 
and local climate. Seasonal shading correction factors for typical climates are given in Table 10 
and Table 11. 

 

                                                
viii The source of the shading calculation due to fins and overhangs is the CEN standard "EN 13790: 
Energy performance of buildings — Calculation of energy use for space heating and cooling". 
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Figure 45: Shading from overhangs and fins 

 
NB: For the purposes of this calculation, the angles alpha and beta, indicated by the dashed 
lines in Figure 45, are taken between the plane of the window and the overhang or fin shadow 
line at mid-window. 

 

 
Table 10: Partial shading correction factor for overhang, Fo 

 

 
Table 11: Partial shading correction factor for fins, Ff 

 

7.5.7. Defining doors – Doors tab 

Only a zone’s external doors need be defined in iSBEM.  

The Doors tab contains one sub-tab: 
• General sub-tab 
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General sub-tab: 
This is where you need to enter the name of the door, assign it to an envelope element, and 
enter its area, its construction type, its additional thermal bridges (if applicable), and what type of 
door it is.  

NB: Internal windows and doors should not to be entered into iSBEM. 

For each door, you will need to create a new record and add the following information: 

1. Name – As before, the name must be unique and must indicate which wall it is to be 
attached to (see Section 3.6: iSBEM Nomenclature, for more information). 

2. Multiplier – Indicate how many doors identical to this one exist in the selected envelope 
element. Remember that this would also “multiply” all of its associated additional thermal 
bridges during the calculation. 

3. In Envelope – Here, you need to select which element this door is part of from a drop-
down box of the envelopes already created. 

4. Type – Here, you need to select between: Personnel Doors, High Usage Entrance 
Doors, and Vehicle Access Doors (as defined in the Building Regulations). 

5. Construction type – Here, you need to select the type of construction. When you click on 
the drop-down menu to the right of the construction field, you will be presented with all 
the constructions for doors that you defined in the Project Database form, as well as a 
default construction. 

6. Area – Specifies the area of the door including the frame, in m2, i.e., the area of the 
structural opening in the wall. 

NB: During the calculation, if the area of the wall input is less than the total area of 
windows and doors defined within in, SBEM will increase the area of the wall to fit the 
areas of all the defined openings in it. The corresponding wall in the reference building 
will similarly have the increased area. Therefore, you should always ensure that you 
double-check the figures you input for your model geometry in iSBEM before running the 
calculation.  

7. Thermal Bridges – Here, you need to define any thermal bridges in addition to those 
described in the Thermal Bridges sub-tab of Project tab (if the global values are being 
applied) or the Thermal Bridges sub-tab of the Zones tab (it they are not), in terms of the 
length of the thermal bridge (m) and its linear thermal transmittance [the ψ (psi) value] 
(W/mK). (See notes in Section 7.5.2: Project tab, regarding thermal bridges.) 

 

NB: Doors which are more than 50% glazed should be entered into iSBEM as windows, and 
their light and solar characteristics should be entered into the Project Database form > Glazing 
tab. Doors which are 50% or less glazed can be treated as opaque doors. 

Figure 46 shows a door being defined. In this example, two doors of 3.75 m2 in area each have 
been entered. 

 



97                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

 
Figure 46: A Door being defined in the Doors tab 

 

7.5.8. Quick Envelopes tab: Short cut to creating envelopes and 
windows 

The Quick Envelopes sub-tab provides an alternative way of introducing the envelope elements 
and windows without having to assign them manually to a zone or envelope element, 
respectively.  

The information required is a selection of the parameters required in the main Envelope and 
Windows & Rooflights tabs.  

 

Envelopes elements and windows are created as follows: 
The zone to which the envelopes and windows are to be assigned is defined by the zone 
selected using the record selector. 
The type (wall, floor/ceiling, or roof) and orientation of the envelope element is defined by which 
row you enter your information into. The first eight rows are for creating walls with orientations S, 
SE, E, NE, N, NW, W, and SW, and the last three rows are for ceilings, floors, and roofs. 
There are then three fields that need to be filled in for each envelope element: 

1. Construction type (choose between a default construction and the constructions that you 
defined in the Project Database form). 

2. Adjacent condition – Here you have 2 options: 
a. Leave the Global button pressed in and hence apply the global default adjacency 

condition that was associated with the selected construction in the Project Database 
form (see Section 7.4.1: Defining construction types) or 

b. Un-depress the Global button and select a condition from the drop-down menu 
(choose between: Exterior, Strongly ventilated spaces, Unheated adjoining space, 
Conditioned adjoining space, or Underground). 
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3. Area (calculated as described in section 7.5.4: Defining envelopes – Envelope tab), in 
m2. 

If that envelope element has any windows or glazed areas, you need to fill in the following 
remaining fields: 

4. Area of the window or rooflight, including the frame, in m2. If you wish to define windows 
or rooflights (including the frames) using percentages of the envelope areas (as was the 
case in previous versions of iSBEM), then you need to untick the relevant box in the 
General form > File Options tab > System Configuration (cont.) sub-tab (see Section 
7.3.1: File Options tab). The box is ticked by default. 
NB: Internal windows and doors should not be entered into iSBEM. 

NB: If the wall/roof is fully glazed, then the area of the window will be equal to, i.e. 100% 
of, the area of the wall/roof. 

NB: During the calculation, if the area of the wall input is less than the total area of windows 
and doors defined within in, SBEM will increase the area of the wall to fit the areas of all the 
defined openings in it. The corresponding wall in the reference building will similarly have the 
increased area. Therefore, you should always ensure that you double-check the figures you 
input for your model geometry in iSBEM before running the calculation.  
5. Glazing type (choose between a default glazing type and the glazing types that you 

defined in the Project Database form). 
6. Disp? – Indicate whether it is a display window or not (as defined in the Building 

Regulations). 
Once the information is entered, click on the “Create Envelopes” button to create the 
envelopes. Once the button has been clicked and the envelopes have been created, the 
contents of the Quick Envelopes tab will be automatically cleared. If you do not wish for the 
contents of the tab to be cleared after the creation of the envelopes, then you need to untick the 
relevant box in the General form > File Options tab > System Configuration (cont.) sub-tab (see 
Section 7.3.1: File Options tab). The box is ticked by default.  

To view the envelopes and windows that you have created, go to the Envelopes Summary sub-
tab (in the Zones tab) and the Windows Summary sub-tab (in the Envelope tab). All the 
envelopes and windows will be available for editing in the main Envelope and Windows tabs.  

NB: The descriptions of the walls remain visible in the Quick Envelopes sub-tab until you clear 
the form (by pressing the “Clear all” button) or close the project. This is so you can use the same 
descriptions to start creating walls for a different zone and hence save time.  

NB: Doors which are more than 50% glazed should be entered into iSBEM as windows, and 
their light and solar characteristics should be entered into the Project Database form > Glazing 
tab. Doors which are 50% or less glazed can be treated as opaque doors. 
 

The parameters that you cannot define in the Quick Envelopes sub-tab include: 
• Thermal bridges for envelope elements or windows - If the envelope or window you have 

created contains any thermal bridges in addition to those already described in the 
Thermal Bridges sub-tab of the Project tab (if the global values are being applied) or the 
Thermal Bridges sub-tab of the Zones tab (it they are not), you will need to go to the 
Envelopes and Windows main tabs, select the record in question, and add the thermal 
bridge manually. (See notes in Section 7.5.2: Project tab regarding thermal bridges.) 

• Shading system - If the window or rooflight has anything but the default for this 
parameter (All other cases), then you will need to go to the Windows & Rooflights main 
tab, select the window in question using the record selector, and change the details 
manually. 

• Transmission factor - If the window or rooflight has anything but the default for this 
parameter (1), then you will need to go to the Windows & Rooflights main tab, select the 
window in question using the record selector, and change the details manually. 
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• Surface area ratio – If the window or rooflight has anything but the default (1 for windows 
and 1.3 for rooflights) for this parameter, you will need to go to the Windows & Rooflights 
main tab, select the window in question using the record selector, and change the details 
manually. 

• Frame factor – If the window or rooflight has anything but the default (0.1 for windows 
and 0.3 for rooflights) for this parameter, you will need to go to the Windows & Rooflights 
main tab, select the window in question using the record selector, and change the details 
manually. 

• Area ratio covered – If the rooflight definition has anything but the default value (1) for 
this parameter, you will need to go to the Windows & Rooflights main tab, select the 
window in question using the record selector, and change the details manually. 

 

Introducing a second envelope element with the same orientation: 
If your zone has, for example, a second west-facing wall, you would need to create one west 
wall, click on the “Clear all” button to remove the information about the first west wall, enter the 
information about the second west wall, and then click on “Create envelopes” again. The tool 
would then add the second west wall to the already created envelopes. 

 

Naming of the envelope elements and windows created in the Quick Envelopes tabs: 
The names are created automatically as described in Chapter 3. 

Figure 47 shows a wall and a window being defined in the Quick Envelopes tab. The example 
wall is a 15 m2, external, south-facing wall, constructed from an External Wall specification that 
had previously been defined in the Project Database form. It has 50% glazing of a type 
previously defined in the Project Database form, and the glazing is not for a display window. 

 

 

 
Figure 47: The Quick Envelopes sub-tab 

Walls 

Global button returning the global default adjacent 
condition associated with (in this case) “External wall”. This 
global default would have been defined in the Project 
Database form when the “External wall” was defined. 

Areas of windows defined by 
entering the area values in 
m2. Percentages can be 
input instead only if the 
relevant box is unticked. 
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Task 12: Create the remaining 12 zones, and define their envelopes and windows using 
Quick Envelopes: 

Details on the remaining twelve zones are given in APPENDIX A:, Table 17.  

To create each new zone, you will need to go back to the General sub-tab of the Zones tab. To 
create a zone’s envelope elements and windows, you need to click on the Quick Envelopes sub-
tab and, making sure that the correct zone is selected using the record selector, define its 
envelopes and windows, and click on “Create Envelopes”. (As this example has excluded 
additional thermal bridges for simplicity, there is no need to go to the Envelopes or Windows & 
Rooflights main tabs afterwards to assign any additional thermal bridges to any envelope 
element or window). 

You should then go to the Envelope Summary sub-tab in the Zones tab to double-check that you 
have defined the envelopes correctly. If you have made any errors, you need to go to the 
Envelopes main tab and select and edit the records there. 

Finally, you need to go to the Window & Door Summary sub-tab in the Envelope tab to double-
check that you have defined the windows correctly. If you have made any errors, you need to go 
to the Windows & Rooflights tab and select and edit the records there.  
 

7.5.9. Using the reports to double-check the data entry 

Apart from the summary sub-tabs already discussed in the previous sections, iSBEM produces 
two Objects reports which can be used to double-check the data you have entered. For details 
on these two reports, see Section 7.9: Double-checking the data. 

 

Task 13: Use the Unassigned Objects report and the Data Summary report to double-
check your data entry 
If you have completed all the tasks up to this point with no errors, you should find that the 
Unassigned Objects Report lists all the zones that you have created listed in the Unassigned 
Building Objects section. 

The Data Summary Report should contain only zone z0/01east (one of the 6 zones already 
defined for you) as this is the only zone that has had its HVAC system selected.  

The following section (the Building Services form) explains how to assign all the remaining zones 
in the Geometry form to an HVAC system. Only then will they appear in the Data Summary 
Report. 

 

7.6. Building Services form 

This form holds all the information relating to the building services. This information is entered 
into 8 main tabs (these are circled in Figure 48): 

• Global and Defaults tab – This tab contains some default information on HVAC systems 
if no or little information is known about the systems in the actual building. It also requires 
information on the electric power factor and lighting controls for the whole building. 

• HVAC systems tab - This tab requires information on the HVAC systems in the building. 
• HWS tab - This tab requires information on the hot water systems in the building. 
• SES tab - This tab requires information on any solar energy systems connected to the 

hot water systems in the building, if applicable. 
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• PVS tab – This tab requires information on any photovoltaic systems connected to the 
building, if applicable. 

• Wind generators tab – This tab requires information on any wind generators connected 
to the building, if applicable. 

• CHP generator tab (this tab only appears when one of the HVAC systems described in 
the HVAC Systems tab is specified as using CHP) – This tab requires information on any 
combined heat and power generators connected to the building. 

• Zones tab – This is where you assign the appropriate HVAC system and HWS to each 
zone and input details on the zones’ lighting and specific ventilation strategy. 

 

 
Figure 48: The eight tabs in the Building Services form 

 

7.6.1. Global and Defaults tab 

In this tab, there are two sub-tabs:  

• HVAC System Defaults sub-tab - This sub-tab is visible only if BER generation is 
selected as the “Purpose of Analysis" in the General form > General Information tab > 
Project Details sub-tab. 

• Project Building Services sub-tab  

 

HVAC System Defaults sub-tab: 

This sub-tab is visible only if BER generation is selected as the “Purpose of Analysis" in the 
General form > General Information tab > Project Details sub-tab. If no HVAC system serves the 
space (i.e., an unconditioned zone), you should select the option  ‘Zones without HVAC system’ 
as the HVAC system for that zone in the Geometry form > Zones tab > General sub-tab (spaces 
which have no heating or cooling, e.g., plant rooms, storage spaces, exposed circulation 
spaces). If you do not know the type of the HVAC system in your building or its detailed 
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parameters, you should instead select one of the following default options from the drop-down 
menu (see Section 7.5.3: Defining zones – Zones tab): 

• ‘Heating only - Electric resistance’ - Heat generated by passing current through 
resistance wire. Assumed to be electric central heating system with warm air 
distribution. Fan storage heaters and electric fan converters should be input by 
defining an HVAC system in the Building Services form > HVAC Systems tab > 
General sub-tab and selecting the system type "Other local room heater - fanned". If 
you do not know the heating method (i.e., whether a heated-only building uses 
electricity or a fuel-based heating system), you should select electric resistance 
heating as your default. 

• ‘Heating only - Other systems’ - Assumed to be wet radiator system, heat generated 
by fuel combustion. Pumps assumed to be powered by grid-supplied electricity. If 
you know the fuel type used by the heating system, you can define it in this sub-tab 
(Figure 48). 

• ‘Heating and mechanical cooling’ - Assumed to be constant volume air system with 
terminal reheat and fixed fresh air. Refrigeration (chillers), fans, and pumps assumed 
to be powered by grid-supplied electricity. If you know the fuel type used by the 
heating system, you can define it in this sub-tab (Figure 48). 

NB: The default HVAC systems available in iSBEM are representative of existing rather than 
new buildings and should only be used if you do not know the type of the HVAC system in your 
building or its detailed parameters as the default efficiencies assumed by iSBEM for these 
systems are quite pessimistic and cannot be edited by the user. 

 

Project Building Services sub-tab: 
In this sub-tab, you need to enter details about the electrical power factor and the controls 
provisions for lighting in the building as shown in Figure 49: 
Controls provision for lighting systems 

1. Is the lighting separately sub-metered? If you select “Yes”, the following question 
becomes active: 

o M&T with alarm for “out of range” values? – This refers to monitoring and 
targeting as a means of identifying changes in operation or onset of faults. 

If the answer is “Yes” to both of these questions, a 5% controls correction is applied to 
the lighting load of the building. 

Building Details 
1. Electric power factor – This is a measure of the actual electric power consumption to that 

usually measured by the electric meter (results from the voltage and current variations 
being out of phase). Select from: ‘<0.9’, ‘0.9-0.95’, and ‘>0.95’. 

District Heating Parameters 
2. Do you know the CO2 conversion factor of the district heating network? – This parameter 

is active only if ‘District Heating’ is selected as the heat source and fuel type for any of 
the HVAC systems defined in the building. If you select “Yes”, then you can enter the 
value in kgCO2/kWh. Otherwise, a default value will be used. 

NB: The CO2 emission factor for district heating should reflect the average annual efficiency and 
fuel mix of the whole district heating system. It should include all heat generating plant, including 
any CHP, any waste heat recovery or heat dumping, the effect of heat losses in distribution 
(external to the building), the emissions from electricity used for pumping, and any other relevant 
carbon dioxide emissions. The CO2 emission factors for the fuel(s) used by district heating 
should be those specified in the Building Regulations approved documents. Submissions for 
Building Regulations compliance and the evidence collected by the energy assessors should 
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include a report signed by a suitably qualified person, detailing how the emission factor for 
district heating has been derived. 

NB: Guidance for calculating the CO2 emission factor for district heating schemes 
supplied by Combined Heat and Power only systems (CHP): For CHP systems, the overall 
CO2 emission factor is the CO2 emission factor of the fuel divided by the overall efficiency of the 
CHP plant. If more than one fuel is used, an average figure is calculated according to the 
guidance for bivalent systems (see section 7.6.2: Defining HVAC Systems – HVAC Systems 
tab). This will need to be apportioned between heat and electricity. A suitable method for use in 
connection with calculations for the purposes of Building Regulations compliance and Asset 
Rating calculations for non-domestic buildings is to use the following equationsix. 

OEF = Overall CO2 emission factor as defined above 

HPR = the heat to power ratio over the whole year 

CO2 emission factor for heat: = OEF x (HPR + 1) / (2.5 + HPR) 

CO2 emission factor for electricity: = OEF x (HPR + 1) / (0.4 + HPR)  

 
3. Do you know the primary energy conversion factor of the district heating network? – This 

parameter is active only if ‘District Heating’ is selected as the heat source and fuel type 
for any of the HVAC systems defined in the building. If you select “Yes”, then you can 
enter the value in kWh/kWh. Otherwise, a default value will be used. 

NB: The primary energy factor for district heating should take into account all heat generating 
plant, including any CHP, any waste heat recovery or heat dumping, the effect of heat losses in 
distribution (external to the building), the electricity used for pumping, and any other relevant 
energy used. Guidelines for the calculation of the primary energy factor of a district heating 
scheme can be found in the EN standard EN 15316-4-5. The primary energy factors for the fuels 
and electricity used in the calculations should be those given in national regulations. 
Submissions for Building Regulations compliance and the evidence collected by the energy 
assessors should include a report signed by a suitably qualified person, detailing how the 
primary energy factor has been derived.   

 

                                                
ix These apply the method recommended in C. Pout, R. Hitchin, Apportioning Carbon emissions from 
CHP Systems, Energy Conversion and Management 46(2005) using the CO2 emission factors for 
natural gas and grid-displaced electricity from the Approved document L2A. 
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Figure 49: Project Building Services sub-tab of the Global and Defaults tab in the Building 

Services form 

 

7.6.2. Defining HVAC Systems – HVAC Systems tab 

Overview of how to model HVAC Systems 
The building’s HVAC system(s) is defined within the first six sub-tabs of the HVAC systems tab. 

• General sub-tab: This is where you select the system type, give it a unique name, and 
enter some basic system details for each HVAC system in the building. 

• Heating sub-tab: This is where you can further define the heat generator efficiency. 
• Cooling sub-tab: This is where you can further define the cold generator efficiency. 
• Systems Adjustments sub-tab: This is where details on air leakage and specific fan 

power can be entered. 
• Metering Provision sub-tab: This is where details of the metering provision for the 

HVAC system can be defined. 
• System Controls sub-tab: This is where heating system controls can be defined. This 

sub-tab is visible only if ‘Republic of Ireland: Building Energy Rating’ is selected as the 
“Purpose of Analysis" in the General form > General Information tab > Project Details 
sub-tab. 

• Zone Summary sub-tab: This tab displays a summary of the zones assigned to the 
HVAC system, along with the zones’ envelopes, windows, and doors. 

. 

The System type selected in the General sub-tab automatically brings with it some 
assumptions. For example, whether mechanical ventilation is an integral part of the system and 
the degree of local time and temperature control that is (or can be) provided. The majority of 
commonly used system types can be found in the system type drop-down box. However, there 
are a few systems which require further guidance, such as: 
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• VRF with natural ventilation – Select ‘Split or multi-split system’, and then adjust the 
efficiencies in the Heating and Cooling sub-tabs to values suitable for the VRF. 

• VRF with mechanical ventilation – Select ‘Split or multi-split system’, and then adjust the 
efficiencies in the Heating and Cooling sub-tabs to values suitable for the VRF, and 
define mechanical ventilation at zone level. 

• If ‘Chilled ceiling’ is selected, the default assumption is that there is displacement 
ventilation.  

o Chilled ceiling with no mechanical ventilation – Select ‘Chilled ceilings or passive 
chilled beams and displacement ventilation’, and then set the specific fan power 
to zero. 

o Chilled ceiling with mixing ventilation – Select ‘Chilled ceilings or passive chilled 
beams and displacement ventilation’, and then use twice the actual specific fan 
power in order to capture the effect of the higher ventilation rate. 

• If your HVAC system is a high velocity forced-convection air heating (induction nozzle 
system), which does the job of mixing the air in the zone in a similar manner to 
destratification fans, then you can model this in iSBEM by first selecting the appropriate 
HVAC system type (flued or unflued) and then ticking the above box relating to 
destratification fans in the zones served by that system. The system should follow the 
flow rate guidelines given for destratification systems shown below. You will then need to 
justify this to Building Control using the necessary documentation for your system's 
functions.  

NB: Destratification may be achieved by several means, for each of which minimum flow 
rates should be ensured. (Where destratification and heating is provided by the same 
system, higher flow rates may be needed to avoid excessive air supply temperatures): 

• Cased fans installed at high level. The volume of air handled by the fans should be at 
least equivalent to two room volumes per hour. Total air movement will be higher than 
this because additional airflow will be induced. 

• Open blade “sweep fans”. In this case, air speeds will be lower and the volume of air 
handled should be at least the equivalent of 6 room volumes per hour. 

• High velocity induction nozzles with a temperature rise through the heater of at least 
45˚C. The volume of primary air from the nozzles should be at least equivalent to 0.15 
room volumes per hour. Total air movement will be significantly higher because of the 
additional airflow induced by the nozzles. 

The system type, along with the further details entered in the remaining four HVAC sub-tabs, 
allow SBEM to calculate the System Seasonal Efficiency for heating (SSEFF), the System 
Seasonal Energy Efficiency Ratio for cooling (SSEER), and the Auxiliary Energy. For further 
details on these parameters and how they are calculated, see the Non-Domestic HVAC 
Compliance Guidex. 

SSEFF – The System Seasonal Efficiency for heating takes account of the seasonal efficiency of 
the heat generator, thermal losses and gains to and from pipework and ductwork, and duct 
leakage. It does not include the energy used by fans and pumps. The combined heating demand 
of all zones served by a particular system divided by its SSEFF gives the energy consumption of 
the heating system (For example, a boiler or boilers). 

SSEER – The System Seasonal Energy Efficiency Ratio for cooling takes account of the 
seasonal efficiency of the cold generator, thermal losses and gains to and from pipework and 
ductwork, and duct leakage. It does not include the energy used by fans and pumps. The 
combined cooling demand of all the zones served by a particular system divided by its SSEER 
gives the energy consumption of the cooling system (For example, a chiller). 

                                                
x The Non-Domestic Heating, Cooling, and Ventilation Compliance Guide published by the CLG. 



106                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

Auxiliary Energy – This is applied to the total floor area conditioned by a particular system. It 
depends on the duration of occupation and operation in the zones served, and it covers the 
energy used by fans, pumps, and controls. The calculation depends on the HVAC system type 
selected, as well as on other information provided by the user on the SFP, duct and AHU 
leakage, and control provision. 

If no HVAC system serves the space (i.e., an unconditioned zone), you should select the option  
‘Zones without HVAC system’ as the HVAC system for that zone in the Geometry form > Zones 
tab > General sub-tab (spaces which have no heating or cooling, e.g., plant rooms, storage 
spaces, exposed circulation spaces.). If you do not know the type of the HVAC system in your 
building or its detailed parameters, you should instead select one of the following default options 
from the drop-down menu (see Section 7.5.3: Defining zones – Zones tab): 

• ‘Heating only - Electric resistance’ - Heat generated by passing current through 
resistance wire. Assumed to be electric central heating system with warm air 
distribution. Fan storage heaters and electric fan converters should be input by 
defining an HVAC system in the Building Services form > HVAC Systems tab > 
General sub-tab and selecting the system type "Other local room heater - fanned" 
(see below). If you do not know the heating method (i.e., whether a heated-only 
building uses electricity or a fuel-based heating system), you should select electric 
resistance heating as your default. 

• ‘Heating only - Other systems’ - Assumed to be wet radiator system, heat generated 
by fuel combustion. Pumps assumed to be powered by grid-supplied electricity. If 
you know the fuel type used by the heating system, you can define it in this sub-tab 
(Figure 48). 

• ‘Heating and mechanical cooling’ - Assumed to be constant volume air system with 
terminal reheat and fixed fresh air. Refrigeration (chillers), fans, and pumps assumed 
to be powered by grid-supplied electricity. If you know the fuel type used by the 
heating system, you can define it in this sub-tab (Figure 48). 

NB: The default HVAC systems available in iSBEM are representative of existing rather than 
new buildings and should only be used if you do not know the type of the HVAC system in your 
building or its detailed parameters as the default efficiencies assumed by iSBEM for these 
systems are quite pessimistic and cannot be edited by the user. 

 
General sub-tab: 
The General sub-tab is shown in Figure 50. For each HVAC system in your building, you will 
need to create a new record and add the following information: 

1. Name – A unique name must be given to each HVAC system. 

NB: Note that the ‘Multiplier’ field no longer exists for HVAC systems (or HWS. If you convert 
project files created with previous versions of the tool, where this field had a value of more than 
1, corresponding multiples of the zones served by that HVAC system are created. 

2. System type – Here, you can currently choose between 26 system types (11 heating only 
systems and 15 heating and cooling systems), including, for e.g., VAV (variable air 
volume), fan coil, dual duct, and central heating with water distribution (see Table 13 for 
brief definitions of the system types). 

NB: In order to ensure adequate ventilation for maintaining the concentration of CO2 below 0.5% 
in spaces served by unflued heating appliancesxi, the zonal ventilation option for these spaces 
should be set to ‘mechanical’ (See section 7.6.8: Defining the zone specific building services).  

NB: In iSBEM version v2.0.b, changes have been made to the HVAC system options. “Variable 
refrigerant flow” (VRF) systems and “Split or multi-split system with ventilation” systems have 
                                                
xi For details, please refer to BS 5925:1991: Code of Practice for Ventilation Principles and Designing 
for Natural Ventilation. 
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been removed from the options available in iSBEM for HVAC system types, and for these 
systems, users should now select "Split or multi-split system", with a suitable efficiency. This 
change was made in order to simplify the HVAC system options (multisplit can be used for VRF 
as VRF is a type of split/multisplit system) and in order to remove ventilation from HVAC 
systems where the ventilation is not an integral part of the system heating/cooling strategy. 
Using v2.0.b or later, if these systems are accompanied by mechanical ventilation, mechanical 
ventilation should now be defined at zone level with a suitable ventilation SFP. 

NB: Zonal ventilation is no longer available for fan coil units. Ventilation for this HVAC type is 
defined at HVAC level. See note after System Adjustments sub-tab, regarding specific fan power 
for fan coil systems.  

NB: See note in Section 7.6.8: Defining the zone specific building services, regarding defining 
high velocity forced-convection warm air heaters. 

NB: If there is more than one type of HVAC system in a space with each system clearly 
meant to service a particular part of the space, e.g., one servicing the facade perimeter area and 
another servicing the core area, then the space should be divided into 2 separate zones in 
iSBEM (each served by its corresponding HVAC system) even if there is no physical separation 
between the 2 zones. However, if heating is provided in the same zone by two, or more, different 
types of heat sources, for e.g., a heat pump in a split system and a gas boiler in a wet system, 
you need to calculate (and enter into iSBEM) a seasonal heat generating efficiency which is 
equivalent to both these heat sources based on their respective efficiencies, fuel types, and 
loads, as described in the guidance on the bivalent calculation later in this section. On the other 
hand, if a zone is served by, for e.g., a gas-fired wet system for heating and an electric split 
system for cooling only, then the systems can be approximated in SBEM by defining your HVAC 
system type as "split or multisplit", the heat source as "LTHW boiler", and fuel type as "natural 
gas", and then define the appropriate seasonal efficiency for the heating and energy efficiency 
ratio for the cooling. SBEM will use natural gas for the heating and grid-supplied electricity for 
the cooling. If applicable, you then need to define the mechanical ventilation at zone level (for all 
the zones served by this system) with a suitable ventilation SFP, and heat recovery. 

If you change the HVAC system type defined in your project from one that provides 
mechanical ventilation to one that does not (or vice versa), you must re-visit the 
Ventilation sub-tab of the Zones tab in the Building Services form for all the zones served 
by this HVAC System in order for all ventilation-related parameters to be updated by the 
tool. You may also wish to re-define whether the ventilation is natural or mechanical in 
these zones following the change in the HVAC type (see Section 7.6.8: Defining the zone 
specific building services- Zones tab). 
 

Heating system: 

3. Heat source – Depending on the system type selected, a selection of heat sources is 
offered. For example, if ‘Single-duct VAV’ is selected, you need to choose between: 
LTHW boiler, MTHW boiler, HTHW boiler, Direct or storage electric heater, Heat pump: 
air source, Heat pump: ground or water source, and District heating. 

4. Fuel type – Depending on your selected heat source, you will be given a selection of fuel 
types to choose from, for e.g., Natural gas, LPG, Oil, Grid-supplied electricity. 

5. Tick if this system also uses CHP (tick box) – This tick box appears if the system type 
selected can use CHP. If it is ticked, a new tab appears, CHP generator, where further 
details are required to describe the CHP facility. If the box is not ticked, the tab does not 
appear. 

Cooling system: 

6. Generator type - If appropriate to your choice of system, you will be given the option to 
select a cooling generator type from the drop-down list: Air cooled chiller, Water cooled 
chiller, Remote condenser chiller, Heat pump (gas/oil), or Heat pump (electric). 
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Ventilation: 

7. Heat recovery – Depending on the system type, this ventilation characteristic needs to be 
selected from: No heat recovery, Plate heat exchanger (Recuperator), Heat pipes, 
Thermal wheel, and Run around coil.  

 
Option Brief Definition 
No heat recovery  No heat recovery system 
Plate heat exchanger 
(Recuperator)  

Recuperators usually take the form of air-to-air plate heat exchangers 

Heat pipes  The heat-pipe is a passive heat exchanger of which there are two main 
types:  
• horizontal - in which a wick within the tubes transfers liquid by 

capillary action    
• vertical - in which heat from the warmer lower duct is transferred to 

the cold upper duct by means of a phase change in the refrigerant. 
Thermal wheel  A thermal wheel comprises a cylinder packed with a suitable heat transfer 

medium that rotates slowly within an airtight casing which bridges the 
ducts between which heat is to be transferred. 

Run around coil Finned air-to-water heat exchangers are installed in the ducts between 
which the heat is to be transferred. A pumped water or water/glycol (for 
freeze protection) circuit is used to transfer heat from the warm extract air 
to the cooler supply air (or vice versa in summer) 

Table 12: Definitions of heat recovery options in iSBEM 

 

8. Heat recovery seasonal efficiency - This parameter is active if a heat recovery system is 
selected, i.e., the previous parameter is not set to ‘No heat recovery’. If you know the 
heat recovery efficiency, it can be introduced manually into the interface. Otherwise, a 
default value will be used by SBEM.  

NB: If the SFP was calculated or measured for a mechanical ventilation system that already 
included heat recovery, then that is the value you enter into iSBEM. If the SFP was calculated or 
measured for a mechanical ventilation system before a heat recovery system was added on, 
then you need to add 0.15 to the SFP for a thermal wheel system, and 0.3 for any of the other 
heat recovery options in iSBEM, to account for the additional resistance.  
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Figure 50: HVAC system definition, General sub-tab 

 
System Type in iSBEM Brief Definition 
Central heating using water: radiators Central heat generator(s) with water distribution and 

radiators 
Central heating using water: convectors Central heat generator(s) with water distribution and 

convectors 
Central heating using water: floor 
heating 

Central heat generator(s) with water distribution and 
floor heating 

Central heating with air distribution Central heat generator(s) with air distribution 
Other local room heater - fanned Includes gas fires, gas convectors, direct electric 

heaters, electric storage heaters that are provided 
with fans. Larger units above about 10kW such as 
"cabinet heaters" or "unit heaters" should be classed 
as "forced convection air-heaters" 

Other local room heater - unfanned Includes gas fires, gas convectors, direct electric 
heaters, electric storage heaters that do not have 
fans  

Unflued radiant heater Luminous or non-luminous overhead radiant heater 
without flue. Includes electric overhead radiant 
heaters 

Flued radiant heater Luminous or non-luminous overhead radiant heater 
with flue 

Multiburner radiant heaters Overhead multiburner radiant heater 
Flued forced-convection air heaters May have fan to assist transportation of combustion 

air and/or combustion products. The 'Auxiliary 
energy for fanned warm air heaters' parameter 
becomes active within the System Adjustment sub-
tab 



110                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

Unflued forced-convection air heaters "Direct" gas heaters. The 'Auxiliary energy for fanned 
warm air heaters' parameter becomes active within 
the System Adjustment sub-tab. Note that provision 
for adequate ventilation must be provided 

Single-duct VAV An all-air system in which the volume of supply air is 
modulated to match the cooling demand. May have 
reheat capability. Assumed to also provide heating, 
possibly also with separate perimeter heating system 

Dual-duct VAV A VAV system with separate supply of hot and cold 
air. Assumed to also provide heating, possibly also 
with separate perimeter heating system 

Indoor packaged cabinet (VAV) Local cooling/heating unit. May supply air directly 
into room, into under floor void, or into ceiling void.  
May have terminal units with variable local 
recirculation rate. May have electrical trim heater. 
Volume of air handled is sufficient to handle all the 
cooling load. Assumed to also provide heating, 
possibly also with separate perimeter heating system 

Fan coil systems Local fanned terminal units in ceiling, on wall or on 
floor, with a central chilled water supply.  Systems 
may be 2-pipe, 3-pipe or 4-pipe, changeover or non-
changeover - no distinction is made here. Assumed 
to also provide heating. Zonal ventilation is no longer 
available for fan coil units. Ventilation for this HVAC 
type is defined at HVAC level.  

Induction system Air is supplied from a central unit, commonly at high 
pressure. This induces a secondary airflow within the 
terminal unit to achieve an acceptable delivery 
temperature. Final heating or cooling is provided by 
heat exchangers within the terminal. Systems may 
be 2-pipe, 3-pipe or 4-pipe, changeover or non-
changeover - no distinction is made here. Assumed 
to also provide heating. 

Constant volume system (fixed fresh air 
rate) 

An all-air system in which the volume of supply air is 
fixed. Assumed to also provide heating, possibly also 
with separate perimeter heating system. If provided 
with local reheat capability, use the "Terminal reheat 
(constant volume)" system. This category includes 
packaged rooftop units. 

Constant volume system (variable fresh 
air rate) 

Constant volume system in which the proportion of 
fresh air can be varied to limit chiller operation ("free 
cooling economiser"). 

Multizone (hot deck/cold deck) A central air handling unit has separate hot and cold 
decks. Mixing takes place at the Air handling unit 
and air is supplied to each zone through a single 
duct per zone. Assumed to also provide heating, 
possibly also with separate perimeter heating 
system. 

Terminal reheat (constant volume) Cooled air is supplied centrally and reheated locally 
to the desired supply temperature for each zone. 
Assumed to also provide heating, possibly also with 
separate perimeter heating system. 

Dual duct (constant volume) Hot and cold air are distributed separately - 
commonly at high pressure - and locally mixed to 
provide the desired supply temperature for each 
zone. Assumed to also provide heating, possibly 
also with separate perimeter heating system. 
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Chilled ceilings or passive chilled 
beams and displacement ventilation 

The combination of a chilled ceiling (or passive 
chilled beam) system with a separate low-level, low 
volume supply of cooled ventilation air. Heating 
assumed to be by separate LTHW system. The 
default assumption is that there is displacement 
ventilation.  

Active chilled beams Chilled beams which include the provision of cooled 
air from a central source, typically operating as an 
induction system. May include local fans. Heating 
assumed to be by separate LTHW system. 

Water loop heat pump Local heat pumps are served by a common water 
circuit to or from which they can reject or extract 
heat. Central cooling and heating plant provides the 
net heat or cooling input to this circuit. Assumed to 
also provide heating. 

Split or multi-split system Combination of outdoor and indoor units connected 
by refrigerant pipe work. No mechanical ventilation 
system. Use this category also for ducted split 
systems and window/wall units. The SEER/SCoP 
should include the power consumption for 
compressors, controls, as well as fans and pumps 
within the air-conditioning units. 

Single room cooling system Integral units without ducting, such as wall or window 
units. Ducted units should be defined as constant or 
variable volume air systems, as appropriate. The 
SEER/SCoP should include the power consumption 
for compressors, controls, as well as fans and 
pumps within the air-conditioning units. 

Table 13: Definitions of HVAC type options in iSBEM 

 
Heating sub-tab: 
Once you have entered the basic information on each HVAC system into the General sub-tab, 
there are a few more details on the heating efficiency which can be entered, if they are known. 
You will see that the ‘Heat Source’ and ‘Fuel Type’ fields that were completed in the General tab 
also appear in this tab (they can be edited in either tab). 

First, you need to select the HVAC system with the record selector, and then the following 
information can be entered: 

Heating System 

1. Heat source – Depending on the system type selected, a selection of heat sources is 
offered. For example, if ‘Single-duct VAV’ is selected, you need to choose between: 
LTHW boiler, MTHW boiler, HTHW boiler, Direct or storage electric heater, Heat pump: 
air source, Heat pump: ground or water source, and District heating. 

2. Fuel type – Depending on your selected heat source, you will be given a selection of 
heating fuel types to choose from, for e.g., Natural gas, LPG, Oil, Grid-supplied 
electricity. 

3. Tick if this heating system uses variable speed pumps (tick box) – This tick box appears 
only if the system type selected is central heating using water. If it is ticked, variable 
speed pumping will be considered during the calculation of the auxiliary energy.  

4. Effective heat generating seasonal efficiency - If you know the effective heat generating 
seasonal efficiency for the heat generator, it can be introduced manually into the 
interface. Otherwise, a default value will be used by SBEM.  

Further 
guidance 

Further 
guidance 
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NB: The Effective Heat Generating Seasonal Efficiency is calculated by adding the Heating 
Efficiency Credits, where applicable, to the Heat Generator Seasonal Efficiency. The Heat 
Generator Seasonal Efficiency is the ratio of the useful heat output to the energy input over the 
heating season. The Heating Efficiency Credits are available for additional controls and other 
measures that go beyond the required minimum controls package. Details of the minimum 
controls packages for the different systems, additional controls, and corresponding available 
credits are in the Non-Domestic Heating, Cooling, and Ventilation Compliance Guide published 
by CLGxii. Note that the necessary documentation to support the efficiency calculation may be 
required by Building Control.  

• The default value is based on whether the generator is on the Energy 
Technology List (ETL) of the ‘Enhanced Capital Allowance’ (ECA) schemexiii. If 
not, you then need to select whether the generator was installed in or after 1998. 

NB: For boiler systems installed from 1998 onwards, a default seasonal efficiency of 
0.81 is suggested by the tool (based on Statutory Instrument 1994 No. 3083), and for 
boiler systems installed before this period, a conservative default seasonal efficiency of 
0.65 is suggested. Please note that from around 1989, the boiler industry began 
producing boilers with efficiencies that would have complied with the above statutory 
instrument. 

2. Generator radiant efficiency (this parameter is active if the HVAC system chosen is a 
radiant system) - It refers to the ratio of radiant heat output to energy input. If you know 
the generator’s radiant efficiency, it can be introduced manually into the interface. 
Otherwise, a default value will be used by SBEM.  

• The default value is based on whether or not the generator is on the Enhanced 
Capital Allowance (ECA) list. 

Figure 51 shows a heating system being defined.   

 
Figure 51: HVAC systems definition, Heating sub-tab 

                                                
xii Available from (http://www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_NONDOMHEAT.pdf) 
xiii www.eca.gov.uk/etl/  

http://www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_NONDOMHEAT.pdf
http://www.eca.gov.uk/etl/
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NB: Defining a bivalent system in iSBEM: A bivalent heating system is one in which the 
heating is supplied by two different types of heat sources. An example could be a heat pump 
with a gas boiler for backup. Within iSBEM, a fuel type and a seasonal efficiency have to be 
input in order for the SBEM calculation to produce the overall CO2 emissions per kWh of the total 
heating provided by the two heat sources. First, the proportion of the heating demand met by 
each heat generator needs to be estimated, in a manner that can be justified to Building Control. 
Then, an efficiency equivalent to the 2 systems based on their respective loads, efficiencies, and 
emission factors (obtained from the Building Regulations approved documents) needs to be 
calculated. Even if the calculated equivalent efficiency figure in this case is over 100%, this is 
just an artificial value for a "virtual" boiler needed to produce the correct carbon emissions in the 
SBEM calculation. If gas is not used in the building, the heating fuel should be defined as oil and 
the corresponding emission factor for oil is to be used in calculating the equivalent efficiency. 
Therefore, for example, if a heating system uses a heat pump of COP 3 providing 75% of the 
annual heating demand, and the remaining 25% of demand is met by a natural gas boiler of 85% 
efficiency (the CO2 emission factor for grid-supplied electricity is 0.643 kgCO2/kWh and for 
natural gas is 0.203 kgCO2/kWh), the heating fuel type is entered as natural gas into iSBEM, and 
the equivalent efficiency can be calculated as follows: 
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Cooling sub-tab:  

In addition to the information entered in the General sub-tab, you can define the power rating 
and efficiency of the cooling system. If they are not known, default values will be used by the 
software. The information is entered as follows: 

Cooling System 

1. Generator type - If appropriate to your choice of system, you will be given the option to 
select a cooling generator type from the drop-down list: Air cooled chiller, Water cooled 
chiller, Remote condenser chiller, Heat pump (gas/oil), or Heat pump (electric). 

2. Generator kW – This is the cooling generator’s nominal electrical power, and if 
applicable, it needs to be selected from: Up to 100kW, 101 to 500kW, 501 to 750kW, and 
751 to 3.5MW. This field is not active if the cooling generator type selected is Heat pump 
(gas/oil), or Heat pump (electric). 

3. Fuel type – Depending on your selected cooling generator type, you will be given a 
selection of cooling fuel types to choose from, for e.g., Natural gas, LPG, Biogas, Oil, or 
Grid-supplied electricity. 

4. Seasonal energy efficiency ratio - If you know the seasonal energy efficiency ratio 
(SEER) for the cooling generator, it can be introduced manually into the interface. 
Otherwise, a default value will be used by SBEM. (Guidance on the calculation of the 
seasonal energy efficiency ratio can be found in the Non-Domestic HVAC Guide 
published by CLG.) 

• The default value is based on whether or not the chiller or air-conditioner is on 
the Enhanced Capital Allowance (ECA) list. 
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5. Nominal energy efficiency ratio - If you know the nominal energy efficiency ratio (EER) 
for the cooling generator, it can be introduced manually into the interface. Otherwise, a 
default value will be used by SBEM for compliance checking. (Guidance on the nominal 
energy efficiency ratio can be found in the Non-Domestic HVAC Guide published by 
CLG.) 

• The default value is based on whether or not the chiller or air-conditioner is on 
the Energy Technology List of the ‘Enhanced Capital Allowance’ (ECA) scheme. 

NB: The cooling generator seasonal energy efficiency ratio is the value used within SBEM to 
calculate the cooling energy while the cooling generator nominal energy efficiency ratio is the 
value used for compliance checking with the limiting standards from the HVAC compliance 
Guide (compliance checking is not yet applicable in iSBEM version 3.5.b for the Republic of 
Ireland). 

6. Tick box to indicate if the HVAC system has mixed mode operation strategy. 

NB: “Mixed-mode” refers to a hybrid approach to space conditioning that uses a combination of 
natural ventilation from operable windows, and mechanical systems that include air distribution 
equipment and refrigeration equipment for cooling. A mixed-mode building integrates the use of 
air-conditioning when and where it is necessary, with the use of natural ventilation whenever it is 
feasible or desirable, to maximize comfort while reducing the energy use (compared to year-
round air conditioning). 

Figure 52 shows a cooling system being defined. 

 

 
Figure 52: HVAC systems definition: Cooling sub-tab 

 

System Adjustments sub-tab: 

The System Adjustments sub-tab (Figure 53) allows the user to specify other system properties, 
such as, the air leakage associated with the ducts or the air handling unit (AHU) and the specific 
fan power (SFP). If this information is not known, default values will be used by the software.  
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NB: These default values reflect past practices and may not be compliant with the current 
Building Regulations. 

The information is entered as follows: 

Ductwork and AHU Leakage 

1. Ductwork leakage – If the ductwork has been tested or design targets set for the building, 
the appropriate CEN classification for air leakage can be entered by clicking on the radio 
button “Yes, it meets the CEN leakage classification below” and choosing from the drop-
down list between: Class A, Class B, or Worse than Class A. Different classes refer to 
the maximum air leakage obtained for the HVAC ductwork at different test conditions. 

2. AHU leakage – Similarly, if the AHU has been tested or design targets set for the 
building, click on the appropriate radio button and choose from the drop-down list 
between: L1, L2, L3, or Worse than L3. 

Specific Fan Power for the System 

3. Specific Fan Power (SFP) – The SFP of an air distribution system is defined as the sum 
of the design total circuit-watts, including all losses through switchgear and controls such 
as inverters, of the fans in the system that supply air and extract it back outdoor (i.e. the 
sum of the total circuit-watts of supply and extract fans), divided by the design air flow 
rate through the system. For further details on the SFP and how it is calculated, see the 
Non-Domestic HVAC Compliance Guide. If the SFP for the system is known, it can be 
entered manually. Otherwise, the software will insert a default value.  

NB: The default value does not comply with the 2006 Building Regulations and should be 
changed for new buildings.  

NB: If the SFP was calculated or measured for a mechanical ventilation system that already 
included heat recovery, then that is the value you enter into iSBEM. If the SFP was calculated or 
measured for a mechanical ventilation system before a heat recovery system was added on, 
then you need to add 0.15 to the SFP for a thermal wheel system, and 0.3 for any of the other 
heat recovery options in iSBEM, to account for the additional resistance.  

NB: Zonal ventilation is no longer available for fan coil units. Ventilation for this HVAC type is 
defined at HVAC level. The auxiliary energy figures for fan coil systems include an allowance for 
the fans in the units (there is a minimum acceptable performance figure in the HVAC guide of 0.8 
W/(l/s) based on the average of all fan coils). Hence, if the fan coil system is selected as the 
HVAC system, the SPF input by the user should be for the central plant, and the fan coil 
allowance will be included automatically. 

If the type of HVAC system selected in the General sub-tab is a fanned warm air heater (flued or 
unflued), then the following parameter becomes active: 

Auxiliary Energy for Fanned Warm Air Heaters 

4. Auxiliary energy for fanned warm air heaters - If the auxiliary energy ratio (auxiliary 
energy in kWh per kWh of heating energy) for the system is known, it can be entered 
manually. Otherwise, the software will use a default value. 
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Figure 53: HVAC systems definition: System Adjustments sub-tab 

 

Metering Provision (renamed from Control Corrections) sub-tab: 
The software also considers the effect of metering and alarms on system operation. (Controls 
assumptions are largely determined by the system choice). There are just 2 questions to answer 
here (see Figure 54): 

Controls Provision 

1. Is this HVAC system separately sub-metered? - This refers to either energy metering of 
plant, and/or metering of plant hours run, and/or monitoring of internal temperatures in 
zones. If you click “Yes, it is”, the following question becomes active: 

a. M&T with alarm for “out of range” values? – This refers to monitoring and 
targeting as a means of identifying changes in operation or onset of faults. 

If the answer is “Yes” to both of these questions, a 5% controls correction is applied to 
the energy consumption of the system in question. 

NB: If you have more than one HVAC system defined in your project, the Metering Provision 
sub-tab will be available for each one of them, i.e., each HVAC system can be separately sub-
metered. 
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Figure 54: HVAC systems definition: Metering Provision sub-tab 

 

System Controls sub-tab: 
The software also needs to know if you have certain controls in your heating system, which 
would be considered during the production of the energy efficiency recommendations to 
accompany the BER certificate. This sub-tab is visible only if ‘Republic of Ireland: Building 
Energy Rating’ is selected as the “Purpose of Analysis" in the General form > General 
Information tab > Project Details sub-tab. There are 5 tick boxes in this sub-tab (see Figure 55): 

Heating System Controls 

1. Tick box to indicate whether the heating system has central time control. 

2. Tick box to indicate whether the heating system has optimum start/stop control. 

3. Tick box to indicate whether the heating system has local time control (i.e., room by 
room). 

4. Tick box to indicate whether the heating system has local temperature control (i.e., room 
by room). 

5. Tick box to indicate whether the heating system has weather compensation control. 

 
NB: The HVAC system controls defined in the System Controls sub-tab are used by SBEM only 
for generating the EPC Recommendations for the Recommendations Report and do not affect 
the actual energy calculations or the input value for the system efficiency. 

NB: If you have more than one HVAC system defined in your project, the System Controls sub-
tab will be available for each one of them, i.e., each HVAC system can have control definitions 
different from the others. 
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Figure 55: HVAC systems definition: System Controls sub-tab 

 

Zone Summary sub-tab: 
The names of the zones assigned to the HVAC system can be viewed in the Zone Summary 
sub-tab of the HVAC Systems tab, shown in Figure 56. The zones are listed in the left hand side 
window, and if any of the zones are highlighted, more details about that zone appear in the 
‘Zone’s properties’ window. For example, details such as the zone’s area and activity are 
displayed. 
 

Task 14: Define the HVAC system for the Example building: The details on the HVAC 
system can be found in Section A.2: Systems. If you click into the HVAC systems tab, you will 
see that the HVAC system for the Example building has been named for you: “HVAC system for 
the Example building”. You need to go through each of the sub-tabs in the HVAC Systems main 
tab in turn, entering the information provided in APPENDIX A:. 
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Figure 56: HVAC systems tab: Zone Summary sub-tab 

 

7.6.3. Defining HWS – HWS tab 

The HWS tab has three sub-tabs: 
• General sub-tab: This is where the Hot Water System generator, fuel type, and efficiency 

are defined. (The HW system needs to be defined here before it can be assigned to any 
zones). 

• Storage & Secondary Circulation sub-tab: This is where the data on the hot water 
storage and secondary circulation are defined. 

• Assigned sub-tab: This tab shows which zones each HWS is assigned to serve.  

 

General sub-tab: 
A HWS is defined by the following information: 

1. Name – This needs to be a unique name. 

NB: Note that the ‘Multiplier’ field no longer exists for HWS. 

2. Generator type – Select from: Dedicated HWS boiler, Stand-alone water heater, 
Instantaneous HWS only, Instantaneous combi, Heat pump, or any of this project’s 
HVAC systems previously defined in the HVAC Systems tab. 

3. Is it later than 1998? - Tick if the system was installed later than 1998. The generator 
type selected above determines whether this tick box is enabled.  

NB: For boiler systems installed from 1998 onwards, a default seasonal efficiency of 
0.81 is suggested by the tool (based on Statutory Instrument 1994 No. 3083), and for 
boiler systems installed before this period, a conservative default seasonal efficiency of 
0.65 is suggested. Please note that from around 1989, the boiler industry began 
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producing boilers with efficiencies that would have complied with the above statutory 
instrument. 

4. Fuel type – Depending on the generator type selected, a list of fuel types is available. For 
example, if “Instantaneous combi” is selected, you need to choose between: Natural gas, 
LPG, Biogas, and Oil. If one of the project’s HVAC systems is chosen as the generator 
type, this field is not enabled as the fuel type would have been previously defined in the 
HVAC Systems tab. 

5. Effective heat generating seasonal efficiency - If you know the effective heat generating 
seasonal efficiency for the HWS generator, it can be introduced manually into the 
interface. Otherwise, a default value will be used by SBEM. (This field is inactive if the 
HWS Generator type selected is ‘Same as HVAC’). The default value is based on the 
above tick box on whether the generator was installed in or later than 1998. 

NB: The Effective Heat Generating Seasonal Efficiency is calculated by adding the Heating 
Efficiency Credits, where applicable, to the Heat Generator Seasonal Efficiency. The Heat 
Generator Seasonal Efficiency is the ratio of the useful heat output to the energy input over the 
heating season. The Heating Efficiency Credits are available for additional controls and other 
measures that go beyond the required minimum controls package. Details of the minimum 
controls packages for the different systems, additional controls, and corresponding available 
credits are in the Non-Domestic Heating, Cooling, and Ventilation Compliance Guide published 
by CLGxiv. Note that the necessary documentation to support the efficiency calculation may be 
required by Building Control.  

Figure 57 shows a HWS generator being defined. 

 

 
Figure 57: Defining a HWS in the General tab 

 
 

                                                
xiv Available from (http://www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_NONDOMHEAT.pdf) 

http://www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_NONDOMHEAT.pdf
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Storage & Secondary Circulation sub-tab: 
In this sub-tab (Figure 58), you can enter the following information: 

1. Is the system a storage system? – Tick if yes. 

2. If the above tick box, regarding the a storage system, is ticked, the following fields 
become active: 

Either (depending on the selected radio button) 

a. Storage volume (volume of the HWS cylinder) in litres. 

b. Insulation type (on the HWS cylinder) – selected from the drop-down menu. If the 
option selected is not “Uninsulated”, then the following parameter becomes 
active: 

i. Insulation thickness (on the HWS cylinder) in mm. 

                  or  

c. Storage losses in MJ/month. 

 

d. Does the system have secondary circulation? (tick box)  

i. If the secondary circulation tick box is ticked, default values will be assumed for 
heat losses per metre run (W/m), pump power (kW), and secondary pipework 
length (m). You can insert specific values if you know them. 

ii. Tick box if there is time control on the secondary circulation.  

NB: If the above two boxes regarding a HWS storage and secondary circulation are activated 
but no values are entered by the user for the relevant parameters, the default values used in the 
SBEM calculation will be displayed within the interface after the calculation has been run. 
However, these calculated defaults would be quite pessimistic, and users are advised to enter 
their own values instead. 

NB: If a solar energy system is connected to a HWS, then hot water storage is expected to exist. 

NB: If the provision of hot water in any area/zone of the building consists of a combination of 
HWS generators that do not work simultaneously (such as an additional generator is for backup 
to ensure continuity of hot water supply in a hospital), then the storage volume entered into 
iSBEM for the HWS should refer to the maximum storage volume that can be used at any given 
time during the year. The same applies to storage losses. For example, if two identical HWS 
generators with independent storage are installed to provide a hospital with HWS but one 
generator and storage are only used in case there is a failure in the primary one, you would input 
into iSBEM the volume and storage losses associated with only one of the systems. 

NB: Modelling trace heating in iSBEM: As an approximation, it can be considered that the 
energy used by trace heating is equivalent to that used by a secondary circulation. You can tick 
the box in the Building Services form > HWS tab > General sub-tab to indicate that there is a 
secondary circulation and then leave the rest of the secondary circulation related fields blank to 
be calculated by SBEM. You can also leave the deadleg at the default of 0 m. 
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Figure 58: HW Storage and Secondary Circulation sub-tab 

 
Assigned sub-tab: 
The zones assigned to the HWS can be viewed in the Assigned sub-tab of the HWS tab, shown 
in Figure 59. 

 

Task 15: Define the HWS: Details can be found in APPENDIX A:, Section A.2: Systems. Click 
into the HWS tab in the Building Services form. There is only one type of HWS in this building, 
and it needs to be named and defined here.  
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Figure 59: The Assigned sub-tab shows Zones to which the HWS has been assigned to 

 

7.6.4. Defining Solar Energy Systems (SES) – SES tab 

There are three sub-tabs in the SES tab: 

• Collector Parameters (renamed from General) sub-tab 

• Solar Storage & Collector Loop sub-tab 

• Auxiliary Energy & Distribution Losses sub-tab 

 
NB: The overall performance of solar thermal systems depends on how the hot water system is 
used, e.g., daily draw-off patterns and the use of other water heating devices such as a back-up 
boiler or an immersion heater. The procedure followed in SBEM is not suitable for detailed 
design for a particular case. It is intended to give a representative value of the solar contribution 
to water heating over a range of users. The calculation methodology implemented in SBEM is 
based on the f-chart method and has been adopted from the standards EN 151316-4-3:2007 
Heating systems in buildings – Method for calculation of system energy requirements and 
system efficiencies – Part 4-3: Heat generation systems, thermal solar systems. 

 
Collector Parameters (renamed from General) sub-tab: 
The parameters required to define an SES in this sub-tab (see Figure 60): 

1. Name – A unique name. 

2. Multiplier – Indicate how many SES systems identical to this one are associated with the 
selected HWS. 

3. In HWS - Select the HWS that this SES connects to, i.e., serves. 
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It is important to assign the SES to the relevant hot water system. The drop-down list contains all 
the systems that you have already defined in the HWS tab. If the SES is not assigned to the 
HWS, it will not be linked to the building, and any savings in energy will not be accounted for. 

NB: If a solar energy system is connected to a HWS, then hot water storage is expected to exist. 

4. Area – Aperture area of solar collector(s), in m2. It refers to the solar collector maximum 
projected area through which un-concentrated solar radiation enters the collector. The 
collector aperture area should not be confused with the collector gross area which refers 
to the projected area of the complete collector. 

5. Orientation - Select from the drop-down list: S, SE, SW, E, W, NE, NW, or N. The 
orientation and inclination of the solar collectors are needed for SBEM to calculate the 
solar radiation at the solar collector surface. 

6. Inclination – Select from the drop-down list from between 0-90o in 15o intervals. The 
inclination of the solar panels is in degrees from the horizontal where 0 stands for a 
horizontal surface and 90 for a vertical surface. The orientation and inclination of the 
solar collectors are needed for SBEM to calculate the solar radiation at the solar collector 
surface. 

7. Do you know the collector performance parameters according to EN 12975-2? – The 
preferred source of performance data for solar collectors is from a test on the collector 
concerned according to EN 12975-2: Thermal solar systems and components – Solar 
collectors – Part 2: Test methods. If test data are not available (e.g., for an existing 
installations), then the default values should be used by selecting: 

• No, use the default values from – you then need to select the collector type from the 
drop-down menu, and SBEM will use the corresponding default values as shown in 
Table 14.  

 
Collector type selected η0 a1 a2 IAM 
Unglazed 0.9 20 0 1 
Flat plate  0.75 6 0 0.94 
Evacuated tube 0.65 3 0 0.97 

Table 14: Default solar collector performance parameters 

 

On the other hand, if the performance parameters are known, then you should select: 

• Yes, the values are – you then need to enter the following parameters which will 
become active: 

a) η0 – (sigma-zero) the zero-loss collector efficiency factor from the collector test 
standards EN 12975-2 and related to the aperture area. 

b) a1 – the collector heat loss coefficient, in W/m2K, from the collector test standards 
EN 12975-2 and related to the aperture area. 

c) a2 – the temperature dependence of the heat loss coefficient, in W/m2K, from the 
collector test standards EN 12975-2 and related to the aperture area. 

d) IAM – the incidence angle modifier (IAM) of the collector from the collector test 
standard EN 12975-2 when the test angle of incidence between it and the direct 
solar radiation for the test condition is 50°. 
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Figure 60: Defining a Solar Energy System in the Collector Parameters sub-tab 

 

Solar Storage & Collector Loop sub-tab: 
The parameters required to define an SES in this sub-tab (see Figure 62) are: 

1. Solar storage volume - refers to the dedicated solar storage volume, in litres, and it 
should be calculated according to the arrangements for solar pre-heating as indicated in 
the schematic in Figure 61 and the guidance below: 

• in the case of one or more separate pre-heat tanks, such as arrangements a) or c) in 
Figure 61, the solar storage volume is the volume of the pre-heat tank(s). 

• in the case of a combined cylinder, such as arrangement b) in Figure 61, the solar 
storage volume is the volume between the bottom of the lowest back-up element 
(electric element or heat exchanger) to the lowest element of the solar primary.  

• in the case of a thermal store (hot water only) where (only) the solar coil is within the 
thermal store, the solar storage volume is the volume of the dedicated thermal 
storage.  

• in the case of a direct system, such as arrangement d) in Figure 61, the solar volume 
should be calculated as 0.3 times the volume of the cylinder. 

NB: The schematic examples reflected in the Figure 61 are unlikely to represent all types of 
commercial solar thermal installations. Where necessary, and for more complex systems, an 
accredited dynamic simulation tool can be used.  

NB: The dedicated solar volume of a solar thermal installation varies depending on the control 
and timing strategy of the of the back-up system. To optimise the performance of the solar 
thermal system, the back-up system should be prevented from operating during and prior to the 
period of the day where the solar radiation is strong enough to contribute to the hot water 
requirements. Where it can be demonstrated that the dedicated solar volume should be 
calculated following a different approach to the guidelines given here, alternative calculations 
can be used as long as they are in agreement with the UK Micro Certification Scheme standards 
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in effect at that time. The detail and justifications of the calculations undertaken will need to be 
submitted to the Building Control officer. 

 

 
Figure 61: Schematic examples of arrangements for solar pre-heating (These schematics are 

not intended to show safety measures or devices needed to make the systems safe.) – 
Adapted from SAP2005  

 

2. Solar pre-heating type – you need to select an option from the drop-down menu as 
follows:  

• Separate solar cylinder- when there is one or more dedicated solar storage vessels 
that are heated with the solar collectors only and that do not contain any other 
heating sources, i.e., the solar energy system has a storage cylinder that is 
independent of that for the hot water system storage. 

• Combined cylinder - the solar storage is combined in a hot water cylinder with one or 
more back-up sources, i.e., the solar energy system shares the same storage 
cylinder with the hot water system. 

3. Insulation type (on the solar storage cylinder) – selected from the drop-down menu. If the 
option selected is not “Uninsulated”, then the following parameter becomes active: 
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a. Insulation thickness (on the solar storage cylinder) in mm. 

4. Do you know the heat transfer rate of the heat exchanger(s) in the collector loop? – you 
need to select one of the following options: 

• There is no heat exchanger - For solar thermal direct systems in which the solar 
primary transmission fluid and the consumed water are the same, i.e., arrangement 
d) in Figure 61, you should select this option. Otherwise, for indirect systems where 
the primary circuit fluid is different to that of the secondary side of the system, there 
will be one or more heat exchangers in the storage vessel, and you should selected 
one of the other two options below. 

• No, use the default value. 

• Yes, the value is – you need to input the heat transfer rate, in W/K, in the box that will 
become active. For small systems, the heat transfer rate of the heat exchanger in the 
solar loop can be obtained from test results according to the standards EN 12975-3 - 
Performance characterisation of stores for solar heating systems. For large systems, 
the value can be taken from the heat exchanger performance data sheet provided by 
the manufacturer. For systems with more than one heat exchanger, using an 
intermediary or tertiary arrangement such as with a thermal store, an equivalent heat 
transfer rate can be input  by the user (alternatively, dynamic simulation compliance 
tools can be used). 

NB: The solar collector loop refers to all elements located between the solar collector 
and the point where the back-up heating source supplies the hot water system with 
energy.  

5. Do you know the overall heat loss coefficient of all pipes in the collector loop? – you 
need to select one of the following options: 

• No, use the default value. 

• Yes, the value is – you need to input the heat loss coefficient, in W/K, in the box that 
will become active. This is the overall heat loss coefficient of all pipes in the solar 
loop, including pipes between collectors and array pipes between the collector array 
and the solar storage tank(s). If the pipe and insulation for the solar loop are known, 
the overall heat loss coefficient of all the pipes in the solar loop can be calculated 
accordingly (see for instance John A. Duffie and William A. Beckman: Solar 
Engineering of Thermal Process. Wiley-Interscience ed., 1991). 
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Figure 62: Defining a Solar Energy System in the Solar Storage & Collector Loop sub-tab 

 

Auxiliary Energy & Distribution Losses sub-tab: 
The parameters required to define an SES in this sub-tab (see Figure 63) are: 

1. Are the distribution pipes between the solar energy system and the back-up system 
insulated? – you need to select either yes or no. If there are pipes between the solar 
thermal system and the back-up heating system, this parameter is used to estimate the 
thermal losses of the distribution between the solar thermal system and back-up heater. 
This parameter becomes active only if the “Solar pre-heating type” parameter in the 
Solar Storage & Collector Loop sub-tab has been set to “Separate solar cylinder”. 

2. Circulation system – you need to select one option from the drop-down menu. If the 
option selected is ‘forced circulation system with no PV’, then the following parameter 
becomes active: 

a. Do you know the nominal power of the pumps? – you need to select one of the 
following options: 

• No, use the default value. 

• Yes, the value is – you need to input the nominal power, in W, in the box that 
will become active. 

NB: The auxiliary energy consumption required by the circulation pumps in the solar 
system is calculated according to the type of circulation system. For thermosiphon 
systems and forced circulation systems assisted with photovoltaics, the auxiliary energy 
consumption is zero. For forced circulation systems that require grid-electricity for the 
circulation pump in the solar loop, the user needs to enter the nominal input power of the 
pumps, which is the power stated on the pumps label. For a multi-stage pump, the power 
corresponding to the typical operation mode should be chosen.  

 

 



129                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

 
Figure 63: Defining a Solar Energy System in the Auxiliary Energy & Distribution Losses sub-

tab 

 

NB: There are no SES in the Example building so there is no task here.  

 

7.6.5. Defining a Photovoltaic system (PVS) – PVS tab 

SBEM allows the user to define a PVS in order to provide a percentage of the electrical demand 
of the building (see Figure 64) by displacing grid-supplied electricity. There is only one sub-tab in 
the PVS tab: 

• General sub-tab 

 

General sub-tab: 
The definition of a PVS requires: 

1. Name – A unique name 

2. Multiplier – Indicate how many PVS identical to this one exist in the building. 

3. Type – Choose from the drop-down list whether it is: Monocrystalline silicon, 
Polycrystalline silicon, Amorphous silicon, or Other thin films. 

4. Area – Area of the photovoltaic panel (m2). 

5. Orientation - Select from the drop-down list: S, SE, SW, E, W, NE, NW, or N. 

6. Inclination – Select from the drop-down list from between 0-90o in 15o intervals. The 
inclination of the photovoltaic panels is in degrees from the horizontal where 0 stands for 
a horizontal surface and 90 for a vertical surface. 
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Figure 64: Defining a PVS 

 

NB: There are no PVS in the Example building so there is no task here.  

 

7.6.6. Defining a wind generator – Wind Generators tab 

As with PVS, SBEM displaces the grid-supplied electricity with that produced by any wind 
generators defined in this tab. There is only one sub-tab in the Wind Generators tab: 

• General sub-tab 

 

General sub-tab: 
The parameters needed to define a wind generator are (see Figure 65): 

1. Name – A unique name. 

2. Multiplier – Indicate how many wind generators identical to this one exist in the building. 

3. Terrain type – This indicates the type of terrain where the wind turbine is located. Select 
from: Smooth flat country (no obstacles), Farm land with boundary hedges, Suburban or 
industrial area, and Urban with average building height > 15m.  

4. Radio button to indicate whether the wind turbine has a horizontal axis or not. If it is a 
horizontal axis turbine, you are asked to enter: 

• Diameter – Wind turbine rotor diameter, in m. iSBEM will use the entered 
diameter to calculate the area swept by the rotor blades. 

If the wind turbine does not have a horizontal axis, e.g., it is a vertical axis wind turbine, 
then you are instead asked to enter: 

• Area – area swept by the rotor blades, in m2. 
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NB: The swept area of a wind turbine is used to calculate the area of air intercepted by 
the turbine rotor. For axial horizontal wind turbines, you can enter the rotor diameter, in 
m, and the swept area is automatically calculated by iSBEM as the area of the circle 

delineated by the turbine's blades, and it is calculated as: 
4

2DA ⋅= π  For any other type 

of wind turbines, including vertical axis wind turbines, you need to enter the area swept 
by the rotor, in m2. Contact the turbine manufacturer if in any doubt. 

5. Hub height – The wind turbine hub height, in m. 

NB: The height of the turbine is used to adjust the wind speed values during the 
calculation. For axial horizontal wind turbines, this corresponds to the turbine hub height 
measured from the ground. For other rotor types including vertical axis wind turbines use 
the geometric centre of the turbine rotor. 

6. Power – The wind turbine rated power (electrical power delivered at rated wind speed), 
in kW. 

 

 
Figure 65: Defining a wind generator 

 

NB: There are no wind generators in the Example building so there is no task here.  

 

7.6.7. Defining the CHP generator – CHP Generator tab 

This tab only appears if one of the HVAC systems, defined in the HVAC Systems tab, is 
specified to use a Combined Heating and Power (CHP) generator for provision of hot water, 
space heating, and electrical power, or a Combined Cooling, Heating, and Power (CCHP) 
generator for provision of hot water, space cooling, space heating, and electrical energy (i.e., the 
relevant box is ticked).  
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There is only one sub-tab in the CHP Generator tab: 

• General sub-tab 

 

General sub-tab: 
The parameters required to describe the CHP generator are (see Figure 66): 

1. Fuel type – Select from: Natural gas, LPG, Biogas, Oil, Coal, Anthracite, Smokeless fuel 
(inc coke), Dual fuel appliances (mineral + wood), Biomass, and Waste heat. 

2. Heat efficiency – the seasonal thermal efficiency of the CCHP generator, defined as the 
total annual useful heat supplied by the generator divided by the total annual fuel energy 
input to the generator (using the gross calorific value). 

3. Electrical efficiency - it is calculated as the total annual electric power output by the CHP 
divided by the total annual fuel energy input (using the gross calorific value). 

NB: Values for the heat and electrical efficiencies are entered as ratios into iSBEM, not as 
percentages. For instance, a 30% electrical efficiency should be entered as 0.3 into iSBEM. 
For information regarding Part L minimum requirements for CHP and CCHP installations in 
England and Wales, please refer to the latest approved version of the Non-Domestic 
Heating, Cooling and ventilation Compliance Guide. 

NB: The heat to power ratio is automatically calculated by iSBEM as the heat efficiency divided 
by the electrical efficiency of the CHP. 

4. CHPQA Quality Index - an indicator of the energy efficiency and environmental 
performance of a CHP scheme relative to the generation of the same amounts of heat 
and power by separate alternative means. 

NB: The Quality Index (QI) provides a means of assessing the quality of CHP Schemes.  In 
SBEM, it is currently used for reporting purposes only, i.e., it is not used in the calculations. 
For information regarding Part L minimum requirements for CHP and CCHP installations in 
England and Wales, please refer to the latest approved version of the Non-Domestic 
Heating, Cooling and ventilation Compliance Guide. 

5. Proportion of space heating supplied to the building - (%). This average monthly value 
needs to be calculated through a detailed analysis of the building’s space heating 
demand values and patterns. Note that the CHP unit is normally sized below the peak 
heating demand of the building and will also be out of service at particular times for 
maintenance purposes. 

6. Proportion of hot water supplied to the building - (%).This average monthly value needs 
to be calculated through a detailed analysis of the building’s water heating demand 
values and patterns. Note that the CHP unit is normally sized below the peak heating 
demand of the building and will also be out of service at particular times for maintenance 
purposes. 

NB: The CHP can provide a proportion of the building’s hot water only if the HWS generator is 
set to be the same as the HVAC system to which the CHP is connected. 

7. Tick box to indicate whether this is a trigeneration system (i.e., it provides cooling, 
heating, and power) or not (i.e., it provides heating and power). If the box is ticked, the 
following fields become active: 

a. Proportion of space cooling supplied to the building - (%). 

b. Chiller efficiency - the seasonal chiller efficiency of the generator, defined as the 
cooling demand divided by the cooling energy for the generator. 

NB: SBEM is not a design tool. The values of the parameters entered in the CHP Generator 
sub-tab need to have come from a previous detailed analysis. 
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Figure 66: Defining a CHP generator: CHP Generator tab 

 

NB: There is no CHP generator in the Example building so there is no task here.  

 

7.6.8. Defining the zone specific building services- Zones tab 

The zone definition is not completed within the Zones tab in the Geometry form. Some zone 
parameters (related to building services) are defined within the Building Services form, under the 
Zones tab. There are six sub-tabs in the Zones tab: 

• HVAC, HWS, and Lighting Systems sub-tab: This is where you assign the HVAC 
system and HWS which serve each zone. In this sub-tab also, the results on the risk of 
overheating in the zone are displayed after the calculation has run successfully. 

• Ventilation sub-tab: This is where you define the ventilation type and characteristics for 
each zone. 

• Exhaust sub-tab: This is where you define an exhaust system in a zone. 
• Lighting (General) sub-tab: This is where you enter details about the general lighting 

characteristics of each zone. 
• Lighting (Controls) sub-tab: This is where you enter details about the lighting controls 

for each zone. 
• Display Lighting sub-tab: This is where you enter details about display lighting 

characteristics and controls for each zone. 

 

HVAC, HWS, and Lighting Systems sub-tab: 
The sub-tab is used to specify the HVAC system and HWS for each zone. The following 
information is required: 

HVAC System Parameters 
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1. HVAC Systems – Here you need to select from the drop-down list (of systems you have 
already defined in the HVAC Systems tab or the default systems) the HVAC system 
which serves the zone. If no HVAC system serves the space (i.e., an unconditioned 
zone), select ‘Zones without HVAC system’ (spaces which have no heating or cooling, 
e.g., plant rooms, storage spaces, exposed circulation spaces).  

NB: If a zone is defined as having no heating or cooling, i.e., assigned to ‘Zones without 
HVAC system’, but the activity type selected for the zone is one which typically requires 
conditioning (according to the Activity Database), a red exclamation mark “!” will appear 
next to this parameter as a warning to the user, in case this was done in error. Ultimately, 
however, the calculation will be carried out using the data input by the user.     

If you do not know the type of the HVAC system in your building or its detailed 
parameters, you should select one of the following default options from the drop-down 
menu: 

• ‘Heating only - Electric resistance’ - Heat generated by passing current through 
resistance wire. Assumed to be electric central heating system with warm air 
distribution. Fan storage heaters and electric fan converters should be input by 
defining an HVAC system in the Building Services form > HVAC Systems tab > 
General sub-tab and selecting the system type "Other local room heater - fanned". If 
you do not know the heating method (i.e., whether a heated-only building uses 
electricity or a fuel-based heating system), you should select electric resistance 
heating as your default. 

• ‘Heating only - Other systems’ - Assumed to be wet radiator system, heat generated 
by fuel combustion. Pumps assumed to be powered by grid-supplied electricity. If 
you know the fuel type used by the heating system, you can define it in the Building 
Services form > Global and Defaults tab > HVAC System Defaults sub-tab (see 
Section 7.6.1: Global and Defaults tab).  

•  ‘Heating and mechanical cooling’ - Assumed to be constant volume air system with 
terminal reheat and fixed fresh air. Refrigeration (chillers), fans, and pumps assumed 
to be powered by grid-supplied electricity. If you know the fuel type used by the 
heating system, you can define it in the Building Services form > Global and Defaults 
tab > HVAC System Defaults sub-tab (see Section 7.6.1: Global and Defaults tab). 

NB: The default HVAC systems are representative of existing rather than new buildings and 
should only be used if you do not know the type of the HVAC system in your building or its 
detailed parameters as the default efficiencies assumed by iSBEM for them are quite pessimistic 
and cannot be edited by the user. 

NB: Indirectly heated spaces - For spaces such as corridors or access areas, which are not 
serviced by an HVAC system (i.e., have no direct supply of heating or cooling) but are likely to 
be indirectly conditioned by the surrounding areas due to the high level of interaction with those 
spaces (allowing the heated air to move freely from the directly conditioned spaces to the 
indirectly conditioned ones), they should be considered heated or conditioned (indirectly) by the 
same HVAC system that supplies the most important surrounding area. In this case, you should 
assign the HVAC system of the main adjacent space to that indirectly conditioned zone also 
(although the space is not directly conditioned, the energy to overcome any losses from or gains 
to it is still required via the conditioned zone, and therefore has to be included in the calculation). 
An example of this would be an open corridor (to heated offices) or a stairwell next and open to 
offices, i.e., which might have a few envelope elements but is mostly open to the surrounding 
conditioned areas and which is not directly conditioned but is conditioned through the movement 
of air (and heat) from the adjacent offices into the corridor. Furthermore, envelope elements 
between a (directly) conditioned space and an indirectly conditioned space should be labelled as 
adjacent to a “conditioned adjoining space” and not to an “unheated adjoining space”. On the 
other hand, if a zone is unheated and totally enclosed thus heated air cannot freely move from a 
heated zone into it, such as a plant room, a store room, or a toilet, you are advised to define it in 
iSBEM as "Zones without HVAC". 



135                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

NB: If there is more than one type of HVAC system in a space with each system clearly 
meant to service a particular part of the space, e.g., one servicing the facade perimeter area and 
another servicing the core area, then the space should be divided into 2 separate zones in 
iSBEM (each served by its corresponding HVAC system) even if there is no physical separation 
between the 2 zones. However, if heating is provided in a zone by two, or more, different types 
of heat sources, for e.g., a heat pump in a split system and a gas boiler in a wet system, you 
need to calculate (and enter into iSBEM) a seasonal heat generating efficiency which is 
equivalent to both these heat sources based on their respective efficiencies, fuel types, and 
loads, as described in the guidance on the bivalent calculation in Section 7.6.2: Defining HVAC 
Systems – HVAC Systems tab. On the other hand, if a zone is served by, for e.g., a gas-fired 
wet system for heating and an electric split system for cooling, then the systems can be 
approximated in SBEM by defining your HVAC system type as "split or multisplit", the heat 
source as "LTHW boiler", and fuel type as "natural gas", and then define the appropriate 
seasonal efficiency for the heating and energy efficiency ratio for the cooling. SBEM will use 
natural gas for the heating and grid-supplied electricity for the cooling. If applicable, you then 
need to define the mechanical ventilation at zone level (for all the zones served by this system) 
with a suitable ventilation SFP, and heat recovery. 

2. Are there destratification fans in the zone? (Tick box) - Destratification fans provide 
additional air recirculation in the zone to ensure even temperature distribution (while 
these would help reduce heating loads, they would increase auxiliary energy loads).  

NB: Destratification may be achieved by several means, for each of which minimum flow rates 
should be ensured. (Where destratification and heating is provided by the same system, higher 
flow rates may be needed to avoid excessive air supply temperatures): 

• Cased fans installed at high level. The volume of air handled by the fans should be at 
least equivalent to two room volumes per hour. Total air movement will be higher 
than this because additional airflow will be induced. 

• Open blade “sweep fans”. In this case, air speeds will be lower and the volume of air 
handled should be at least the equivalent of 6 room volumes per hour. 

• High velocity induction nozzles with a temperature rise through the heater of at least 
45ºC. The volume of primary air from the nozzles should be at least equivalent to 
0.15 room volumes per hour. Total air movement will be significantly higher because 
of the additional airflow induced by the nozzles. 

NB: If your HVAC system is a high velocity forced-convection air heating (induction nozzle 
system), which does the job of mixing the air in the zone in a similar manner to destratification 
fans, then you can model this in iSBEM by first selecting the appropriate HVAC system type 
(flued or unflued) and then ticking the above box relating to destratification fans in the zones 
served by that system. The system should follow the flow rate guidelines given for 
destratification systems shown above. You will then need to justify this to Building Control using 
the necessary documentation for your system's functions.  

Hot Water System  

3. HWS - A HWS needs to be selected for: 

a. All occupied zones - Depending on the activity and building type selected for 
the zone, a standard hot water demand is assumed. For example, there is a 
demand assumed to arise from the occupants of an office for activities such as 
washing hands and washing up cups. This demand is associated with the 
office rather than the toilet or tea room. Thus, the demand from each space 
needs to be assigned to a HWS even if the system itself is not present in the 
space. If there is more than one HWS serving the building, the HWS that 
needs to be specified for a zone should be the generator which accounts for 
the majority of its demand. A HWS needs to be assigned to every zone 
defined in iSBEM. 
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b. Any space with a deadleg within it – As described above, hot water demand is 
associated with occupied spaces rather than the spaces. However, if there is a 
deadleg within the zone, it needs to be associated with the appropriate 
system, through the zone it serves. 

4. Deadleg length in this zone - Length of the draw-off pipe to the outlet in the space (only 
used for zones where the water is drawn off, such as toilets and tea rooms). This 
parameter is used to determine the additional volume of water to be heated because the 
cold water in the deadleg has to be drawn off before hot water is obtained. This assumes 
that the hot water system circulation maintains hot water up to the boundary of the zone, 
or that the pipe runs from circulation or storage vessel within the zone. 

NB: Modelling trace heating in iSBEM: As an approximation, it can be considered that the 
energy used by trace heating is equivalent to that used by a secondary circulation. You can tick 
the box in the Building Services form > HWS tab > General sub-tab to indicate that there is a 
secondary circulation and then leave the rest of the secondary circulation related fields blank to 
be calculated by SBEM. You can also leave the deadleg at the default of 0 m. 

Lighting System 

5. Lighting System – This field will become active in future versions of the tool and will 
enable the user to select a lighting system for the zone from a previously defined list of 
systems, similar to that for HVAC systems and HWS. 

Risk of overheating in this zone. 

SBEM runs an overheating calculation in order to provide recommendations in the Advisory 
report which accompanies the BER certificate. After the calculation runs successfully, the 
risk of overheating in each zone is reported in this sub-tab (Figure 67).  

Figure 67 shows a zone’s HVAC, HWS, and lighting characteristics being defined. 

 

 
Figure 67: Selecting a zone’s HVAC, HWS, and lighting systems  
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Ventilation sub-tab: 
This sub-tab is used to specify the type of ventilation system specific for each zone. The 
following information is required: 

Zonal Ventilation Type 

1. Zonal ventilation type – A mechanical ventilation system separate from the heating or 
cooling system (i.e., zonal ventilation) can be added here. If the selected HVAC system 
does not already include ventilation, the zonal ventilation radio buttons become active. 
This would be possible, for example, with radiators or under-floor heating. You need to 
select either: Natural or Mechanical supply & extract, according to whether there is a 
mechanical ventilation system present in the zone to provide fresh air. 

NB: In order to ensure adequate ventilation for maintaining the concentration of CO2 below 0.5% 
in spaces served by unflued heating appliancesxv, the zonal ventilation option for these spaces 
should be set to ‘mechanical’. 

NB: The supply and extract flow rate for all ventilation systems is set to take the minimum fresh 
air requirements value from the NCM Activity Database. 

NB: Zonal ventilation is no longer available for fan coil units. Ventilation for this HVAC type is 
defined at HVAC level. See note in Section 7.6.2: Defining HVAC Systems, regarding specific 
fan power for fan coil systems.   

NB: If you change the HVAC system defined in your project from one that provides 
mechanical ventilation to one that does not (or vice versa), you must re-visit the 
Ventilation sub-tab of the Zones tab in the Building Services form for all the zones served 
by this HVAC System in order for all ventilation-related parameters to be updated by the 
tool. You may also wish to re-define whether the ventilation is natural or mechanical in 
these zones following the change in the HVAC type. 

If mechanical supply & extract is selected, the following fields become enabled: 

a. Do you know the supply & extract specific fan power? - Here you can either 
use the default value or enter your own SFP for the zonal mechanical 
ventilation system, in W/(l/s). The SFP of an air distribution system is defined 
as the sum of the design total circuit-watts, including all losses through 
switchgear and controls, such as inverters, of the fans in the system that 
supply air and extract it back outdoor (i.e. the sum of the total circuit-watts of 
supply and extract fans), divided by the design air flow rate through the 
system. For further details on the SFP and how it is calculated, see the Non-
Domestic HVAC Compliance Guide. NB: The default value may not comply 
with the current Building Regulations.  

Heat recovery 

b. Heat recovery – Here you need to select from: No heat recovery, Plate heat 
exchanger (Recuperator), Heat pipes, Thermal wheel, and Run around coil. 

c. Heat recovery seasonal efficiency - This parameter is active if a heat recovery 
system is selected, i.e., the previous parameter is not set to ‘No heat 
recovery’. If you know the heat recovery efficiency, it can be introduced 
manually into the interface. Otherwise, a default value will be used by SBEM. 

NB: If the SFP was calculated or measured for a mechanical ventilation system that already 
included heat recovery, then that is the value you enter into iSBEM. If the SFP was calculated or 
measured for a mechanical ventilation system before a heat recovery system was added on, 
then you need to add 0.15 to the SFP for a thermal wheel system, and 0.3 for any of the other 
heat recovery options in iSBEM, to account for the additional resistance.  

                                                
xv For details, please refer to BS 5925:1991: Code of Practice for Ventilation Principles and Designing 
for Natural Ventilation. 
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d. Demand-controlled ventilation – This field will become active in future versions 
and will allow the user to specify demand-controlled ventilation. 

2. Does the activity area require high pressure drop air treatment? – This option caters for 
activities that inherently demand the use of high pressure drop air treatment, including 
HEPA filtration. This may occur in hospitals (areas such as operating theatres and 
intensive care suites), airports (to keep aviation fumes out), some museums and libraries 
(with sensitive exhibits), commercial kitchens (odour filters, grease traps, filters to protect 
the odour filters, etc.), some industrial processes, and in buildings designed to withstand 
a biological attack. Here, you can either let SBEM take this parameter from the NCM 
activity database or you can select to tick or untick the relevant box manually.  

NB: If you do tick the box manually, you may be expected to provide justification to 
your claim for high pressure drops to building control.  

Figure 68 shows a zone’s ventilation characteristics being defined. 

 

 
Figure 68: Defining the zone ventilation in the Ventilation sub-tab 

 
Exhaust sub-tab: 
This sub-tab is used to specify the characteristics of a mechanical exhaust system in the zone. 
The following information is required: 

Local Mechanical Exhaust 

1. Is there mechanical exhaust in the zone? – An example of when this would be used is in 
a toilet. This tick box is enabled for all types of HVAC systems serving the zone. 

If the above tick box is ticked (i.e., there is mechanical exhaust in the zone), then the 
following fields become active: 

a. Local mechanical exhaust - This is the flow rate of air leaving the zone, in 
l/s.m2 of floor area. Guidance on typical figures for this parameter could be 
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found in CIBSE Guide F [1] Part A (Table 7.2, Basic fan capacity benchmarks). 
NB: iSBEM requires the exhaust flow rate in l/(s.m2) of floor area while the 
values in the CIBSE Guide are given in l/(s.m3). Use the zone height to convert 
the CIBSE values into the units required by iSBEM. 

b. Do you know the exhaust specific fan power? - Here you can either use the 
default value or enter your own SFP for the zonal mechanical exhaust system, 
in W/(l/s). NB: The default value may not comply with the current Building 
Regulations.  

c. Scope of exhaust system – Here you can use the radio buttons to specify 
whether the exhaust fan is remote from the zone (i.e., the exhaust system 
serves multiple spaces) or within the zone (i.e., a local window/wall/roof unit 
such as in a toilet). 

 

Figure 69 shows a zone’s exhaust characteristics being defined. 

 
Figure 69: Defining the zone mechanical exhaust in the Exhaust sub-tab 

 
Lighting (General) sub-tab: 

In the Lighting (General) sub-tab, each zone needs to be selected in turn and the following data 
entered: 

1. What information is available on lighting? – Here, you need to choose from: Full lighting 
design carried out (where you need to enter the total wattage in Watts and the design 
illuminance in lux for that zone – usually available from the lighting design engineer for a 
new building), Lighting chosen but calculation not carried out (where you need to specify 
the average initial (100 hour) lamp plus ballast efficacy for the lighting in the zone in 
lumens per circuit-Watt), or Lighting parameters not available (where you need to choose 
the lamp type from a drop-down list) – usually for existing buildings. The power density 
used by SBEM when each of the lamp types is selected is shown in Table 15. If you 
cannot find your lamp type on the list, you can select the one with the closest power 
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density. For example, low voltage tungsten halogen (which have a typical power density 
= 24 W/m2 per 100 Lux) can be approximated by selecting tungsten lamps (which have a 
typical power density = 28 W/m2 per 100 Lux) instead in iSBEM. 

NB: If you select ‘Full lighting design carried out’ or ‘Lighting chosen but calculation not 
carried out’ and enter the required parameters, you will now also need to select the type of 
lamps used in the zone (for the purposes of generating the Advisory Report for the BER).  

NB: If you do not know the type of lamps in the zone, you should select the option of ‘Don't 
know’ in the “Lamp Type” parameter (SBEM will assume that they are tungsten lamps). If 
you know that the lamps are fluorescent but have no further details, you should select the 
option ‘Fluorescent (No details)’.  

 
Power Density in W/m2 per 

100 Lux 

Lamp Type 
Commercial 
Application 

Industrial 
Application 

Tungsten lamp 28 - 
Fluorescent - compact 4.6 - 
T12 Fluorescent - halophosphate - low frequency ballast 5 3.9 
T8 Fluorescent - halophosphate - low frequency ballast 4.4 3.4 
T8 Fluorescent - halophosphate - high frequency ballast 3.8 3 
T8 Fluorescent - triphosphor - high frequency ballast 3.4 2.6 
Metal Halide 5.5 4.1 
High Pressure Mercury 7.6 5.7 
High Pressure Sodium 4.5 3.3 
T5 Fluorescent - triphosphor-coated - high frequency ballast 3.3 2.6 
Fluorescent (no details)  5 5 
Don’t know  28 28 

Table 15: Power densities used by SBEM in correspondence to the lamp types selected 

 
NB: The total wattage value that is entered into iSBEM is for the lighting system, i.e., it 
should include the luminaires and ballasts (control gear). 

NB: The design illuminance, in lux, is that for which the full lighting design has been carried 
out. The maintained illuminance at the end of the lamp life and before cleaning of the 
luminaires should not be less than the design illuminance. This value will be used, along with 
the total wattage value, in order to determine the consequent power density values 
associated with the lighting system used in W/m2 per 100 lux. This value will, in turn, be used 
to calculate the electrical consumption of an equivalent system which delivers the 
illuminance levels specified in the database. The calculated lighting energy consumption will 
be higher or lower than you expect depending on whether the design illuminance entered is 
higher or lower than the database illuminance for the activity. Changing the activity in a zone 
will change the corresponding illuminance retrieved from the Activity database, which would 
be reflected in both the actual and reference buildings. You can download the NCM Activity 
Database from the NCM website if you wish the view the illuminance values associated with 
each activity type. 

NB: The lighting option of “Lighting chosen but calculation not carried out” is not available in 
SBEM for office, industrial, and storage areas in all building types, as the compliance criteria 
for these spaces are measured in luminaire-lumens per circuit-watt (rather than lamp-
lumens/circuit-watt). Please refer to the Approved Document L2A for details.  

2. Does display lighting use efficient lamps? – Select: Yes or No/don’t know. If “Yes” is 
selected, the lamp-lumens per circuit wattage need to be entered for the display lighting 
(only applies if there is display lighting in the space by nature of its selected activity). 
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3. Are air-extracting luminaires fitted? – Select: Yes or No/don’t know. 

Figure 70 shows the lighting characteristics of a zone being defined. 

 

 
Figure 70: Defining the zone lighting characteristics in the Lighting (General) sub-tab 

 
Lighting (Controls) sub-tab: 
In this sub-tab, each zone needs to be selected, and the controls relating to its lighting need to 
be defined: 

1. Light controls - Here you need to indicate whether there are: No local controls (i.e., the 
lighting is centrally controlled according to the occupancy schedules from the NCM 
Activity Database for the activity selected for this particular zone), Local manual 
switching, and/or Photoelectric controls present by ticking none, both, or one of the 2 tick 
boxes, respectively. Local manual switching is where the occupants can control their own 
luminaries individually, and each light switch must be less than six metres from the 
luminaries it controls (it could be a hand held controller such as infra-red). 

If the “Photoelectric option” is ticked, the following fields become active: 

a. Photoelectric options - Here you need to choose between: Switching and 
Dimming. 

b. Indicate whether there is a different sensor to control the lighting in the back half 
of the zone (tick box), i.e., the half furthest from the window. 

c. Select the type of photoelectric sensors from the available options: Stand-alone 
sensors or (Digitally) Addressable systems.  

d. Parasitic power – Enter the parasitic power consumption of the photoelectric 
system in W/m2 if you know it. Otherwise, the following defaults will be used: 0.3 
W/m2 if the previous field is selected as “Stand-alone sensors”, and 0.57 W/m2 if 
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“Addressable systems” is selected (digitally addressable systems are for special 
applications and are not particularly energy efficient).  

NB: Values for the parasitic power need to be reasonable. Otherwise, the 
benefits due to the use of photoelectric controls may be negated by the extra 
electrical consumption required by the controls equipment. 

2. Automatic daylight zoning for lighting controls? – This parameter is active if one or both 
of the above tick boxes on lighting controls are ticked. If you select ‘Yes’, then SBEM will 
automatically sub-divide the zone into daylighting zones, if needed, following the zoning 
rules for zones with windows and rooflights, and you do not need to sub-divide it 
yourself. If you select ‘No’, then you need to specify the percentage area of the zone 
where the lighting is controlled so as to respond to daylight (whether by a photosensor or 
manual control). If that percentage is 100%, this means that the whole area of the zone 
has lighting controls that respond to daylight, and SBEM will perform no further sub-
divisions for this zone, i.e., you have already done the sub-division manually yourself. If 
the percentage value that you enter is less than 100%, for e.g., 70%, then SBEM will 
sub-divide the zone into two daylight zones whose areas are 70% and 30% of the total 
area of the zone, respectively. SBEM will then consider that the 70% daylight area will 
have lighting controls responding to daylight while the lighting in the 30% daylight area 
will not be affected by daylight.  

NB: If your zone has a non-typical layout of windows and/or rooflights, and you are 
worried that SBEM’s automatic sub-division might not correctly reflect the access to 
daylight in the zone, it is recommended that you carry out the daylighting sub-division 
yourself, as with previous iSBEM versions. 

3. Occupancy Sensing – Here, you need to select what kind of occupancy sensing the zone 
has, if applicable, from the available options shown in Table 16. NB: If there is no 
manual light switching defined in the zone, then the occupancy sensing options are 
restricted to: AUTO-ON-DIMMED and AUTO-ON-OFF only. If occupancy sensing is 
available in the zone, the following field becomes active: 

a. Parasitic power for occupancy sensing – Enter the parasitic power consumption 
of the occupancy sensing in W/m2 if you know it. Otherwise, the default value of: 
0.3 W/m2 will be used.  

NB: Values for the parasitic power need to be reasonable. Otherwise, the 
benefits due to the use of occupancy sensing may be negated by the extra 
electrical consumption required by the controls equipment. 

 
Type of Occupancy 

Sensing Control 
Brief Description 

MAN-ON-OFF+EXT Lights manually switched on and off, with the addition of an 
automatic extinction signal. 

AUTO-ON-DIMMED Lights automatically switched on whenever people enter a 
room and dimmed to a low level when no movement has 
been detected for a set time (usually 5-15 minutes). 

AUTO-ON-OFF Lights automatically switched on whenever people enter a 
room and switched off when no movement has been 
detected for a set time (usually 5-15 minutes). 

MAN-ON-DIMMED Lights manually switched on and automatically dimmed to a 
low level when no movement has been detected for a set 
time (usually 5-15 minutes). 

MAN-ON-AUTO-OFF Lights manually switched on and automatically switched off 
when no movement has been detected for a set time 
(usually 5-15 minutes). 

NONE No occupancy sensing 

Table 16: Types of occupancy sensing controls available in iSBEM 
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Figure 71 shows the lighting controls in a zone being defined. 

 

 
Figure 71: Defining the lighting controls characteristics of a zone 

 

Display Lighting sub-tab: 
This sub-tab is active for a particular zone only if by nature of the activity selected for the zone, 
display lighting is applicable, e.g., retail. In the Display Lighting sub-tab, each zone needs to be 
selected in turn and the following data entered: 

1. Does display lighting use efficient lamps? – Select: Yes or No/don’t know. If “Yes” is 
selected, then the average lamp and ballast efficacy in lamp-lumens per circuit wattage 
needs to be entered for the display lighting (only applies if there is display lighting in the 
space by nature of its selected activity). 

NB: For the purposes of the lighting calculations in SBEM, efficient display lighting is one 
with a lamp and ballast efficacy better than 15 lamp-lumens per circuit-Watt. Examples of 
efficiency display lighting lamps include: metal halide, compact fluorescent, and white 
SON (high pressure sodium). 

2. Time Switching for display lighting (only applies if there is display lighting in the space by 
nature of its selected activity, e.g., retail) – Here, you need to choose between: None, 
Dimming, or Switching. If either Dimming or Switching is chosen, the following 
parameters become active, and you then need to enter the “Hours off” and “Fraction off” 
parameters.  

a. Hours off - If switching is selected, the hours off specifies the number of hours 
per average day during which the display lighting is switched off. If dimming is 
selected, the hours off specifies the number of hours per average day during 
which the display lighting is dimmed. 
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b. Fraction off – If switching is selected, the fraction off parameter specifies the 
fraction of display lighting which is turned off by the time switch. If this is 1, all the 
display lighting is switched off by the time switch. If dimming is selected, the 
fraction off specifies the fraction of display lighting which is dimmed by the time 
switch. 

Figure 72 shows the display lighting characteristics and controls for a zone being defined. 

 

 
Figure 72: Defining the zone display lighting in the Display Lighting sub-tab 

 

Task 16: Assign each zone to the appropriate HVAC and HWS, and define the ventilation 
and lighting strategies for each of the zones. 

Details can be found in APPENDIX A:, Section A.2: Systems. For each zone, click into the 
Zones tab in the Building Services form. Select each of the zones in turn using the record 
selector, and enter the required information.  

 

7.7. Building Navigation form 

This form allows the user to navigate through the project in order to view summaries of the 
different types of building objects that have been defined, as well as some detailed information 
about individual objects. This form contains 2 tabs: 

1. Selections tab 
2. Object Properties tab 
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7.7.1. Selections tab 

In this tab (Figure 73), depending on which radio button is selected in the ‘Objects’ section, you 
can choose to view either: HVAC systems only, HVAC systems and zones only, HVAC systems, 
zones, and envelopes only, or HVAC systems, zones, envelopes, windows, and doors. 
Depending on which radio button is selected in the ‘Assignment Status’ section, you can choose 
to view either: Assigned objects only, Unassigned objects only, or both. Also, by ticking the box 
in the ‘Objects’ section, you can choose to also view other building objects, such as 
constructions, HWS, SES, etc. The objects are then listed in the left hand side ‘Object Tree’ 
window in terms of their names and types. The ‘Key to Objects’ section contains the key to the 
symbols used to denote the types of objects. 

There is a ‘Refresh’ button which you can click on in order to manually initiate the refreshing of 
the contents of the Building Navigation form, if the relevant tick box in the General form > File 
Options tab > System Configuration sub-tab is unticked. It the box is ticked, the contents of the 
Building Navigation form will be refreshed automatically with any changes in the objects 
properties that might have been performed since the form was last accessed (see Section 7.3.1: 
File Options tab).  

 

 
Figure 73: Selections tab in the Building Navigation form 

 

7.7.2. Object Properties tab 

In this tab (Figure 74), if any of the objects listed in the ‘Object tree’ window is highlighted, more 
details about that object’s properties appear in the ‘Objects properties’ window on the right. For 
example, if the highlighted object is an envelope, the details displayed will be its area, 
construction, and the condition of the adjoining space, etc. 

 

Objects 
section 

Assignment 
status section 

Key to Objects 
section 

Object 
Tree 
window 
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Figure 74: Objects Properties tab in the Building Navigation form 

 

7.8. About iSBEM form 

This form displays information about the SBEM software, licensing conditions, and 
acknowledgement. There is no data entry in this form. 
 

7.9. Double-checking the data 

It is advisable to always double-check the data entered for any project, in order to ensure that 
the building is modelled correctly, before running the energy performance calculation and 
compliance checking. There are several tools within iSBEM to facilitate this: 

• The Objects reports - These reports can be accessed from all of the forms in the 
interface by pressing the Object Reports button:  This can be found at the top right-
hand side of all the tabs in the Project Database, Geometry, and Building Services forms, 
the bottom of the Asset Rating tab in the Ratings form, and in the File Options tab in the 
General form. There are two reports available in iSBEM to help the users check their 
data entry. 

1. The Unassigned Objects report which lists all the objects which have been 
created/defined but not assigned. 

2. The Data Summary report which provides a hierarchical summary of all the building 
objects that have been defined and assigned along with key details on some of the 
objects. 

• The Assigned sub-tabs - Wherever objects in iSBEM require that they be assigned to 
another object, there is usually a sub-tab which lists which objects have been assigned. 

Properties of 
highlighted object 
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• The Summary sub-tabs – Similar to the Assigned sub-tabs used for objects defined in 
the Geometry form. 

• The Building Navigation form – Provides a hierarchical summary of all the objects that 
have been defined in the project, assigned and unassigned, along with key details on 
some of the objects. 

 

7.9.1. The Unassigned Objects Report 

The Unassigned Objects Report is a simple list of all the objects which have been created but 
not assigned. They are grouped into two categories: Unassigned Building Objects and Other 
Unassigned Objects. 

The Unassigned Building Objects (in red text) include all the zones, envelope elements, 
windows, doors, HVAC systems, HWS, and SES that have been created in iSBEM but not 
assigned. These are critical unassignments. 

The Other Unassigned Objects (in blue text) include any construction or glazing types which 
have been created but not assigned to any of the envelope elements, windows, or doors. These 
are non-critical unassignments. 

Figure 75 shows that there are 4 zones which have not been assigned to an HVAC system. The 
user would then need to go into the Zones tab in the Geometry form (or the Zones tab in the 
Building Services form) to assign each zone to an HVAC system. The figure also shows that 
there are no non-critical unassignments. 

 

 
Figure 75: The Unassigned Objects Report 
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7.9.2. The Data Summary Report 

The Data Summary Report has a double layer structure:  
The first layer is in black text and is a tree structure of all the building objects that have been 
defined and assigned, reflecting the hierarchical relationship of the building objects (HVAC -> 
Zone -> Envelope -> Window / Door / Envelope Thermal bridge). 
The second layer is in blue text and provides key information about each of the listed objects. 
 

The assignment tree structure (black): 
The first column lists the HVAC system status of the zone, the highest element in the hierarchy. 
The next column lists all of the zones that are assigned to that HVAC system. All the zones that 
have no HVAC system are listed first (see Figure 76) followed by those that do (Figure 77). The 
next column lists all of the zone’s envelope elements, followed by the envelope elements’ 
additional thermal bridges, windows, the windows’ additional thermal bridges, and finally any 
doors with their additional thermal bridges. 

 

Summary information (blue): 
To the right of each zone, envelope element, and window (door) name is a selection of its key 
parameters/details. For example, to the right of any zone, you will find its activity type and its 
area. To the right of an envelope element, you will find which type of envelope it is (wall, roof, 
ceiling/floor), what sort of space it adjoins, its construction type, and its area. To the right of a 
window, you will find its glazing type and its area, and for a door, its construction and its area. 

 

 
Figure 76: Data Summary Report: Zones without HVAC 
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Figure 77: Data Summary Report: Zones with HVAC 

 

Task 17: Check your data entry and assignments using the Data Summary report and 
Unassigned Objects Report 
Now that all the zones have been assigned to HVAC systems, they should all appear in the Data 
Summary Report. Click on the Objects Report button in the top right hand corner of any of the 
sub-tabs and view the Assigned Objects Report. You should now be able to see the hierarchy of 
the building objects you have created. The HVAC system should have 16 zones assigned to it. 
Each zone should have its respective walls, floors, ceilings/roofs assigned and certain walls 
should have windows and/or doors assigned. Double-check that the assignments are correct 
before proceeding. 
 

7.9.3. The Assigned sub-tabs  

The Assigned sub-tabs display the parent objects which the object in question has been 
assigned to. There are six Assigned tabs in the interface: 

• The Walls Assigned sub-tab - in the Project Database form > Construction for Walls 
tab - displays all of the envelopes to which the wall construction selected in the record 
selector has been assigned. 

• The Floors Assigned sub-tab - in the Project Database form > Construction for Floors 
tab - displays all of the envelopes to which the floor construction selected in the record 
selector has been assigned. 
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• The Roofs Assigned sub-tab - in the Project Database form > Construction for Roofs 
tab - displays all of the envelopes to which the roof construction selected in the record 
selector has been assigned. 

• The Glazing Assigned sub-tab - in the Project Database form > Glazing tab - displays 
all of the windows or rooflights to which the glazing selected in the record selector has 
been assigned. 

• The Doors Assigned sub-tab - in the Project Database form > Construction for Doors 
tab - displays all of the doors to which the door construction selected in the record 
selector has been assigned. 

• The HWS Assigned sub-tab - in the Building Services form > HWS - displays all of the 
zones to which the HWS selected in the record selector has been assigned. 

 

All the above Assigned tabs cannot be edited. They are for viewing only.  
 

7.9.4. The Summary sub-tabs 

The Summary sub-tabs show which sub-objects have been assigned to the object in question. 
There are three Summary sub-tabs in the interface: 

• The Envelopes Summary sub-tab - in the Geometry form > Zones tab shows which 
envelopes have been assigned to each respective zone (see Section 7.5.3: Defining 
zones). 

• The Windows & Doors Summary sub-tab - in the Geometry form > Envelopes tab 
shows which windows and doors have been assigned to which envelope (see Section 
7.5.4: Defining envelopes – Envelope tab). 

• The Zone Summary sub-tab - in the Building Services form > HVAC Systems tab 
shows which zones have been assigned to which HVAC system (see Section 7.6.2: 
Defining HVAC Systems). 

 

Task 18: Check your data entry and assignments using the Summary and Assigned sub-
tabs 
Double-check that the assignments are correct before proceeding. 
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8. CALCULATING AND VIEWING THE ENERGY 
PERFORMANCE OF THE BUILDING- THE RATINGS 
FORM AND OUTPUT REPORTS 

The energy performance of the building is calculated and compliance with the building 
regulations is assessed (or the Building Energy Rating Certificate generated) via the Ratings 
form. The key results are then displayed in this form. Further details on Building Regulations 
compliance and a more detailed analysis of the energy used and CO2 emitted from the building 
are given in the SBEM output reports. This chapter describes how to calculate the results and 
access the various outputs. 

 

8.1. The Ratings form 

The Ratings form allows the user to: 

1. Run the entered building model through SBEM and the Compliance Checking Module 
(BRIRL) to calculate the energy consumption and CO2 emissions of the building (and 
those of the reference building) and determine whether it complies with Building 
Regulations (if ‘Republic of Ireland: Building Regulations Part L’ were selected as the 
“Purpose of Analysis” in the General form > General Information tab > Project Details 
sub-tab). You can do this by pressing the “Check Regulations” button in the Building 
Regulations Check tab > Building Rating sub-tab. 

or (depending on the “Purpose of Analysis” selection in the General form > General 
Information tab > Project Details sub-tab) 

2. Run the entered building model through SBEM and the Building Energy Rating 
Generator Module (BERgen) to calculate the energy consumption of the building, CO2 
emissions (and those of the notional building), and its BER (if ‘Republic of Ireland: 
Building Energy Rating’ were selected as the “Purpose of Analysis” in the General form > 
General Information tab > Project Details sub-tab). You can do this by pressing the 
“Calculate BER” button in the Asset Rating tab > Building Rating sub-tab. 

NB: You will be able to monitor on the screen the progress of the calculation process as it is 
carried out for the different building objects.  

3. View the key results within the interface. 

4. Access the following output reports:  

• the Building Regulations Compliance document, the SBEM Main Output report, and 
2 Data Reflection Reports for the actual and reference buildings, if compliance with 
Building Regulations is the purpose of the analysis.  

• the BER Certificate, the Advisory Report, the SBEM Main Output report, SBEM 
Supplementary Advisory Report, and the Data Reflection Report for the actual 
building if generating the BER is the purpose of the analysis.  

 

The Ratings form is composed of one tab, which is either: 
• Building Regulations Check tab: displays the primary energy consumption, in kWh per 

m2 of building area and the CO2 emissions, in kg per m2 of building area, for the actual 
and reference buildings as well as the target, and an assessment of whether the EPC 
and CPC of the building comply with the maximum permitted coefficients for energy and 
CO2 emissions, respectively, in the Building Regulations. It also displays a break-down of 
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the annual energy consumption by end-use for both the actual and reference buildings in 
kWh/m2. 

or (depending on the “Purpose of Analysis” selection in the General form > General 
Information tab > Project Details sub-tab) 
• Asset Rating tab: displays the CO2 emissions, in kg per m2 of building area, for the 

actual, reference, and notional buildings, along with the calculated BER and energy band 
of the actual building. It also displays a break-down of the annual energy consumption by 
end-use for the actual, reference, and notional buildings in kWh/m2. 

 

8.1.1. Building Regulations Check tab 

This tab is visible if ‘Republic of Ireland: Building Regulations Part L’ were selected as the 
“Purpose of Analysis” in the General form > General Information tab > Project Details sub-tab. 
The Building Regulations Check tab has four sub-tabs:  

• Building Rating sub-tab 

• Calculation Logs sub-tab 

• Calculation Errors sub-tab 

• Supporting Documents sub-tab 

 

Building Rating sub-tab: 

Building Regulations compliance is assessed by clicking on the “Check Regulation” button in the 
Building Rating sub-tab. This initiates the data processing through the SBEM calculation engine 
and the Compliance Checking Module (BRIRL). The following calculated information is then 
displayed in this sub-tab as follows: 

1. The energy used per square metre (kWh/m2) annually by the actual building and the 
reference building for heating, cooling, auxiliary energy (pumps, fans, and controls), 
lighting, and hot water. 

2. The total energy used per square metre (kWh/m2) annually by the actual building and the 
reference building in terms of both electricity and fuel use.  

3. The actual building’s primary energy consumption – This is the annual primary energy 
consumed per square metre for the actual building, in kWh/m2. 

4. The actual building’s CO2 emission rate – This is the annual CO2 emissions per square 
metre for the actual building, in kgCO2/m2. 

5. The reference building’s primary energy consumption – This is the annual primary 
energy consumed per square metre for the reference building, in kWh/m2. 

6. The reference building’s CO2 emission rate – This is the annual CO2 emissions per 
square metre for the reference building, in kgCO2/m2. 

7. The target primary energy consumption – This is the annual primary energy consumed 
per square metre for the target, in kWh/m2. 

8. The Target Emission Rate (TER) – This is the annual CO2 emissions per square metre 
for the target, in kgCO2/m2 

9. Pass energy - If the Energy Performance Coefficient (EPC) < Maximum Permitted 
Energy Performance Coefficient (MPEPC), then the building passes the primary energy 
criterion of the building regulations. Otherwise, it does not. 

10. Pass CO2 - If the Carbon Performance Coefficient (CPC) < Maximum Permitted Carbon 
Performance Coefficient (MPCPC), the building passes the CO2 emissions criterion of 
the building regulations. Otherwise, it does not. 
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Checks regarding other Building Regulations compliance criteria, such as U-Value checks, can 
be found in the Building Regulations Compliance document (see Section 8.2.2: SBEM BRIRL 
Output Document: Compliance with Building Regulations) which can be accessed from the 
Building Rating sub-tab. 

Also accessible from this sub-tab is the Main SBEM Output report and the Data Reflection 
Reports. See Sections 8.2.1: SBEM Main Output Document, 8.2.2: SBEM BRIRL Output 
Document: Compliance with Building Regulations, 8.2.3: Data Reflection Report – Actual 
Building, and 8.2.4: Data Reflection Report – Reference Building. 

NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 

NB: If any changes are made to a project, the “Check Regulation” button needs to be 
clicked on again on returning to this sub-tab in order to update the results as the results 
figures are not refreshed automatically. 
NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 

 
Unassignment alert 

If you have omitted to assign any objects in the interface, you will be notified at the bottom of 
both the Building Regulations Check and Asset Rating tabs. You will be able to view the 
Unassigned Objects Report by clicking on the ‘Objects Report’ button. You will see one of the 
following two messages at the bottom of the screen: 

“Click to check object assignments, there are no CRITICAL un-assignments in this project”. 

“Please check (#) CRITICAL UNASSIGNMENTS before proceeding with final rating” (where # is 
the number of critical un-assignments in the project). 

NB: CRITICAL refers to “building object” un-assignments rather than construction or glazing un-
assignments. 

Figure 78 shows the Building Rating sub-tab in the Building Regulation Check tab of the Ratings 
form. The message at the bottom of the screen indicates that there are no critical un-
assignments in the project. If there were, the user would need to click on the “Objects Report” 
button, identify the un-assignment, make the correction in the appropriate part of iSBEM, then 
return to this page, and then click the “Check Regulation” button. 
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Figure 78: Using the interface to check compliance with Building Regulations in the Building 

Regulation Check tab of the Ratings form 

 
Calculation Logs sub-tab: 
Log files for the SBEM calculation (SBEM.log) and the compliance checking module, BRIRL, 
(BRIRL.log) can be viewed in this sub-tab (Figure 83). 

 
Calculation Errors sub-tab: 
Error files for the SBEM calculation (SBEM.err) and the compliance checking module, BRIRL 
(BRIRL.err) can be viewed in this sub-tab (Figure 84). If the calculation crashes, you can refer to 
these files for any error messages produced during the calculation. 

 

Supporting Documents sub-tab: 
This sub-tab (Figure 85) contains buttons that allow access to the following supporting (non-
official) documents produced by SBEM: the Main SBEM Output report (section 8.2.1: SBEM 
Main Output Document), and the Data Reflection Reports (sections 8.2.3: Data Reflection 
Report – Actual Building, and 8.2.4: Data Reflection Report – Reference Building). 

NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
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8.1.2. Asset Rating tab 

This tab is visible only if ‘Republic of Ireland: Building Energy Rating’ were selected as the 
“Purpose of Analysis” in the General form > General Information tab > Project Details sub-tab. 
The Asset Rating tab has five sub-tabs:  

• Building Rating sub-tab 

• Recommendations sub-tab  

• EPC Audit sub-tab 

• Calculation Logs sub-tab 

• Calculation Errors sub-tab 

• Supporting Documents sub-tab 

 

Building Rating sub-tab: 
The Asset Rating is calculated by clicking on the “Calculate BER” button. This runs the data 
through the SBEM calculation engine and the Building Energy Rating Generator (BERgen).  

NB: For assessors accredited by an Accreditation Scheme Provider that generates the final BER 
certificate and the Advisory Report for lodgement in a central system for the Accreditation 
Scheme, please note that in order to generate the XML file required by your Accreditation 
Scheme Provider, your computer must be connected to the internet (see Section 7.3.2: General 
Information tab). If there is no internet connection, then the XML file will not be generated. 
Please also note that the output files produced on your computer will always contain the 
watermark.  

The Building Rating sub-tab then displays the following calculated results: 
1. The energy used per square metre (kWh/m2) annually by the actual, reference, and 

notional buildings for heating, cooling, auxiliary energy (pumps, fans, and controls), 
lighting, and hot water. 

2. The total energy used per square metre (kWh/m2) annually by the actual, reference, and 
notional buildings in terms of electricity and fuel use.  

3. The reference building’s primary energy consumption – This is the annual primary 
energy consumed per square metre for the reference building, in kWh/m2. 

4. The target primary energy consumption – This is the annual primary energy consumed 
per square metre for the target, in kWh/m2. 

5. The B-C boundary primary energy consumption – This is the annual primary energy 
consumed per square metre corresponding to the boundary of the B-C energy bands in 
the BER certificate, in kWh/m2. 

6. The actual building’s primary energy consumption – This is the annual primary energy 
consumed per square metre for the actual building, in kWh/m2. 

7. The reference building’s CO2 emission rate – This is the annual CO2 emissions per 
square metre for the reference building, in kgCO2/m2. 

8. The target CO2 emission rate – This is the annual CO2 emissions per square metre for 
the target, in kgCO2/m2. 

9. The B-C boundary CO2 emission rate – This is the annual CO2 emissions per square 
metre corresponding to the boundary of the B-C energy bands in the BER certificate, in 
kgCO2/m2. 

10. The actual building’s CO2 emission rate – This is the annual CO2 emissions per square 
metre for the actual building, in kgCO2/m2. 

11. The calculated BER Label (i.e., energy band) of the actual building. 
12. The calculated BER (i.e. Building Energy Rating) of the actual building. 
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Also accessible from this sub-tab is the BER Certificate, the BER Advisory Report, the SBEM 
Main Output report, the Data Reflection Report for the actual building, and the supporting 
recommendations in the form of the Supplementary Report. See Sections: 8.2.1: SBEM Main 
Output Document, 8.2.3: Data Reflection Report – Actual Building, 8.2.7: Building Energy Rating 
Certificate, 8.2.8: Advisory Report, and 8.2.10: SBEM Supplementary Report. 

NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 

NB: If any changes are made to a project (i.e., input parameters), the “Calculate BER” 
button needs to be clicked on again upon returning to this tab in order to update the 
results as the results figures are not refreshed automatically. 
NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 

Figure 79 shows the Building Rating sub-tab in the Asset Rating tab of the Ratings form. The 
message at the bottom of the screen indicates that there are no critical un-assignments in the 
project. If there were, the user would need to click on the “Objects Report” button, identify the 
un-assignment, make the correction in the appropriate part of iSBEM, then return to this page, 
and then click on the “Calculate BER” button. 

 

 
Figure 79: Using the interface to calculate the BER for the building in the Asset Rating tab of 

the Ratings form 

 
Task 19: Check compliance with Building Regulations and calculate the BER. If you ensure 
that the “Purpose of Analysis” parameter is set to ‘Republic of Ireland: Building Regulations Part 
L’, in the General form > General Information tab > Project Details sub-tab, and click into the 
Ratings form, you should find yourself in the Building Rating sub-tab of the Check Building 
Regulations tab. Check that the message at the bottom of the screen says that there are no 
critical un-assignments in this project, and then click on the “Check Regulation” button. Once the 
calculation is completed, you will be able to view the Building Regulations Compliance document 
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and Main SBEM Output Report (which you can compare to the versions included in APPENDIX 
A:). Then, go to the General form > General Information tab > Project Details sub-tab and 
change the “Purpose of Analysis” parameter to ‘Republic of Ireland: Building Energy Rating’. 
Finally, go back to the Ratings form > Asset Rating tab > Building Rating sub-tab and click on 
the “Calculate BER” button. Once the calculation is complete, you will be able to view the BER 
Certificate and the BER Advisory Report (APPENDIX A: includes samples of the BER Certificate 
and the Advisory Report).  
 
You have now completed this tutorial. 

 
Recommendations sub-tab: 
Once the BER has been calculated successfully, the BERgen module produces the BER 
Certificate and the Advisory Report. The latter contains the NCM and user-defined 
recommendations for energy efficiency improvements to the actual building. This sub-tab is 
visible only if BER generation has been selected as the “Purpose of Analysis" in the General 
form > General Information tab > Project Details sub-tab. This sub-tab (Figure 80) contains the 
following parameters: 

1. There are 4 radio buttons in a box entitled “Show recommendations”: 

a. All NCM – Click this button to view only the NCM recommendations generated by 
BERgen. 

b. All USER – click this button to view only the recommendations added by the 
user. If there are no user-defined recommendations, then iSBEM will prompt you 
to add one (see below).  

c. All – Click this button to view both the NCM recommendations and the ones 
added by the user. 

d. Only from Report – Click this button to view only the recommendations that have 
been included in the Advisory report. 

In addition to creating new recommendations in this sub-tab, the energy assessor can also edit 
the NCM recommendations generated by BERgen by adding comments and/or modifying the 
calculated impacts, using the following parameters:  

2. Click to edit this recommendation – By ticking this tick-box, you indicate that you wish to 
edit this particular NCM recommendation (whose text can be viewed in the grey box 
entitled “Recommendation”) generated by BERgen. If the box is ticked, the following 
fields become active: 

d. Assessor Comments - You can enter any comments related to the 
recommendation, for e.g., the reason why you have chosen to edit this NCM 
recommendation. These comments will appear in SBEM’s supporting documents 
in the Supplementary report. 

e. Energy Impact - You can select from the options available in the drop-down 
menu in order to specify the potential impact of implementing the 
recommendation on the energy performance of the actual building. (HIGH = 
change in total building energy is >4%, MEDIUM = change in total building 
energy is =<4% and >0.5%, LOW = change in total building energy is <0.5%). 

f. CO2 Impact - You can select from the options available in the drop-down menu in 
order to specify the potential impact of implementing the recommendation on the 
CO2 emissions of the actual building. (HIGH = change in total building CO2 
emissions is >4%, MEDIUM = change in total building CO2 emissions is <=4% 
and >0.5%, LOW = change in total building CO2 emissions is <0.5%). This 
impact will appear in the Advisory report. 

g. CO2 Saved per £ Spent - You can select from the options available in the drop-
down menu (GOOD, FAIR, POOR, and UNKNOWN) in order to specify the 
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potential CO2 emissions saved from the actual building per pound spent on 
implementing the recommendation in the actual building. 

h. Payback (drop-down menu) - You can select from the options available in the 
drop-down menu (LONG, MEDIUM, SHORT, and UNKNOWN) in order to specify 
the typical payback time for implementing the recommendation in the actual 
building. (LONG = payback is >7 years, MEDIUM = payback is >=3 years and <7 
years, SHORT = payback is <3 years). If you know the exact figure for payback 
time in years, use the next parameter instead. 

i. Payback (number) – Here you can input, in years, the typical payback time for 
implementing the recommendation in the actual building. If you do not know the 
exact figure for payback time in years, use the previous parameter instead. 

The following fields, however, remain greyed-out or un-editable as the user is not allowed to 
modify these parameters of NCM recommendations: 

a. Category – This describes the category under which the recommendation is 
classified, such as heating, cooling, etc. 

b. Code – This describes a unique code for each NCM recommendation. The code 
of any recommendation created by the energy assessor will be USER.  

c. Recommendation – This describes the text of the NCM recommendation. This 
text will appear in the Advisory report. 

d. Applicable to – This describes the object to which the recommendation applies, 
for e.g., the whole building or a particular HVAC system or HWS. 

3. Click to take out – By ticking this tick-box, you indicate that you wish to remove this 
particular NCM recommendation, which was generated by BERgen, from the Advisory 
Report.  

 
If the “All USER” radio button is selected in the “Show recommendations” box or the “Add 
new record” button  at the bottom of the screen is clicked, then iSBEM will prompt you to 
create a new recommendation.  

4. Once you have confirmed that you do wish to add a recommendation to the ones already 
generated by BERgen, then the following fields become active (Figure 81): 

a. Category - You can select from the options available in the drop-down menu in 
order to specify the category under which the recommendation will be classified. 

b. Code – This parameter should remain set to ‘USER’ for any user-defined 
recommendation. 

c. Recommendation – You can enter text to describe the newly-added 
recommendation. This text will appear in the Advisory report. 

d. Assessor Comments - You can enter any comments related to the 
recommendation, for e.g., the reason why you have chosen to edit this NCM 
recommendation. These comments will appear in SBEM’s supporting documents 
in the Supplementary report. 

j. Energy Impact - You can select from the options available in the drop-down 
menu in order to specify the potential impact of implementing the 
recommendation on the energy performance of the actual building. (HIGH = 
change in total building energy is >4%, MEDIUM = change in total building 
energy is =<4% and >0.5%, LOW = change in total building energy is <0.5%). 
NB: If you enter the value as UNKNOWN, SBEM will set it to LOW. 

k. CO2 Impact - You can select from the options available in the drop-down menu in 
order to specify the potential impact of implementing the recommendation on the 
CO2 emissions of the actual building. (HIGH = change in total building CO2 
emissions is >4%, MEDIUM = change in total building CO2 emissions is <=4% 
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and >0.5%, LOW = change in total building CO2 emissions is <0.5%). This 
impact will appear in the Advisory report. NB: If you enter the value as 
UNKNOWN, SBEM will set it to LOW. 

l. CO2 Saved per £ Spent - You can select from the options available in the drop-
down menu (GOOD, FAIR, POOR, and UNKNOWN) in order to specify the 
potential CO2 emissions saved from the actual building per pound spent on 
implementing the recommendation in the actual building. NB: If you enter the 
value as UNKNOWN, SBEM will set it to POOR. 

m. Payback (drop-down menu) - You can select from the options available in the 
drop-down menu (LONG, MEDIUM, SHORT, and UNKNOWN) in order to specify 
the typical payback time for implementing the recommendation in the actual 
building. (LONG = payback is >7 years, MEDIUM = payback is >=3 years and <7 
years, SHORT = payback is <3 years). NB: If you enter the value as UNKNOWN, 
SBEM will set it to LONG. If you know the exact figure for payback time in years, 
use the next parameter instead. 

e. Payback (number) – Here you can input, in years, the typical payback time for 
implementing the recommendation in the actual building. If you do not know the 
exact figure for payback time in years, use the previous parameter instead. 

f. Applicable to – Here you can specify the object to which the recommendation 
applies, for e.g., the whole building or a particular HVAC system or HWS. If the 
option selected is either ‘HVAC-SYSTEM’ or ‘HWS’, then the following parameter 
becomes active: 

i. Name – You need to specify the name of the particular HVAC system or 
HWS (already defined in iSBEM) to which the user-defined 
recommendation refers. 

NB: Only recommendations that are defined as applicable to the whole building, i.e., the 
parameter “Applicable to” has been set to ‘BUILDING’, appear in the official Advisory 
report. All the defined recommendations, however, will appear in SBEM’s Supplementary 
report.  

5. Delete Recommendation – This button allows you to delete a user-defined 
recommendation.  
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Figure 80: The Recommendations sub-tab in the Asset Rating tab of the Ratings form showing 

an NCM recommendation 

 
NB: After editing, deleting, or adding any recommendations, you need to re-run the 
calculation in order to re-generate the Recommendations Report with all your editing 
applied.  
 
NB: The NCM recommendations are generated for the building and its energy systems when 
operated according to standard schedules appropriate to the general activities in the building. 
The Energy Assessor is expected to use his or her knowledge to remove inappropriate ones and 
possibly to add additional ones. If the Building Energy Rating calculation has made extensive 
use of default values, some of the recommendations may be based on uncertain assumptions. 
These recommendations do not cover the quality of operation or maintenance of the building and 
its systems. There are frequently significant opportunities for energy and carbon savings in these 
areas and a full "energy audit" to identify them is strongly recommended. 
 
NB: Once a recommendation has been edited by the user, it can no longer be displayed in the 
Advisory Report as being automatically generated by the calculation, and so cannot appear in 
any of the first 3 tables. It must appear in the 4th table containing the users' added or edited 
recommendations. This is the case if the 'tick to edit’ box is ticked for a recommendation (even if 
no changes are actually made or comments are added by the user after ticking the box). 
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Figure 81: The Recommendations sub-tab in the Asset Rating tab of the Ratings form showing 

the active fields for creating a user-defined recommendation 

 
EPC Audit sub-tab: 
This sub-tab is visible only if BER generation has been selected as the “Purpose of Analysis" in 
the General form > General Information tab > Project Details sub-tab. The EPC Audit sub-tab 
(Figure 82) contains four sub-forms as follows: 

• Construction sub-form – contains the audit trail information relating to the construction 
input parameters, i.e., construction specification of walls, floors, roofs, windows, 
rooflights, and doors. 

• Geometry sub-form - contains the audit trail information relating to the geometry input 
parameters, i.e., definitions of thermal bridges; air permeability; and shading systems on 
glazing. 

• HVAC & HWS sub-form - contains the audit trail information relating to the HVAC and 
HWS input parameters, i.e., heating and cooling system type; heating and cooling 
efficiencies, duct and AHU leakage, specific fan power, HWS generator efficiency, 
metering and controls provision, and high pressure drop air filtration. 

• Lighting sub-form - contains the audit trail information relating to the lighting input 
parameters, i.e., lamp type, lighting controls, and parasitic power. 

This sub-tab is where the energy assessor provides supporting evidence for over-riding any of 
the default values in iSBEM. This information is necessary for the audit trail regarding all the 
parameters that are used to carry out the energy calculations for the generation of the BER 
certificate, should any of the default values or settings be changed by the energy assessor. Each 
of the above four sub-sub-tabs contains the following: 

1. Accept defaults – this is the list of defaults set in iSBEM for each of: Construction, 
Geometry, HVAC & HWS, and Lighting, which the energy assessor can over-ride.  

2. Assessor walk-though inspection – supporting evidence based on a walk-through 
inspection by the energy assessor. 
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3. Inspection by other: Sales particulars - supporting evidence based on sales particulars. 
4. Inspection by other: Technical inspection - supporting evidence based on a technical 

inspection by someone other than the energy assessor. 
5. On-site measurements of input parameters for assessment - supporting evidence based 

on on-site measurements of the input parameters. 
6. Other sources - supporting evidence based on other sources. 
7. Comments – additional information that the energy assessor would like to include for the 

audit trail. 

 

 
Figure 82: The EPC Audit sub-tab in the Asset Rating tab of the Ratings form 

 
Calculation Logs sub-tab: 
Log files for the SBEM calculation (SBEM.log), the compliance checking module, BRIRL, 
(BRIRL.log), and the BER certificate generator, BERgen, (BERgen.log) can be viewed in this 
sub-tab (Figure 83). 
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Figure 83: The Calculation Logs sub-tab in the Asset Rating tab of the Ratings form 

 
Calculation Errors sub-tab: 
Error files for the SBEM calculation (SBEM.err), the compliance checking module, BRIRL, 
(BRIRL.err), and the BER certificate generator, BERgen, (BERgen.err) can be viewed in this 
sub-tab (Figure 84). If the calculation crashes, you can refer to these files for any error 
messages produced during the calculation. 
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Figure 84: The Calculation Errors sub-tab in the Asset Rating tab of the Ratings form 

 

Supporting Documents sub-tab: 
This sub-tab (Figure 85) contains buttons that allow access to the following supporting (non-
official) documents produced by SBEM: the Main SBEM Output report (section 8.2.1: SBEM 
Main Output Document), and the Data Reflection Reports (sections 8.2.3: Data Reflection 
Report – Actual Building, and 8.2.4: Data Reflection Report – Reference Building). 

NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
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Figure 85: The Supporting Documents sub-tab in the Asset Rating tab of the Ratings form 

 

8.2. SBEM Output reports 

Output reports when running SBEM for building regulations compliance checking: 
If ‘Republic of Ireland: Building Regulations Part L’ were selected as the “Purpose of Analysis” in 
the General form > General Information tab > Project Details sub-tab, and the calculation was 
run to check compliance with building regulations, then SBEM produces six output reports. The 
six reports produced by SBEM are as follows, the first four of which can be accessed from the 
Ratings form > Asset Rating tab > Building Rating sub-tab (see Figure 78): 

1. SBEM Main Calculation Output Document 

2. SBEM BRIRL Output Document: Compliance with Building Regulations 

3. Data Reflection Report – for the Actual Building 

4. Data Reflection Report – for the Reference Building 

5. Technical Output Report – for the Actual Building 

6. Technical Output Report – for the Reference Building 

As described in the previous section, the first four reports are accessible from within iSBEM, 
using the appropriate buttons or hyperlinks in the Ratings form > Building Regulations Check tab 
> Building Rating sub-tab. These reports are all stored in the same location as the project files, 
along with the Technical Output Reports, which can only be accessed from the Projects folder. 
The default location for the project files is within the specific project folder (created when the 
project was first created, see Section 4.4: Creating new and opening existing projects) within the 
iSBEM_v3.5.b folder, e.g., C:\NCM\iSBEM_v3.5.b\Projects\Example building Republic of Ireland. 
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Output reports when running SBEM for Energy Performance Certificates: 
If ‘Republic of Ireland: Building Energy Rating’ were selected as the “Purpose of Analysis” in the 
General form > General Information tab > Project Details sub-tab, and the calculation was run to 
generate the BER Certificate, then SBEM produces eight output reports. The eight reports 
produced by SBEM are as follows. 

1. SBEM Main Output Document 

2. Building Energy Rating Certificate 

3. Advisory Report 

4. Data Reflection Report – for the Actual Building 

5. Technical Output Report – for the Actual Building 

6. Technical Output Report – for the Reference Building 

7. Technical Output Report – for the Notional Building 

8. Supplementary Report 

As described previously, the first four reports are accessible from within iSBEM, using the 
appropriate buttons or hyperlinks in the Ratings form > Asset Rating tab > Building Rating sub-
tab. These reports are all stored in the same location as the project files, along with the 
Technical Output Reports, which can only be accessed from the Projects folder. The default 
location for the project files is within the specific project folder (created when the project was first 
created, see Section 4.4: Creating new and opening existing projects) within the iSBEM_v3.5.b 
folder, e.g., C:\NCM\iSBEM_v3.5.b\Projects\Example building Republic of Ireland. 

One more file is produced when running the BER calculation. This file is the XML message 
which contains all the data used in the generation of the Building Energy Rating Certificate and 
the BER Advisory report.  

NB: For assessors accredited by an Accreditation Scheme Provider that generates the final BER 
certificate and the Advisory Report for lodgement in a central system for the Accreditation 
Scheme, please note that in order to generate the XML file required by your Accreditation 
Scheme Provider, your computer must be connected to the internet (see Section 7.3.2: General 
Information tab). If there is no internet connection, then the XML file will not be generated. 
Please also note that the output files produced on your computer will always contain the 
watermark.  

 

8.2.1. SBEM Main Output Document 

This report can be accessed from the Ratings form > Building Regulations Check tab > Building 
Rating sub-tab when checking compliance with building regulations and the Ratings form > 
Asset Rating tab > Building Rating sub-tab when generating a BER, by clicking on the “SBEM 
output” button, and it is stored in the same location as the project files as described in Section 
8.2.11: Accessing the reports from the project folder. The file is in “pdf” format. 

This report gives a summary of the energy consumptions and CO2 emissions of the building. It 
provides: 
• The name and type of the building. 
• A bar chart showing the annual CO2 emissions from the building, in kg/m2, due to fuel and 

electricity consumptions. It also shows the amount of annual CO2 emissions displaced by 
renewables, if applicable, and the building area, in m2. 

• A bar chart showing the annual energy consumption of the building for the different end 
uses, in kWh/m2. 

• A bar chart showing the variation of the monthly energy consumption by the different end 
uses along the year, in kWh/m2. 
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• A pie chart displaying the percentage of the total annual energy consumption that is due to 
each of the end uses, with the energy consumed by equipment excluded from the total. 

• A pie chart displaying the percentage of the total annual energy consumption that is due to 
each of the end uses, with the energy consumed by equipment included in the total. 

See APPENDIX A:, A.5 for the SBEM Main Output Document for the Example building. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
 

8.2.2. SBEM BRIRL Output Document: Compliance with Building 
Regulations 

This report can be accessed from the Ratings form > Building Regulations Check tab > Building 
Rating sub-tab by clicking on the “Approved Documents checks” button or hyperlink, and as with 
the SBEM Main Output report, it is stored in the same location as the project files, as described 
in Section 8.2.11: Accessing the reports from the project folder. The file is in “pdf” format. 

SBEM's Building Regulations Compliance Document will form part of the submission by 
designers to Building Control to demonstrate compliance, for e.g., with the Republic of Ireland: 
Building Regulations Part L. The SBEM Building Regulations Compliance Document contains 
the following sections: 

• Administrative Information: This section gives information about the project’s address, 
the building’s owner including name, telephone number, and address, and the building’s 
certifier including name, telephone number, and address. It also gives information about 
the certification tool used to generate the results. 

• Primary Energy Consumption and CO2 Emissions: This section of the report contains 
information about the predicted CO2 emission rate for the reference and actual buildings, 
in kg/m2.year, the Carbon Performance Coefficient (CPC), and the Maximum Permitted 
Carbon Performance Coefficient (MPCPC). It also contains information about the 
predicted primary energy consumption for the reference and actual buildings, in 
kWh/m2.year, the Energy Performance Coefficient (EPC), and the Maximum Permitted 
Energy Performance Coefficient (MPEPC). The CPC and EPC are displayed in green 
text if they are less than or equal to the MPCPC and MPEPC, respectively. Otherwise, 
they are displayed in red text. A statement is also displayed correspondingly.  

• Heat Transmission through Building Fabric: This section of the report contains 
information about the building fabric, including the construction U-values and the air 
permeability. A table displays the calculated area-weighted average U-values for each 
type of envelope element, as well as for all the elements in the building, and the 
corresponding maximum values in the Building Regulations, in W/m2K. If the maximum 
values are not exceeded, then the corresponding calculated values are displayed in 
green text. Otherwise, they are displayed in red text. A statement is also displayed 
correspondingly. A second table displays the area-weighted average air permeability in 
all the zones in the building, in m3/(h.m2) at 50 Pa.  

NB: Note that the Building Regulations compliance check regarding U-values will be applied by 
the tool to all envelopes which are not adjacent to a ‘Conditioned adjoining space’ or ‘Same 
space’. Also note that the tool will not check the U-values of elements in unconditioned zones for 
compliance.  

NB: The area-weighted average U-value displayed in the BRIRL document is calculated using 
the U-values of the different envelope elements and their areas as follows:  
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where avgU  = area-weighted average U-value, iA  = area of envelope i , and iU  = U-value of 
material of envelope i . 

• Building Services: This section of the report contains information about the building 
services systems in the building. Consecutive tables display the heating efficiency, 
cooling efficiency, and specific fan power for each HVAC system in the building. There 
are also tables that display the heating efficiency for each hot water system in the 
building.   

• Technical Data Sheet (Actual Vs. Reference Building): This section displays some 
information about the overall energy performance of the building (actual and reference) 
and some specific information on the HVAC systems in the building (actual and 
reference). It also lists some general information, such as the weather location of the 
building and the percentages of total building floor area occupied by the different activity 
types. 

 

See APPENDIX A:, A.9 for a sample Building Regulations Compliance document. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 

 

8.2.3. Data Reflection Report – Actual Building 

This report contains all the data that SBEM uses to calculate the energy performance of the 
building along with some general details about the building (as input by the user) and can be 
attached to the building’s Log Book. The information is presented in the following order: 
 
• General details 
• Building fabric details 
• All systems other than HVAC 
• HVAC system 1 

Zone 1 in HVAC system 1 
Envelope 1 of Zone 1  

  Window 1 in Envelope 1 of Zone 1  
  Door 1 in Envelope 1 of Zone 1 

  Etc..for all other zones in HVAC system 1 
 

Etc.. for all other HVAC systems 
 

• Compliance Check Summary details 
 
The report contains hyperlinks (in blue) to aid in navigation around the report. See Figure 86 for 
a screen shot of one of the Data Reflection Report in html format and for examples of the 
hyperlinks.  
 
The data in this report for the actual building is also produced in a more compact layout in pdf 
format (Figure 87). This report is more printer-friendly than the html one, and it can be printed 
either on A4 or A3 paper.   
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Figure 86: Data Reflection report in html format 

 
NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 

 

Click here go to the HVAC 
system which serves the zone 
that the envelope is part of 

Click here to be taken to the 
description of the External Wall 

Click here go to the zone which 
the envelope is part of 
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Figure 87: Data Reflection report in pdf format for the actual building 

 

8.2.4. Data Reflection Report – Reference Building 

This report contains all the details on the reference building created by SBEM to compare with 
the actual building. It has the same structure and functionality as the Data Reflection report for 
the actual building described above. 
 

NB: The Data Reflection Reports in html format are generated, and the related access buttons 
become visible in the Ratings form, only if the relevant box is ticked in the General form > File 
Options tab > System Configuration sub-tab. 
 

8.2.5. Technical Output Report – Actual Building 

This is a comma-separated-values ‘.csv’ file (which can be opened using Microsoft Excel) and is 
intended for those who wish to do a more in-depth analysis of the results and create their own 
graphs. It is accessible from the project folder, as described in Section 8.2.11: Accessing the 
reports from the project folder. It contains the calculated values for (Figure 88): 
• Monthly and annual energy use by fuel type (in MJ/m2 and kWh/m2). 
• Monthly and annual energy use by end use (in MJ/m2 and kWh/m2). 
• Annual CO2 emissions by fuel type (in kgCO2/m2). 
• Monthly and annual energy production (in MJ/m2 and kWh/m2) and CO2 emissions (in 

kgCO2/m2) displaced by renewables, if applicable. 
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Figure 88: Technical output report 

 

8.2.6. Technical Output Report – Reference Building 

This is a comma-separated-values ‘.csv’ file (which can be opened using Microsoft Excel) for the 
reference building similar in format to the technical output report for the actual building described 
above. 
 

8.2.7. Building Energy Rating Certificate 

This report can be accessed from the Ratings form > Asset Rating tab > Building Rating sub-tab 
by clicking on the “BER Certificate” button and is stored in the same location as the project files, 
as described in Section 8.2.11: Accessing the reports from the project folder. The file is in “pdf” 
format. 

This report gives a summary of the energy performance of the building and its CO2 emissions. It 
contains the following sections: 

• Administrative information in the form of the building name, address, type, total floor 
area, main heating fuel (the fuel which delivers the greatest total thermal output for space 
or water heating), and servicing environment (the service strategy that delivers the 
greatest total CO2 emissions). It also contains the energy assessor’s details and the 
certificate’s number and validity dates. 

• Building Energy Rating Indicator: displays the building’s calculated BER, its primary 
energy consumption, and where the building’s BER fits on a scale of the building energy 
efficiency bands. 

• Carbon Dioxide Emissions Indicator: displays the building’s calculated CO2 Emissions 
Indicator, its CO2 emission rate, where the building’s CO2 Emissions Indicator fits on a 
scale of buildings emissions.   

NB: Final BER certificates are generated in colour while provisional ones are generated in 
greyscale. 



172                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

NB: Please note that if none of the zones in the building are conditioned, the “building 
environment” will be set by the calculation to be “Undefined”, and no XML message will 
be generated by the tool for the building.  
NB: If none of the zones in the building as defined have space or water heating energy 
consumption, the “main heating fuel” will be set by the calculation to be “Undefined”.  

See APPENDIX A:, A.6 for a sample Building Energy Rating Certificate for the Example building. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
 

8.2.8. Advisory Report 

This report can be accessed from the Ratings form > Asset Rating tab > Building Rating sub-tab 
by clicking on the “BER Advisory Report” button and is stored in the same location as the project 
files, as described in Section 8.2.11: Accessing the reports from the project folder. The file is in 
“pdf” format. 

This report contains some administrative information about the building and the energy assessor 
and a list of recommendations (generated by the calculation and input by the energy assessor) 
for energy-efficiency improvements in the building. It contains the following sections: 

• Administrative Information: contains information on the Property Reference Number, the 
software used to produce the report, the validity dates of the report, and the servicing 
strategy of the property.   

• Energy Assessors Details: contains details about the energy assessor. 

• Background: contains information on the legislation. 

• Introduction: contains information on the basis for the report. 

• Recommendations: contains a list of recommendations, edited by the energy assessor, 
for the improvement of the energy performance of the building and their respective 
potential impact on the CO2 emission rate of the building. The recommendations are 
grouped into the following sub-sections: short payback (up to 15 recommendations), 
medium payback (up to 10 recommendations), long payback (up to 5 recommendations), 
and other recommendations created by the energy assessor (up to 10 
recommendations). 

NB: Only recommendations that are defined as applicable to the whole building, i.e., the 
parameter “Applicable to” has been set to ‘BUILDING’, appear in the official Advisory 
report. All the defined recommendations, however, will appear in SBEM’s Supplementary 
report.  

• Next Steps: contains information on the steps that need to be taken following the 
production of the reports. 

• Glossary: contains definitions of some of the terms used in the report. 

See APPENDIX A:, A.6 for a sample Recommendations Report for the Example building. 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
NB: The NCM recommendations are generated for the building and its energy systems when 
operated according to standard schedules appropriate to the general activities in the building. 
The Energy Assessor is expected to use his or her knowledge to remove inappropriate ones and 
possibly to add additional ones. If the Building Energy Rating calculation has made extensive 
use of default values, some of the recommendations may be based on uncertain assumptions. 
These recommendations do not cover the quality of operation or maintenance of the building and 
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its systems. There are frequently significant opportunities for energy and carbon savings in these 
areas and a full "energy audit" to identify them is strongly recommended. 

 

8.2.9. Technical Output Report – Notional Building 

This is a comma-separated-values ‘.csv’ file (which can be opened using Microsoft Excel) for the 
notional building similar in format to the technical output report for the actual building described 
previously (see Section 8.2.5: Technical Output Report – Actual Building). 
 

8.2.10. SBEM Supplementary Report 

This report is generated if ‘Republic of Ireland: Building Energy Rating’ were selected as the 
“Purpose of Analysis” in the General form > General Information tab > Project Details sub-tab, 
and the calculation was run to generate the BER. It can be accessed from the Ratings form > 
Asset Rating tab > Building Rating sub-tab by clicking on the “Supplementary Report” button and 
is stored in the same location as the project files as described in Section 8.2.11: Accessing the 
reports from the project folder. The file is in “pdf” format. 

This report gives a summary of building’s energy and CO2 emissions performance for the 
different end-use categories and a full list of recommendations (generated by the calculation 
and/or input by the user) for energy-efficiency improvements in the building (i.e., not just the 
recommendations that appear in the official Advisory report described in section 8.2.8: Advisory 
Report. It provides: 
• The name and type of the building. 
• A key to the colour codes used in displaying the recommendations. 
• The current performance of the building for each of the following categories, such as the 

attributed percentage of the total building’s CO2 emissions and overall energy performance: 
• Heating 
• Cooling 
• Hot water 
• Lighting 
• Renewables 
• Overheating 
• Envelope 
• Fuel-Switching 
• Auxiliary 
• Other 

• Recommendations related to each of the above categories, and for each recommendation, a 
set of information is displayed, such as the potential impact of implementing the 
recommendation on the energy performance and CO2 emissions of the building, the potential 
saving in CO2 emissions per Euro spent, and any additional comments input by the energy 
assessor. 

See APPENDIX A:, A.8 for a sample SBEM Supplementary Report for the Example building. 
 

8.2.11. Accessing the reports from the project folder 

All of the above reports are accessible from the specific project folder (created when the project 
was first created, see Section 4.4: Creating new and opening existing projects). The default 
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location for this folder is within the main Projects folder within the iSBEM_v3.5.b folder, e.g., 
“C:\NCM\iSBEM_v3.5.b\Projects\Example building Republic of Ireland”. The reports have the 
following file names and extensions: 

 

Output reports when running SBEM for building regulations compliance checking: 
1. SBEM Main Output Document – “project name”_sbem.pdf 
2. SBEM BRIRL Output Document: Compliance with Building – “project name”_brirl.pdf 
3. Data Reflection Report - Actual Building – “project name”_dr.pdf 
4. Data Reflection Report - Actual Building – “project name”_dr.htm 
5. Data Reflection Report - Reference Building – “project name”_not_dr.htm 
6. Technical Output Report - Actual Building – “project name”_sim.csv 
7. Technical Output Report - Reference Building – “project name”_not_sim.csv 

 
Output reports when running SBEM for Building Energy Rating Certificates: 

1. SBEM Main Output Document – “project name”_sbem. pdf 
2. Building Energy Rating Certificate – “project name”_ber[ber].pdf  
3. BER Advisory Report – “project name”_ber[adv].pdf 
4. Data Reflection Report - Actual Building – “project name”_dr.pdf 
5. Data Reflection Report - Actual Building – “project name”_dr.htm 
6. Technical Output Report - Actual Building – “project name”_sim.csv 
7. Technical Output Report - Reference Building – “project name”_not_sim.csv 
8. Technical Output Report - Notional Building – “project name”_ref_sim.csv 
9. Supplementary Advisory Report.– “project name”_ber[sadv].pdf 
10. XML file for the Building Energy Rating Certificate and the BER Advisory Report – 

“assessor number”.”project name”. xml 
NB: Your Accreditation Scheme provider needs the XML file in order to generate the non-
watermarked BER Certificate and Advisory Report for the official lodgement of documents.  

 

The project folder for the “Example building - Complete Ireland” file is shown in Figure 89 with 
the output reports highlighted when running SBEM for building regulations compliance checking 
and in Figure 90 with the output reports highlighted when running SBEM for Building Energy 
Rating Certificates. 

Also highlighted is the NCT file which is the file that is read by iSBEM and where all the 
input data has been stored. If you need to share a project with your colleagues, this is the only 
file you need to send them. They will be able to open it through iSBEM and generate all the other 
files.  

Other files highlighted in Figure 89 are 3 error files (with the extension .err) which you should 
check for any warnings or error messages generated by SBEM or BRIRL during the calculation. 
These are text files. Similarly, in Figure 90, 3 error files are highlighted which contain warnings or 
error messages generated by SBEM or BERgen. The contents of these files can also be viewed 
in the Calculation Errors sub-tab in the Ratings form (see section 8.1.2: Asset Rating tab). 

You will also notice that the there are 2 further Data Reflection Reports with the extension ‘.csv’. 
These files contain the same data as in the Data Reflection ‘.htm’ files described above but in a 
comma-separated-values format (which can be opened using Microsoft Excel).  

 

NB: You must close all output files before re-running the calculation (so the software can over-
write them). Otherwise, an error message will be produced. 
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Figure 89: Contents of the Projects folder showing the SBEM output reports when running 

SBEM for building regulations compliance checking 

 

Building Regulations Compliance Document 

Main SBEM Output report  

Technical Output report for the actual building 

The NCT file: the file read by iSBEM 

Technical Output report for the reference building 

3 Error files reporting error messages and warnings 

csv Data Reflection report for the reference building   

html Data Reflection report for the actual building  

html Data Reflection report for the reference building  

csv Data Reflection report for the actual building   

pdf Data Reflection report for the actual building  
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Figure 90: Contents of the Projects folder showing the SBEM output reports when running 

SBEM for Building Energy Rating 

 

BER Advisory Report 

Main SBEM Output report  

Technical Output report for the notional building 

3 Error files reporting error messages and warnings 

BER Certificate  

Technical Output report for the actual building 

The NCT file: the file read by iSBEM 

Supplementary Advisory Report  

html Data Reflection report for the actual building  

html Data Reflection report for the reference building  

Technical Output report for the reference building 

csv Data Reflection report for the reference building   

csv Data Reflection report for the actual building   

XML file for official lodgement 

pdf Data Reflection report for the actual building  
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APPENDIX A: TUTORIAL BUILDING DETAILS AND iSBEM 
OUTPUT DOCUMENTATION 

A.1. Building description 

The building is located in London. It is rectangular in shape with dimensions of 50 m x 30 m. It 
provides space for offices, a supermarket, and a coffee shop. 

 

 
Figure 91: 3D view of the Example building 

 

It has two floors. The supermarket and the coffee shop are located on the ground floor, with an 
outdoor passage between them, and the offices are located on the first floor. The first floor is 
accessible by stairs and lifts. 

 
Height inside the building: 

Ground floor: 3 m floor to floor  

First floor: 3 m floor to soffit 

 

All windows are set-back by 30 cm. This gives a transmission factor of 0.8. The window sill 
height is 1 m. The doors are 2.5 m high.  

The supermarket has an auxiliary room (see drawings), and there are another two auxiliary 
rooms in the coffee shop. There are toilets serving the offices on the first floor.  



178                                
iSBEM version 3.5.b - Republic of Ireland Volume    3Dec10 

A.1. Constructions 

q Roof:   Flat roof, 2002 Building Regulations 
q Ground floor:  Solid floor 
q Internal floor/ceiling: Suspended Floor, 2002 Building Regulations 
q Internal Walls:  Un-insulated concrete wall 

q External Wall:  U-value = 0.24W/m2K, κm = 51KJ/m2 

q Glazing:   All the glazing in the building is double glazing.   
    U-value = 2.1W/m2K, T-Solar = 0.821 and L-Solar = 0.898 

q Doors:   U-value = 2W/m2K, κm = 20KJ/m2K. 

 

The air permeability of the building at 50pa is 8m3/h.m2.  

 

A.2. Systems  

HVAC: System is a single duct VAV system with LTHW boiler using natural gas as fuel. It has 
heat recovery (Plate heat exchanger). The chiller is air-cooled with less than 100 kW capacity. 
Both the chiller and the boiler appear in the ECA list after 2001. The system has provision for 
metering and has M&T with alarms for “out of range” values. The ductwork leakage meets the 
CEN standard Class B, and the AHU has been tested and meets the CEN standard Class L1. 
The specific fan power is 2.2 W/(l/s). 

The HVAC system serves all the zones in the building except for the circulation spaces and the 
toilets. 

Lighting: No information apart from lamp types = T8 fluorescents. There is manual switching 
and photoelectric dimming with a back sensor in the coffee shop and the office. There is manual 
switching in all other areas. 

Hot water: Provided by the HVAC system boiler. 

Ventilation: Toilets have mechanical exhaust with 5 l/s.m2.  

 

A.3. Zoning of the building 

The building has been divided into 19 zones: 

z0/01east: The coffee shop on the ground floor – core and unglazed east perimeter area. 

z0/01north, z0/01northwest, z0/01west, z0/01south west, and z0/01south: The coffee shop on 
the ground floor – glazed perimeter areas. 

z0/02: The circulation area / staircase / lift area on the ground floor. 

z0/03: The supermarket on the ground floor. 

z1/01centre: The open plan office area on the first floor – core zone. 

z1/01north, z1/01northeast, z1/01east, z1/01southeast, z1/01south, z1/01southwest, z1/01west, 
and z1/01northwest: The open plan office area on the first floor – glazed perimeter areas. 

z1/02: The circulation area / staircase / lift area on the first floor. 

z1/03: The toilets on the first floor. 
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As you can see in Figure 92: Ground floor plan, the supermarket and the coffee shop contain 
smaller (auxiliary) areas which could be considered as separate zones. For e.g., it would be 
possible to separate the supermarket (z0/03) into two zones: the main area and the smaller 
room at the west end of the space. Similarly, the coffee shop core and east perimeter zone 
(z0/01/east) could be split into two zones. For simplicity, however, it has been assumed that the 
activities of the auxiliary rooms within the supermarket and coffee shop do not vary from the 
activity within the main areas. Hence, these auxiliary spaces have been absorbed within the 
main zones. More details on zoning can be found in Section 3.3: Zoning guide – How to zone 
your building.  

Table 17 below shows the area information you need for entering the geometry of the zones into 
iSBEM. See Section 3.6 for a description of the nomenclature used in this example. (e.g.: 
z0/01north/n = external north wall of zone z0/01/north). 

GROUND FLOOR      

Zones 
Area 
(m2) Envelope Area (m2) Windows/Doors  Area (m2) 

z0/01northxvi 54 z0/01north/n 27 z0/01north/n/g 8.1 
    z0/01north/e 18 z0/01north/e/d 3.75 
    z0/01north/f 54   
  z0/01north/ci 54   
z0/01east 162 z0/01east/e 54   
    z0/01east/f 162   
  z0/01east/ci 162   
z0/01south 54 z0/01south/s 27 z0/01south/s/g 8.1 
    z0/01south/e 18 z0/01south/e/d 3.75 
    z0/01south/f 54   
  z0/01south/ci 54   
z0/01southwest 36 z0/01southwest/s 18 z0/01southwest/s/g 5.4 
  z0/01southwest/w 18 z0/01southwest/w/g 5.4 
  z0/01southwest/f 36   
  z0/01southwest/ci 36   
z0/01west 108 z0/01west/w 54 z0/01west/w/g 16.2 
    z0/01west/f 108   
  z0/01west/ci 108   
z0/01northwest 36 z0/01northwest/n 18 z0/01northwest/n/g 5.4 
  z0/01northwest/w 18 z0/01northwest/w/g 5.4 
  z0/01northwest/f 36   
  z0/01northwest/ci 36   
z0/02 50 z0/02/n 7.5   
    z0/02/ei 60   
  z0/02/s 7.5   

  z0/02/w 60 z0/02/w/d 
2 x 3.75 

=7.5 
    z0/02/f 50     
    z0/02/ci 50     
z0/03 900 z0/03/n 90   
   z0/03/e 90   
  z0/03/s 90   

 
 

z0/03/w 30 z0/03/w/d 
2 x 3.75 

=7.5 
  z0/03/wi 60   
   z0/03/f 900     
   z0/03/ci 900     

                                                
xvi For a description of nomenclature used in the example, see Section 3.6. 
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FIRST FLOOR      

Zones Area (m2) Envelope 
Area 
(m2) Windows/Doors  

Area 
(m2) 

z1/01north 225.5 z1/01north/n 114 z1/01north/n/g 34.2 
  z1/01north/ni 7.5   
    z1/01north/ei 3   
  z1/01north/wi 3   
  z1/01north/fe 27.5   
    z1/01north/fi 198   
    z1/01north/c 225.5   
z1/01northeast 36 z1/01northeast/n 18 z1/01northeast/n/g 5.4 
  z1/01northeast/e 18 z1/01northeast/e/g 5.4 
  z1/01northeast/fi 36   
  z1/01northeast/c 36   
z1/01east 108 z1/01east/e 54 z1/01east/e/g 16.2 
    z1/01east/fi 108   
    z1/01east/c 108   
z1/01southeast 36 z1/01southeast/e 18 z1/01southeast/e/g 5.4 
  z1/01southeast/s 18 z1/01southeast/s/g 5.4 
  z1/01southeast/fi 36   
  z1/01southeast/c 36   
z1/01south 225.5 z1/01south/s 114 z1/01south/s/g 34.2 
    z1/01south/si 7.5   
  z1/01south/ei 3   
  z1/01south/wi 3   
  z1/01south/fe 27.5   
    z1/01south/fi 198   
    z1/01south/c 225.5   
z1/01southwest 36 z1/01southwest/s 18 z1/01southwest/s/g 5.4 
  z1/01southwest/w 18 z1/01southwest/w/g 5.4 
  z1/01southwest/fi 36   
  z1/01southwest/c 36   
z1/01west 108 z1/01west/w 54 z1/01west/w/g 16.2 
    z1/01west/fi 108   
    z1/01west/c 108   
z1/01northwest 36 z1/01northwest/n 18 z1/01northwest/n/g 5.4 
  z1/01northwest/w 18 z1/01northwest/w/g 5.4 
  z1/01northwest/fi 36   
  z1/01northwest/c 36   
z1/01centre 614 z1/01centre/ei 54   
  z1/01centre/wi 54   
  z1/01centre/fe 20   
    z1/01centre/fi 594   
  z1/01centre/c 614   
  z1/01centre/ni 7.5   
  z1/01centre/si 7.5   
z1/02 50 z1/02/ni 7.5   
  z1/02/ei 60   
  z1/02/si 7.5   
  z1/02/wi 30   
  z1/02/wi.1 30   

  z1/02/fi 50   
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  z1/02/c 50   

z1/03 25 z1/03/ni 7.5   

  z1/03/ei 30   

  z1/03/si 7.5   

  z1/03/wi 30   

  z1/03/fe 25   

  z1/03/c 25   
 
 

Other information 
Window to wall (%) 30 
Door area (m2) 3.75 

Table 17: Zoning summary and dimensions of the Example building 
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A.4.  Drawings 

The next figures show architectural drawings and building zoning for each floor of the 
Example building. 

 
Figure 92: Ground floor plan 
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Figure 93: First floor plan 
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A.5. SBEM Main Output Document for Example Building 
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A.6. Building Energy Rating Certificate for Example Building 
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A.7. Advisory Report for Example Building 
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A.8. Sample Supplementary Advisory Report 
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A.9. Sample SBEM BRIRL Output Document 
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APPENDIX B: iSBEM file conversion 

If you want to open and edit files created with previous versions of iSBEM (version 1.0, 1.0.b, 
1.1.a, 1.2.a_b01, 1.2.a, 2.0.b, 2.0.c, 2.9.b, 3.0.a, 3.0.b, 3.0.e, 3.0.f, 3.1.a, 3.2.b, 3.3.b, 3.4.a, or 
3.5.a) using this current version (v3.5.b), you will need to convert them first. The file conversion 
tool is downloaded and installed to your computer at the same time as you download and install 
the new version of iSBEM. There are 6 stages to converting the files: 

 
1. Open the file conversion tool - Double-click on the ‘nct_convert_3.5.b.mdb’ file in the 

iSBEM_v3.5.b folder, as shown in Figure 94. 

 

 

Figure 94: Folder showing the file conversion tool 

 

2. Select the file you want to convert - To do this, click on the button shown in Figure 95. 
This opens a dialogue box, shown in Figure 96, from which you need to browse to find 
the file you want to convert. Once you have found the file, click on ‘Open’. (This file must 
have been created using either iSBEM_v1.0, v1.0.b, v1.1.a, v1.2.a_b01, 1.2.a, 2.0.b, 
2.0.c, 2.9.b, 3.0.a, 3.0.b, 3.0.e, 3.0.f, 3.1.a, 3.2.b, or 3.3.b). 

Double click to open the file 
conversion tool 
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Figure 95: Selecting a file to convert - stage 1 

 

 
Figure 96: Selecting a file to convert - stage 2 

 

3. Choose a name for the converted file - There are three options: 

i. Click on the button shown in Figure 97. This opens a dialogue box (the same as 
in stage 2). Re-select the file you are converting and click on ‘Save’. The new file 
will automatically be given the name: “original file name_v3.5.b.nct”. The 
original file will not be over-written by the conversion tool, and you should keep it 
for future reference. 

ii. If you want to give the converted file a new name of your own, type a new name 
and its full path into the field (shown in Figure 97). 

Click to open the dialogue box 

Select file for 
conversion 
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Figure 97: Naming the new file 

 

4. Convert the file – When both of the fields are filled, the ‘Convert’ button becomes active 
(see Figure 98). Clicking on this button converts the files and produces the message 
shown in Figure 99. Click on ‘OK’. The new file will be saved to the same folder as the 
original file by default, unless you specify otherwise. 

 
5. Close the tool – Click on the ‘Quit’ button (see Figure 98). 

 

 
Figure 98: The Convert and Quit buttons 

 

 
Figure 99: Message which appears after conversion 

 

Option ii - Enter a new name of your choice Option i - Use “original name_v3.5.b” 

Click to exit tool 

Click to convert files 
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6. Open iSBEM and open the newly created nct file - Due to the nature of the changes 
introduced in the new version, some fields in some projects may not get refreshed 
automatically. In order to ensure all the fields in your project are refreshed and updated, 
after converting files generated by a previous version, you need to do the following 
(using the record navigation arrows at the bottom): 
• Click through all the envelope elements in the Geometry form > Envelope tab in 

order to refresh the adjacencies (i.e., the "connects space to" field). 
• Click through all the HVAC systems in the Building Services form > HVAC systems 

tab > General sub-tab. 
• Click through all the sub-tabs in the Building Services form > Zones tab. 
• Due to the construction database having been updated in certain parts, you may 

wish to review your construction definitions in the Project Database form if the 
constructions were selected either from the library or using the inference method.  

 
7. Double check and note the points which have changed since the previous 

version: 
Please see the front pages of this manual for a list of the changes introduced in this version 
of the tool and manual, as well as in each of the previous versions. It is essential that you 
click through and review all the different forms, tabs, and sub-tabs of iSBEM and ensure that 
you provide input for parameters that did not exist in previous versions. This would also 
allow any changes that have been made to iSBEM’s default values to be adopted into the 
input correctly. You might also wish to modify your input for any of the existing parameters 
based on any further guidance added in this manual or the Help pages. 

 
NB: The development of SBEM version 3.5.b has incorporated improvements to the 
calculation algorithms, added features, modifications to some of the underlying databases, 
and correction of identified minor bugs. Hence, the generated results may differ either way 
from those generated by previous versions, depending on the individual projects. 
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APPENDIX C: User-defined construction database 

The User Library (User_library_3.5.b.mdb) is a feature first introduced with iSBEM_v2.0.c. You 
can now build up a database of your commonly used constructions so that you do not need to 
re-enter them each time you start a new project. You can also import constructions into your 
Library from a project you have been working on in iSBEM or from another User Library. 
 
This appendix will take you through the basics of: 

1. How to add a construction type to your library – and add this to iSBEM 
2. How to add a glazing type to your library – and add this to iSBEM 
3. How to add a frame type to your library – and add this to iSBEM 
4. How to edit the list of opaque constructions categories and the list of sources 
5. How to import constructions previously entered into an iSBEM project or in another User 

Library into your own User Library 
 
For definitions of a particular parameter, place the curser in that field and press F1. This 
will open a window with the Help item for that field, in the same way that the Help can be 
accessed within iSBEM. These definitions are not included in this appendix. 
 
The User library can be found as shown in Figure 100: 

 
Figure 100: Location of the User-defined construction library

The User Library can be accessed by 
double clicking this icon 
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How to add a construction type to your library – and add this to iSBEM 
 
To add a construction to the User Library, click into the Constructions form and follow the 
instructions starting by clicking on the “create new construction” button and finishing by updating 
the library in iSBEM. 
 

 
 
 
 

 
Figure 101: Description of Constructions tab in User-defined construction library 

 
 
 

 
 
 
A construction created in this way will be accessible in iSBEM from the Project Database form. It 
will be located in the “Constructions for X” tab, where X is the type of envelope as selected in 
the envelope type field (stage 3) and under the category as selected in the category field (stage 
4). The construction will be called $Construction Name, where Construction Name is the name 
entered in the name field. 
 

1 – click on the “create 
new construction” 
button 

To delete a 
construction 
click here 

8- Click on this 
button to 
update iSBEM 
with your new 
construction. 

7 – enter a 
description 
(optional) 

3 – select the 
envelope type 
(wall/roof/ 
floor/door) 

4 – select the 
category under 
which you want 
this to appear in 
iSBEM (to add a 
category, see 
Section 5 of this 
appendix) 

5 – select a 
source (to add a 
source to this list 
see Section 4 of 
this appendix) 

2 – enter a unique name. NB: in 
iSBEM, this name will be 
preceded with a $ 

To view all the 
constructions in your 
library click here 

6 – enter κm value, U-value and tick if construction contains metal 
cladding. For further details on these parameters, press F1 in the 
library or refer to Section 7.4 of the iSBEM User Guide. 
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1. How to add a glazing type to your library – and add this to iSBEM 
 
Adding a new glazing type to the glazing Library and updating iSBEM with this information is 
done in the same way as for constructions but in the Glazing form. For glazing, in addition to 
requiring a unique name, U-value, and source of the information, you are required to enter 
parameters which describe the solar and light transmission properties of the glazing. For details 
of any of the parameters, press F1 or see Section 7.4 of the iSBEM User Guide. 
 
 
 
 
 
 

 
Figure 102: Description of Glazings tab in User-defined construction library 

 
 
 
 
 
 
A glazing type created in this way will be accessible in iSBEM in the Project Database form > 
Glazing tab. It will be accessible when the “import one from the library” radio button is selected, 
from the glazing library. The glazing type will be called $Glazing Name, where Glazing Name is 
the name entered in the name field. 
 

1 – click on the “create 
new glazing” button 

3 – select the 
envelope type 
(window/ 
rooflight) 

6 – select a 
source (to add a 
source to this list 
see Section 3 of 
this appendix) 

To delete a 
glazing type 
click here 

9 – Click on 
this button to 
update iSBEM 
with your new 
glazing types. 

8 – enter a 
description 
(optional) 

5 – select 
coating type 

To view all the 
glazing types in your 
library click here 

2 – enter a unique name. NB: in 
iSBEM, this name will be 
preceded with a $ 

7 – enter T-Solar, L-Solar and U-value. For further details of these 
parameters, press F1 in the library or refer to Section 7.4 of the 
iSBEM User Guide. 

4 – select 
number of panes 
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2. How to add a frame type to your library – and add this to iSBEM 
 
As with the glazing, you can add a frame to your frames library in the same way that you add a 
construction to the constructions library but in the Frames form. The only parameters required to 
define a frame is the type (PVC, hardwood, softwood, steel, etc.) and the U-value. You are able 
to enter a description as with the constructions and glazing libraries. 
 
 
 
 
 

 
Figure 103: Description of Frames tab in User-defined construction library 

 
 
 
 
A frame type created in this way will be accessible in iSBEM in the Project Database form > 
Glazing tab. It will be accessible when the “import one from the library” radio button is selected, 
from the frame library. The frame type will be called $Frame Name, where Frame Name is the 
name entered in the name field. 
 

3 – select the 
type (Softwood/ 
Hardwood/ 
Steel/ 
Aluminium/ 
PVC/ Other) 

4 – select a 
source (to add a 
source to this list 
see Section 3 of 
this appendix) 

To delete a 
frame click 
here 

7 – Click on 
this button to 
update iSBEM 
with your new 
frames 

6 – enter a 
description 
(optional) 

2 – enter a unique name. NB: in 
iSBEM, this name will be 
preceded with a $ 

1 – click on the “create 
frame” button To view all the 

frames in your library 
click here 

5 – enter the U-value. For further details of this parameter, press F1 
in the library or refer to Section 7.4 of the iSBEM User Guide. 
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3. How to edit the list of opaque constructions categories and the list of Sources 
 

• Editing the list of categories for opaque constructions 
 

As described in Section 0, when creating a new construction type for your library, you 
need to select a category under which your construction will appear in iSBEM. If none of 
the pre-defined categories are appropriate, you can add a new one to the library in the 
Category form. To do this, enter the Category form, click on the “create new category” 
button, add a unique name in the name field, select an envelope type, and if you want, 
add a description. This category will now appear in the “Category” field in the 
Constructions form. 

 
 
 

 
Figure 104: Description of Construction Categories tab in User-defined construction library 

 
 

3 – select the 
envelope type 
you want this 
category to be 
available for 
(wall/roof/ 
floor/door) 

This table displays all the constructions in your library which fall under this category 

To delete a 
category 
click here 

2 – enter a unique name 
1 – click on the “category” button 

4 – enter a 
description 
(optional) 

To view all the 
categories in your 
library click here 
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• Editing the list of sources which you can select when defining opaque 
constructions, glazing types, or frame types 

 
The list is viewable and editable in the Sources form. To add a new source, click on the 
“enter new source” button and write the name of the source in the source field. This 
source will now be available for selection in the Construction, Glazing, and Frames form. 
 

 
 
 

 
Figure 105: Description of Sources tab in User-defined construction library 

 
 

 
 

This table displays all the constructions, glazing types, and frames which use this 
source in your library. 

To delete a 
source click 
here 

2 – enter a unique name 1 – click on the “source” 
button To view all the 

sources in your 
library click here 
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4. How to import constructions previously entered into an iSBEM project or in another 
User Library into your own User Library 

 
You may wish to import constructions from an existing User Database into your own, for 
example, from a colleague’s User Database. This can be done in the Import form. Similarly, In 
iSBEM, there is already a library of constructions which you can choose from in the Project 
Database form. If you wanted to edit any of these, you could import these into your User Library. 
This is done by selecting the mdb (User Database) file or nct (iSBEM file) and clicking on the 
appropriate import button as shown in Figure 106. 
 

 
Figure 106: Description of Import tab in User-defined construction library 

 
Once this procedure is successfully completed, these records will be available for editing within 
the User Library tool, and should also be automatically available for use within iSBEM without 
any further updates needing to be carried out. 
 
NB: All user-updated constructions, glazings, and frames from the User Library (including those 
that have been imported) will have the prefix "§ " added to them (unless it already exists, in 
which case an additional § will NOT be added). 
 
NB: Should a construction/glazing/frame of the same name as an existing 
construction/glazing/frame be imported into the User Library, a number will be appended to the 
end of it, according to the number of records in the User Library with a similar name, i.e., a 
record with name Name will have its name changed to Name.1, Name.2, Name.3, etc. 
depending on whether there are already 1, 2, 3, etc. records in the database already with a 
similar name (excluding the suffix). 
 
NB: Frames cannot be imported from NCT files due to the nature of their table layouts. Only 
constructions and glazings can be imported by this procedure. 

1) Click here to 
browse through your 
network to locate the 
nct file you want to 
import constructions 
from 

2) Click here to 
import the data from 
the selected nct file 

1) Click here to 
browse your network 
to locate the user 
library you want to 
import constructions 
from 

2) Click here to 
import the data from 
the selected user 
library 

To import data from an 
existing nct file 

To import data from 
an existing user 
library  
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APPENDIX D: List of parameters required by iSBEM 

Form: General  
Tab: General Information 

Sub-tab: Project details 
• Purpose of analysis 
• Additionally check Building regulations? (field enabled only when BER 

generation is selected as purpose of analysis) 
• Weather (location) 
• Stage of analysis (field enabled only when BER generation is selected 

as purpose of analysis) 
• Project complexity  

Sub-tab: Building details 
• Building type 
• Name of project 
• Building address 
• County 
• Location description 
• MPRN (field enabled only when BER generation is selected as purpose 

of analysis) 
• Year of construction (field enabled only when BER generation is 

selected as purpose of analysis) 
Sub-tab: Certifier’s / Energy Assessor’s Details 

Sub-form: Certifier’s / Energy Assessor’s Details  
• Name  
• Telephone number 
• Address 
• County 
• Assessor number (field enabled only when BER generation is 

selected as purpose of analysis) 
• Accreditation Scheme (field enabled only when BER generation is 

selected as purpose of analysis) 
• Qualifications (field enabled only when BER generation is selected 

as purpose of analysis) 
• Employer/Trading name (field enabled only when BER generation is 

selected as purpose of analysis) 
• Employer/Trading address (field enabled only when BER generation 

is selected as purpose of analysis) 
• Assessor Company Number (field enabled only when BER 

generation is selected as purpose of analysis) 
Sub-form: Insurance details (sub-form enabled only when BER generation is 
selected as purpose of analysis) 

• Insurance Company 
• Policy Number 
• Policy start/effective date 
• Policy end/expiry date 
• Policy cover limit 

Sub-tab: Owner’s details 
• Name  
• Telephone number 
• Address 
• County 
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Form: Project Database 
Tab: Construction for walls 

Sub-tab: General 
• Name of construction 
• Does it involve metal cladding? 
• Globally used in walls that connect zone to  
• Definition of construction of walls using one of the following 3 options: 

1) Library 
o Category  
o Library 

or 
2) Inference procedures 

o Building sector 
o Building Regulations compliance 
o General description 

or 
3) Enter parameters manually 

o U-value [W/m2K] 
o κm [kJ/m2K] 

Tab: Construction for roofs 
Sub-tab: General 

• Name of construction 
• Does it involve metal cladding? 
• Globally used in roofs that connect zone to  
• Definition of construction of roofs using one of the following 3 options: 

1) Library 
o Category  
o Library  

or 
2) Inference procedures 

o Building sector 
o Building Regulations compliance 
o General description 

or 
3) Enter parameters manually 

o U-value [W/m2K] 
o κm [kJ/m2K] 

Tab: Construction for floors 
Sub-tab: General 

• Name of construction 
• Globally used in floors that connect zone to 
• Definition of construction of floors using one of the following 3 options: 

1) Library 
o Category  
o Library  

or 
2) Inference procedures 

o Building sector 
o Building Regulations compliance 
o General description 

or 
3) Enter parameters manually 

o U-value [W/m2K] 
o κm [kJ/m2K] 
o Has the U-value been corrected to account for heat loss 

through floors in contact with the ground? 
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Tab: Construction for doors 
Sub-tab: General 

• Name of construction 
• Definition of construction of doors using one of the following 3 options: 

1) Library 
o Category  
o Library  

or 
2) Inference procedures 

o Building sector 
o Building Regulations compliance 
o General description 

or 
3) Enter parameters manually 

o U-value [W/m2K] 
o κm [kJ/m2K] 

Tab: Glazing 
Sub-tab: General 

• Name of construction 
• Definition of construction of glazing using one of the following 3 options: 

1) Library 
o Category  
o Library  

or 
2) Inference procedures 

o Building Regulations compliance 
o Number of panes 
o Coating 
o Frame material 

or 
3) Enter parameters manually 

o U-value - for glazing in vertical inclination [W/m2K] 
o T-solar – for normal incidence 
o L-solar – for normal incidence 

 
Form: Geometry 

Tab: Project 
Sub-tab: General & Geometry 

• Global air permeability at 50pa [m3/h.m2] 
• Building (clockwise) rotation [degrees] 
• Global zone floor-to-floor height [m] 
• Building area [m2]  
• Building volume [m3]  

Sub-tab: Thermal Bridges 
• Global Psi value [W/mK] for junctions involving metal cladding for each 

of: 
o Roof-Wall 
o Wall-Ground floor  
o Wall-Wall (corner)  
o Wall-Floor (not ground floor)  
o Lintel above window or door 
o Sill below window 
o Jamb at window or door 

• Global Psi value [W/mK] for junctions not involving metal cladding for 
each of: 

o Roof-Wall 
o Wall-Ground floor  
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o Wall-Wall (corner)  
o Wall-Floor (not ground floor)  
o Lintel above window or door 
o Sill below window 
o Jamb at window or door 

Tab: Zones 
Sub-tab: General 

• Zone name 
• HVAC system which serves the zone 
• Building type  
• Activity type in the zone 
• Zone area [m2] 
• Zone floor-to-floor height [m], or select global value 
• Air permeability at 50pa [m3/h.m2] in the zone, or select global value 
• Zone multiplier 
• Description of zone 
• Define the following Psi values for thermal bridges in the zone or use 

global values? 
o Zone Psi value [W/mK] for junctions involving metal cladding for 

each of: 
§ Roof-Wall 
§ Wall-Ground floor  
§ Wall-Wall (corner)  
§ Wall-Floor (not ground floor)  
§ Lintel above window or door 
§ Sill below window 
§ Jamb at window or door 

o Zone Psi value [W/mK] for junctions not involving metal cladding 
for each of: 
§ Roof-Wall 
§ Wall-Ground floor  
§ Wall-Wall (corner)  
§ Wall-Floor (not ground floor)  
§ Lintel above window or door 
§ Sill below window 
§ Jamb at window or door 

Tab: Envelopes 
Sub-tab: General 

• Envelope name 
• Zone which envelope belongs to 
• Type of envelope 

o Is it a flat roof? (field enabled if envelope type is roof) 
• Envelope connects space to, or select global value 
• Envelope construction 
• Envelope area [m2] 
• Envelope orientation 
• Definition of any thermal bridges in the envelope additional to global 

values 
o Thermal bridge multiplier 
o Thermal bridge length [m] 
o Thermal bridge Psi [W/mK] 
o Thermal bridge description 

Tab: Doors 
Sub-tab: General 

• Door name 
• Envelope which door is in 
• Door type 
• Door construction 
• Door area [m2] 
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• Definition of any thermal bridges in the door additional to global values 
o Thermal bridge multiplier 
o Thermal bridge length [m] 
o Thermal bridge Psi [W/mK] 
o Thermal bridge description 

Tab: Windows & Rooflights 
Sub-tab: General 

• Window/Rooflight name 
• Envelope which window/rooflight is in 
• Glazing type 
• Window/Rooflight projected area [m2] 
• Ratio of developed area to projected area of window/rooflight 
• Ratio of roof area covered by rooflight array to area of rooflight glazing 
• Is it a display window? 
• Frame factor 
• Shading system on window/rooflight 
• Transmission factor due to fins and overhangs 
• Definition of any thermal bridges in the window/rooflight additional to 

global values 
o Thermal bridge multiplier 
o Thermal bridge length [m] 
o Thermal bridge Psi [W/mK] 
o Thermal bridge description 

 
Form: Building Services 

Tab: Global and Defaults 
Sub-tab: HVAC System Defaults (sub-tab enabled only when BER generation is 

selected as purpose of analysis) 
• Fuel type for default Heating only – Other systems 
• Fuel type for default Heating and mechanical cooling systems 

Sub-tab: Project building services 
• Do the lighting systems have provision for metering?  

o Is there monitoring and testing with alarm for out-of-range 
values? (field enabled if lighting systems have provision for 
metering) 

• Electric power factor  
Tab: HVAC Systems 

Sub-tab: General 
• HVAC system name 
• HVAC system type 

o Heat recovery in ventilation system (field enabled if there is 
mechanical ventilation at HVAC level) 
§ Heat recovery seasonal efficiency  

Sub-tab: Heating System 
• Heat source 
• Fuel type for heat generator 
• Does this heating system use variable speed pumping? (field enabled 

only if the heating system is central using water) 
• Does this heating system also use CHP? 
• Effective heat generating seasonal efficiency for heat generator 
• Heat generator radiant efficiency (field enabled if HVAC is a radiant 

system) 
• Does the heating system qualify for ECA (relevant only if default 

efficiency value is used)? 
o Was the heating system installed in or after 1998 (relevant only 

if default efficiency value is used)? 
Sub-tab: Cooling System (enabled only if HVAC system provides cooling) 
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• Generator type  
• Generator kW 
• Fuel type for cooling generator 
• Seasonal energy efficiency ratio for cooling generator 
• Nominal energy efficiency ratio for cooling generator 
• Does the cooling system qualify for ECA (relevant only if default 

efficiency value is used)? 
• Does the system have mixed mode operation strategy? 

Sub-tab: System adjustment (enabled only if there is mechanical ventilation at HVAC 
level) 

• Has the ductwork been leakage tested? 
o CEN classification it meets 

• Does the AHU meet CEN leakage standards? 
o CEN classification it meets 

• Specific fan power [W/(l/s)] 
• Ratio of kWh of auxiliary energy to kWh of heating energy (field enabled 

if HVAC is a fanned warm air heater) 
Sub-tab: Metering Provision 

• Does the HVAC system have provision for metering?  
o Is there monitoring and testing with alarm for out-of-range 

values? (field enabled if HVAC system has provision for 
metering) 

Sub-tab: System Controls (sub-tab enabled only when BER generation is selected 
as purpose of analysis) 

• Does the HVAC system have central time control? 
• Does the HVAC system have optimum stop/start control? 
• Does the HVAC system have local time control? 
• Does the HVAC system have local temperature control? 
• Does the HVAC system have weather compensation control? 

Tab: HWS 
Sub-tab: General 

• HWS name 
• HWS generator type 

o Fuel type for HWS generator (field enabled if hot water is not 
generated by HVAC system) 

o Effective heat generating seasonal efficiency for HWS generator 
(field enabled if hot water is not generated by HVAC system) 

o Was the HWS installed later than 1998 (relevant only if default 
efficiency value is used)? (field enabled if hot water is not 
generated by HVAC system) 

Sub-tab: Storage & Secondary Circulation 
• Is the system a storage system? 

o Storage volume [litres] 
o Insulation type on storage vessel 

§ Insulation thickness [mm] 
or 
o Storage losses [MJ/month] 
o Does the system have secondary circulation? 

§ Circulation losses [W/m] 
§ Pump power [kW] 
§ Loop length [m] 
§ Is there time control on the secondary circulation? 

Tab: SE Systems 
Sub-tab: General 

• SES name 
• HWS which SES is in 
• SES area [m2] 
• SES multiplier 
• SES orientation 
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• SES inclination [degrees] 
• Do you know the collector performance parameters according to EN 

12975-2? 
o Zero-loss collector efficiency factor 
o Collector heat loss coefficient [W/m2K] 
o Temperature dependence of heat loss coefficient [W/m2K] 
o Incidence angle modifier of collector 

Sub-tab: Solar Storage & Collector Loop 
• Solar storage volume [litres] 
• Solar pre-heating type 

o Insulation type on storage vessel 
§ Insulation thickness [mm] 

• Do you know the heat transfer rate of the heat exchanger(s) in the 
collector loop? 

o Heat transfer rate [W/K] 
• Do you know the overall heat loss coefficient of all pipes in the collector 

loop? 
o Heat loss coefficient [W/K] 

Sub-tab: Auxiliary Energy & Distribution Losses 
• Are the distribution pipes between the solar energy system and the 

back-up system insulated? (field enabled only if the solar pre-heating 
type is a separate solar cylinder) 

• Circulation system 
o Do you know the nominal power of the pumps? 

§ Nominal power of the pumps [W] 
Tab: PV Systems 

Sub-tab: General 
• PVS name 
• PVS type 
• PVS area [m2] 
• PVS multiplier 
• PVS orientation 
• PVS inclination [degrees] 

 
Tab: Wind Generators 

Sub-tab: General 
• Wind generator name 
• Terrain type 
• Horizontal axis? 

o Diameter of blades [m] 
• Other axis? 

o Area swept by blades [m2] 
• Hub height [m] 
• Wind generator power [kW] 

Tab: CHP Generator 
Sub-tab: General 

• Fuel type 
• Heat efficiency 
• Electrical efficiency 
• CHPQA Quality Index 
• % of building space heat supplied by CHP 
• % of building hot water supplied by CHP 
• Is it a tri-generation system? 

o % of building space cooling supplied by CHP 
o Chiller efficiency 

Tab: Zones 
Sub-tab: HVAC, HWS, and Lighting systems 

• HVAC system which services the zone 
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• Are there de-stratification fans in the zone? 
• HWS which serves the zone 
• Dead leg length for HWS in the zone [m] 

Sub-tab: Ventilation 
• Zonal ventilation system – natural or mechanical (field enabled if there is 

no mechanical ventilation at HVAC level) 
o Heat recovery in the zone ventilation (field enabled if there is 

mechanical ventilation at zone level) 
§ Heat recovery seasonal efficiency  

o Specific fan power for supply & extract [W/(l/s)] (field enabled if 
there is mechanical ventilation at zone level) 

• Does activity require high pressure drop air treatment? 
Sub-tab: Exhaust 

• Is there mechanical exhaust in the zone? 
o Flow rate of mechanical exhaust [l/s.m2] 
o Specific fan power for exhaust [W/(l/s)] 
o Extract system serves single or multiple rooms? 

Sub-tab: Lighting (General) 
• Provide information on lighting using one of the following 3 options: 

1) Full lighting design 
o Total wattage [W] 
o Design illuminance [lux] 

or  
2) Lumens per circuit wattage (not available for office, industrial, and 
storage areas in all building types)  
or  
3) Lamp type 

• Does display lighting use efficient lamps? (field enabled for activities with 
display lighting) 

o Lumens per circuit wattage for display lighting 
• Are air-extracting luminaries fitted? 

Sub-tab: Lighting (Controls) 
• Type of lighting controls in the zone 

o Local manual switching? 
o Photoelectric?  

§ Dimming or switching? 
§ Type of sensors? 
§ Different sensor for back of zone? 
§ Parasitic power for photoelectric control 

o Do you want SBEM to perform automatic daylight zoning for 
lighting controls? 
§ Percentage area of zone where lighting is controlled by 

daylight. 
• Type of occupancy sensing in the zone 

o Parasitic power for occupancy sensing  
Sub-tab: Display Lighting 

• Does display lighting use efficient lamps? (field enabled for activities with 
display lighting) 

o Lumens per circuit wattage for display lighting 
• Are air-extracting luminaries fitted? 
• Is there time-switching for display lighting? (field enabled for activities 

with display lighting) 
o Hours off 
o Fraction off 
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APPENDIX E: Connection to EPCgen.net 

If the XML message is not generated when running a BER calculation, you should check 
the following: 

• Ensure that your computer is connected to the internet while running the BER 
calculation. 

• If applicable, ensure that you have entered the proxy server details correctly into 
iSBEM. Contact your IT department for assistance on your correct proxy server 
settings. 

• If applicable, ensure that the firewall settings on your computer system allow access 
to the EPCgen.net website. Contact your IT department for assistance on your 
firewall settings. The website and IP address that your firewall will need to allow 
access to is: 

o www.epcgen.net - IP: 209.62.38.248 

• Ensure that the BER calculation in iSBEM has completed successfully (i.e., that it 
has not crashed with any errors before completion). If not, examine the error files 
(.err) and correct the errors before proceeding. You can contact your Accreditation 
Scheme Provider for assistance. 

 
 
 

 

http://www.epcgen.net
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APPENDIX F: Matrix of activity areas and building types 

Building Types/Activities C
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Office x x x x x x x x x x x x x x x
primary schools x x x x x x x x x x x x x x x x
secondary school x x x x x x x x x x x x x x x x x x x x x
further education universities x x x x x x x x x x x x x x x x x x x x x x x x x x x x
primary health care buildings x x x x x x x x x x x
nursing, residential homes and hostels x  x x x x x x x x x x x x x
hospital x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x x
hotel x x x x x x x x x x x x x x x x x x x x x x
restaurant/bar/public house x x x x x x x x x x x
sports centre/leisure centre x x x x x x x x x x x x x x x x x x x x
sports ground/arena x x x x x x x x x x x x x x x x x x x x
retail x x x x x x x x x x x x x x x x x x x x x
warehouse and storage x x x x x x x x x x x x x x x x x x x x x
theatres/cinemas/ music halls and auditoria x x x x x x x x x x x x x x x x
social clubs x x x x x x x x x x x x x x x x
community/day centre x x x x x x x x x x x x x x x x x x
libraries, museums and galleries x x x x x x x x x x x x x x x x x x
prisons x x x x x x x x x x x x x x x x x x x x x x
emergency services x x x x x x x x x x x x x x x x x x
crown and county courts x x x x x x x x x x x x x
airport terminals x x x x x x x x x x x x x x x x x x x x x x x x x
bus station/train station/seaport terminal x x x x x x x x x x x x x
workshops/maintenance depot x x x x x x x x x x x x
telephone exchanges x x x x x x x x x x x
Industrial process building x x x x x x x x x x x x x x x x x x x x
Laundry x x x
Dwelling x x x x x x x x
Retail Warehouse x x x x x x x x x x x x x x x x x x x
Miscellaneous 24hr activities x x

 
 
 


